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The latest Windows and Macintosh versions can be downloaded from either of the following URL:

http://adapt-it.org/ 

Tips, discussions, issues and their resolution, blogs, etc, may also be found at the same site.

The latest Linux (Ubuntu/Wasta) version package repositories are currently as follows:

Adapt It Ubuntu apt repository setting (i386 and amd64 architectures):

deb  http://packages.sil.org/ubuntu trusty main

deb  http://packages.sil.org/ubuntu xenial main

deb  http://packages.sil.org/ubuntu bionic main

deb  http://packages.sil.org/ubuntu focal main

Adapt It WX is open source software. The source code for Adapt It WX
is freely available under the LGPL or CPL license at:

https://github.com/adapt-it/adaptit
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What tasks is Adapt It WX well suited to?
· Adapting an existing text or translation done in a related language, or dialect.
· Serving as a capable adaptation tool in collaboration with Paratext or Bibledit.
· Back translating a translation for checking by a translation consultant; whether or not the translation was produced by Adapt It.
· Glossing text.
· Producing interlinear exegetical helps for national translators, using the Greek NT or Hebrew OT as the source text.

· Producing formatted RTF documents according to the Word Scripture Template standard, for printing in a publishable format in a word processor application such as MS Word, LibreOffice or OpenOffice.
· Producing glossed documents, the glossing having been done in a national language that national translators can read, ready for adapting into a related language; for cluster translation project support.
· The Adapt It application supports Unicode encodings and fonts.
Preliminary Information and Special Notes

Prior to version 4 Adapt It could only run as an application under the Windows operating system. Beginning with version 4, Adapt It WX is the latest version of Adapt It utilizing cross-platform technologies. Adapt It WX is built on the wxWidgets cross-platform GUI framework (hence WX in the name). Using a single source code base built on top of the wxWidgets framework, we can now create programs that run natively on Windows, Linux and Macintosh systems. 
This document is designed to give an overview of the Adapt It application, terminology used for discussing its features, descriptions of its commands, and how to get started. More detailed help can be found in the online Html helps and other documents that are installed with Adapt It. The Help_for_Administrators.htm file describes in detail how translation program administrators can best utilize Adapt It in their translation programs. There is a Tutorial, designed to get you familiar with the application by adapting a short text of Melanesian Tok Pisin. There is also an Adapt It Quick Start HTML document to help you learn important Adapt It operations.
Some of the screen shots in this document may vary slightly from how the application currently looks on your system and computing platform. The software is updated from time to time, and so the appearance of some dialogs in particular might vary from what is shown in this document. If you find an error in this document, or encounter a problem or bug in the software, please read the “Known Issues and Limitations.txt” and “Adapt It changes.txt” included with your installation; and if the issue is not dealt with in the documentation, please notify the authors at the email addresses listed on the first page of this document.
Adapt It can handle source texts of virtually any size. Adapt It works with plain text files (*.txt) whether standard-format marked, or not.
We also make frequent reference to two important terms: "source text" and "target text". The source language is the one you are going to adapt from. The target language is the one you are going to translate, or adapt, into. For example, if you wanted to adapt a German text so that it was translated into Dutch, German would be the source text, and Dutch would be the target text.
In this documentation we talk about "adapting" source text. If you are not comfortable with that term, just think of it as "translating" the source text so that it becomes a meaningful and grammatical translation done in the target language. Throughout this documentation, the terms "adaptation" and "translation" will be used interchangeably, they are intended to mean the same thing.
Special Note to all users of Adapt It WX (any platform)
If you have used Adapt It previously and move your project files to a new computer with a different operating system or to a different version of Windows, Adapt It may have trouble reading your old configuration files. Adapt It WX should be able to automatically deal with this situation. However, in the event that it does not succeed, a manual solution is available: launch Adapt It WX while holding down the SHIFT key. This causes the configuration files to be bypassed and will get you up and running again, but you may need to access the Preferences… item on the Edit menu, and reset any settings such as font selection, punctuation, etc., set previously. Then when you have everything set up how you want it, close the application to cause new configuration files to be created, and save the knowledge base (or document) if asked. You only need to do this once. When your configuration files are correct, you do not have to hold the SHIFT key down while launching.
If you accidentally change Adapt It’s interface language to an exotic language that you cannot read and cannot figure out how to change it back to a language you can read, close the application; then launch Adapt It WX while holding down the ALT key. This will force Adapt It to present the dialog that allows you to select your preferred language for Adapt It’s interface.
Special Note to those using Adapt It WX on Windows:
Different versions of Windows have different capabilities. If you need to run Adapt It on any Windows9X, or Windows ME, you will need to use Adapt It Regular version 6.4.3 or earlier, since versions of Adapt It starting with 6.5.0 will only run on Windows 2000 or later. 
Adapt It WX Unicode (which supports Unicode) will run reliably only on Windows Windows 7, 8 and 10 versions, and you will need to make sure that your system has appropriate fonts, multi-language support turned on, and some complex script languages (such as Arabic) selected in Microsoft Office <version> Language Settings, if you want to be sure to get correct right-to-left rendering capability and text displayed correctly for such languages. 
Special Note to those using Adapt It WX on Linux and Macintosh:

Since all releases of Ubuntu, Wasta  and most other distributions of Linux fully support Unicode, only Adapt It WX Unicode is being made available for Linux users. Adapt It WX Unicode is also the only version available for the Macintosh. If you are moving to Linux or the Macintosh from Windows and you have only used the non-Unicode (Regular) version of Adapt It, and especially if the font you used was custom made (“hacked”) to provide any special characters, your data will most likely need to be converted to Unicode and you will need to use fonts on your Linux or Macintosh system that support Unicode. Converting text data from a non-Unicode encoding to Unicode is beyond the scope of this document. See your IT department for assistance if you need to convert your data from non-Unicode data to Unicode data.
If you need to run Adapt It on a Macintosh running OS X 10.4 or earlier, you will need to use Adapt It version 6.4.3 or earlier, since versions of Adapt It starting with 6.5.0 will only run on OSX 10.5 or later. 
Note to those using Keyman for special characters:

If you have Keyman turned on and you are typing a two-character combination to get a certain special character entered, and if the edit box where you are typing expands after the first keypress, then the second keypress will not be interpreted as part of the key combination, with the result that you will see the two characters you typed, rather than the expected special character. Solution: In the View tab of the Preferences dialog, there is an edit box with the title "Phrase Box white space slop and expansion multiplier", the box contains a number. If you are having problems with special characters not being interpreted by Keyman as expected, increase the number in that edit box - perhaps to 15 or higher; that should make the problem go away.
The Administrator menu
Versions 5.2.3 and higher have a hidden Administrator menu. Commands on this menu can be 'dangerous' for new users. (They might result in data loss if misused.) Therefore the Administrator menu is password protected. To gain initial access, so as to set one's desired password, requires access to it when there is no password set. So we have supplied a default password, admin, without the comma of course, which is hard-coded, and all lower case characters. It will always work, whether you set your own custom password or not. A password has to be at least 5 characters long, and may be any mix of letter, punctuation, and digits. Your custom password will be stored in the clear in the basic configuration file.  Please do not reveal the admin default password to new users you wish to protect from gaining access to the Administrator menu.
Getting Started

System requirements: operating systems: Windows 7 or higher; Linux (Debian/Ubuntu installations), Macintosh OS X (Intel) 10.5 or higher; processor, 100MHz or faster; RAM more than 32MB is recommended (will run with less, but the chance of failure is high due to possibility of the application running out of memory when you are multitasking or working on a large file); free hard drive space, approximately 30MB minimum. The minimum screen size for running Adapt It is currently 640w x 480h pixels. Recommended screen size should be 800 x 600 or greater.

Adapt It WX Unicode,is supplied for all platforms: Windows, Linux and Macintosh installations,The size and type of installation package depends on the operating system version, and whether the full installation (including helps and localization files) is desired. For the Windows OS, installers are available in the form of compressed installer executable files. For Linux, Debian packages are available for Trusty, Xenial, and Bionic (i386 and amd64), and for Focal (amd64 only). A disk image (DRM) installer  is available for the Mac OS X (Intel only) version. See one of the download sites (on title page) for downloads.

Read the Adapt It Quick Start (HTML) document for a quick explanation of how to start using the application. Or continue reading on in the next sections below. Administrators should read the Help for Administrators (HTML) document.

Setting the Language of Adapt It’s Interface

The following dialog will appear when you first run Adapt It on a given computer:
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The dialog shows a list of the available interface languages (called localizations). Adapt It will ask you to confirm or set the language of its interface.  English is the default but you can choose any of the languages shown in the list. Not all localizations are fully translated. English will be displayed for the parts of the interface which have not yet been translated. After you set the interface language this dialog will not appear when the application is run subsequently. See the section “Choose Interface Language…” in the discussion of the View menu for more information.

Using Adapt It For The First Time

Use the Start button and Programs menu or the Applications menu as appropriate and select Adapt It WX Unicode to launch the application.  Adapt It will run and you will see a welcome splash window. Click the OK button to make it disappear.  The window looks like this:
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When Adapt It is launched for the first time, it sets up the directory structures it needs. You should NEVER change directory structures set up by Adapt It, nor rename the folders it creates using an external program such as Windows Explorer, Finder or Nautilus/Nemo File Browser. (Here are the things you can do safely, provided you are willing to live with the consequences: delete a whole project; delete a document from a project; rename a document (but not while the document is open in Adapt It;) copy a project from another computer into your work folder; delete a knowledge base file, or backup file, or both; delete document backup files. Note: From version 5.2.0 Adapt It has a password protected Administrator menu that can be used to change the work folder location to a custom location, lock or unlock the work folder location, move and/or copy files, etc. – see the Administrator Menu topic.)  If you are using the Windows version, Adapt It will set up a work folder called "Adapt It Unicode Work" in your "My Documents" folder (or “Documents” on Vista/Windows 7, 8, 10). If you are using a Linux version, Adapt It’s work folder will be placed in your home user (home/<username>) folder. On the Mac it will be placed in your home folder (Users/<username>). As you work with the Start Working Wizard described below, Adapt It will set up additional folders within the Adapt It Unicode Work folder. If you want Adapt It to store its project files is a location other than the default location, see the “Set up a custom work folder” topic in the Help_for_Administrators.htm document. In rare instances you might even refer to "Using Adapt It with command-line options" section near the end of this documentation. 

Configuration Files
Adapt It stores most of the settings you use in two configuration files. There is a general configuration file, which has the filename AI-BasicConfiguration.aic. This file contains all the application-wide settings. It is updated every time you close the application. It is used to restore the application-wide settings every time you launch the application. It is saved to the Adapt It Work folder. It is a plain text file, so you can open it in a word processor and edit it if you want. (But only do that if you know what you are doing or if you are sure the configuration file has become corrupt and you know how to fix it.) There is also a second configuration file – for the project, so there is a different one for each project you have created. Each time you change a project’s settings or close a project, the project's configuration file is updated. The project configuration file is named  AI-ProjectConfiguration.aic and it too can be edited. It stores the font information, and just a few of the other settings which are in the AI-BasicConfiguration file, and some other things which are unique to projects only and so are not in the basic configuration file. If the settings in the project configuration differ from the ones in the basic configuration, then the project settings take priority. 

Beginning with version 5.20, you may also see configurations files that are named
   AI-AdminBasicConfiguration.aic 
   AI-AdminProjectConfiguration.aic 
These files are created when an Administrator runs Adapt It on his/her own computer but accesses an Adapt It work folder and project folders on a different computer over a network. 

Adapt It also saves a few settings in an application data location. These settings include many of the settings that can be configured on the Administrator menu, including settings related to Adapt It's help viewer, and settings related to the choice of interface language, collaboration settings, etc. In Windows these settings are contained in a file called Adapt_It_WX.ini (Its location depends on the computer platform type you use. For example, it is located in \Users\<username>\AppData\Roaming on Windows systems). On Linux and the Mac, these settings are contained in a hidden file in the user's home directory which has the name .Adapt_It_WX.

If you think the configuration files are corrupted (Adapt It fails on your attempt to launch it,) you can cause Adapt It to ignore them by holding down the SHIFT key for a while as you do the launching procedure. Hold it down until you see the Project page of the Start Working Wizard to reset basic settings. Hold the Shift key down while clicking "Next >" at the Project page with a particular project selected to reset the project settings for that selected project.. Holding down the SHIFT key will not reset the settings in the .Adapt_It_WX or Adapt_It_WX.ini file which stores some critical settings for restoring the settings (such as the interface language chosen, input/export folders under navigation protection, collaboration settings, etc) that were set up by an administrator. In a SHIFT down startup of a collaboration project Adapt It will prompt the user to confirm whether the collaboration settings should be removed or retained.

When Adapt It is first launched, it sets up a folder for your adaptation project. (If you want to have more than one project, you can later create them and then additional folders will be created and placed in the Adapt It Work folder too, one for each different project.) Inside each project folder, Adapt It stores a knowledge base file, and a backup for it if you have that option turned on. The knowledge base is a storage location for information about the adaptations in the target language which you make for source words or phrases.

Also, within the project file, Adapt It creates a folder called Adaptations. This folder is where the application stores each Adapt It document file. An Adapt It document is an xml formatted file that contains the adaptations you make for a source text, such as a book of scripture (eg. Romans, or Hebrews, or whatever), or a literacy text. Adapt It document files are not the same as the knowledge base. Each project has only one knowledge base, but potentially dozens of documents – there will be a document file for each individual text you adapt. 

Adapt It version 6 also creates a number of “special” sub-folders. A few are created in the main Adapt It Unicode Work folder, but most are created within each project folder. These folders are automatically created as standard locations for storing specific kinds of input and output files. These folders begin with one or two underscore characters and their names are in all upper case letters. They include __SOURCE_INPUTS for storing source language input texts,  _FREETRANS_OUTPUTS, _GLOSS_OUTPUTS, _SOURCE_OUTPUTS, _TARGET_OUTPUTS, and their RTF counterparts, _REPORTS_OUTPUTS, _INTERLINEAR_RTF_OUTPUTS, _XHTML_OUTPUTS, _PATHWAY_OUTPUTS, and four folders that can store certain kinds of files that may be used as both inputs and outputs – including _KB_INPUTS_OUTPUTS, _PACKED_INPUTS_OUTPUTS, _LIFT_INPUTS_OUTPUTS, and _CCTABLE_INPUTS_OUTPUTS. The _CCTABLE_INPUTS_OUTPUTS, _PACKED_INPUTS_OUTPUTS, and additional folders called _LOGS_EMAIL_REPORTS and _DATA_KB_SHARING are created in the top level Adapt It Unicode Work folder. All of the others are created in each Adapt It project folder. For all of these special folders, the administrator can use the “Assign Locations for Inputs and Outputs” dialog from the Administrator menu to configure Adapt It to only use these locations, and use them automatically requiring no interaction from the user. See the Help for Administrators document for more details.

When the welcome window goes away, the normal setup calls the Start Working Wizard, which will help you to set up the application for work, and get you started working on your first document. 

The first page of the wizard – called the Choose a Project page - will look like the picture below with the "<New Project>" item highlighted if you have just launched Adapt It for the first time. 
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If you have already created one or more projects, the list box will list them all, and when the page is first shown to you, the project that was open when you last used Adapt It will be shown highlighted. Therefore, if the last project you used was “Takia to English adaptations”, the Choose a Project page would look like this:
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There is a button at the top called "What Is A Project? …" which you can click if you are not too sure what a project is, and how it differs from a document. It will show you a brief explanation. 

In the first wizard page, double click on the "<New Project>" item (or click on “Next” while <New Project> is highlighted). The second wizard page will appear.  It will look like the following:
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This page, called the Define Source and Target Language Names page, asks you to type names for the source text language (or dialect), and the target text language (or dialect). It also allows you to optionally enter the official Ethnologue codes for the source and target languages (if you know them). Click on the Lookup Codes button to select appropriate codes from the official list. Click the Next> button to go to the next page, after typing appropriate source and target language names.

Note: the Define Source and Target Language Names page only appears when the user is setting up a new project, and once the project has been created, there is no way to make the languages page reappear when working within that project. So the user has only one shot at getting the settings for these two controls to correctly conform to how the source text data is structured. If the user gets the settings wrong, exit Adapt It, delete the project folder and its contents using an external file utility such as Windows Explorer, Ubuntu’s File Manager, or the Mac’s Finder; then relaunch Adapt It, and set up the project a second time - this time choosing the correct settings. 

The third page, called the Choose Fonts and Font Characteristics page, allows you to set up fonts, including their size, style and colour, for the kinds of text that Adapt It knows about. This is what it looks like:
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The three Change Font… buttons take you to a standard font dialog used on your operating system, where you can set the font, the text size, styles such as regular, bold, italic, or bold and italic. The Set Custom Color… buttons take you to a standard colour dialog used on your operating system, where you can set the text colour for certain text elements. You should set different colours for the source text, target text and navigation text, to make it easier when you are working. On some operating systems the standard font dialog allows you the option of setting the font to a limited subset of colours. If you use the Set Custom Color buttons instead you will have a much wider variety (millions) of colours to choose from. The default colour for Source text is blue and for Target text the default is black.

"Navigation text" is text which tells you where you are in the document, such as chapter and versus numbers, and information about backslash markers. The same font is also used in some of the dialogs, especially for text you type for filenames, folder names, language names, document names, and so forth. Navigation text is shown immediately above a strip of source text. The default colour for Navigation text is a light green.

"Special text" is any text that is not verses, or poetry - such as subheadings, titles, references, and so forth. It's a good idea to give special text its own colour, different from the source text colour, the default is red. You can set the Special Text colour using the Set Special Text Color… button. "Retranslation text" is text which is a new translation of the source text, instead of adapting the source text. The default colour for Retranslation text is a dark olive colour. You can set the Retranslation Text colour using the Set Retranslation Text Color… button. The Set Text Differences Color… button allows you to set a temporary colour for words and phrases in the target text which differ from the source text immediately above them.

Click Next> when you are done with the Fonts page. (You can always change your settings later, if you don't like them, at any time when a document is open, using the Edit … Preferences … menu item.)

At this point the Define Source and Target Punctuation Correspondences page will appear. This page is the place to specify what the source text's punctuation characters are, what the target text's punctuation characters are, and what are the correspondences between members of each of these two sets of punctuation characters. When Adapt It inserts the punctuation for you in the target text's adaptations, it will use these correspondences to work out what the appropriate target punctuation character should be. The dialog looks like this:
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Single punctuation characters can be entered in the columns on the left, and double punctuation characters can be entered in the wider columns on the right.
You should take care to do these things, and understand these behaviours:
· Every source text punctuation character needed should be somewhere in the Source column of one of the left column-pairs, add them at the end of the list. If necessary remove unwanted default characters from some of the cells and type the ones you need in their place. (See the last point for an exception to this rule.)
· Every target text punctuation character that is needed should be somewhere in the Target column of one of the left column pairs, and likewise you can replace unwanted characters with the ones you need if there are not enough cells in the dialog to add them at the end. (See the last point for an exception to this rule.)
· Each row of each column pair defines a correspondence. So type in the Target cell whatever punctuation character corresponds to the one in the cell to the immediate left in the Source column.
· You can leave some cells empty, either in the Source column, or in the Target column, or both. (If a source cell has no punctuation character but there is something in the cell to the right, Adapt It will not insert the target punctuation character anywhere automatically. If a target cell is empty but there is a source punctuation character in the cell to its left, Adapt It will insert no punctuation character automatically into the target text when that particular source punctuation character is encountered in the source text.)
· In the right side of the dialog are some larger column pairs, here you can type any correspondences between pairs of punctuation characters, or perhaps between pairs of punctuation characters and a single punctuation characters. For example, << might correspond to " in the target text. Any punctuation characters unique to this list (that is, they are not listed in the left hand column pairs), will be quietly added to the list of punctuation characters which Adapt It maintains. 
· The punctuation correspondences you set up here are stored permanently in Adapt It's configuration files. Adapt It uses those files to restore your punctuation settings when you next launch it.
Click the Next button to move to the next page of the Start Working wizard. The next page is the Define Any Lower To Upper Case Equivalences page in which you can set up any lower and upper case equivalences, providing such distinctions are a characteristic of the source text you are using and you want to make similar distinctions in the target text. The page initially shows only one checkbox which is labelled as: “Check here if the source text contains both capital letters (upper case) and small letters (lower case)” [see illustration below]. If you check this first checkbox, a second checkbox appears which asks, “Check here if you want Adapt It to automatically distinguish between upper case and lower case letters.” Finally, if you put a tick in both of these checkboxes, the Case page displays the remainder of the choices you can make for setting up your case equivalences. The default is to set up the Latin or English set of equivalences – and then the user can add to this set any special characters required for correct writing of the language. The English set does not have to be used. This dialog is used in conjunction with the Use Automatic Capitalization command on the Tools menu; and the dialog is the only way to set up the required case correspondences. The dialog has this appearance:
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Follow the directions on the page. You can use the buttons below each column to initialize the lists with a default set of lower and upper case equivalences or to copy from one list to another. The pairs of letters in each list are editable so you can make adjustments directly to the lists. Remember, in this dialog, each line must specify a pair of letters – and the lower case one must come first. For languages which read right-to-left, "come first" will mean that the lower case letter is on the right of the upper case one.

Click on the Next button to advance to the Define USFM and Marker Filtering (Marker Hiding) page. This page allows you to select the overall standard format marker (sfm) set that is used in the source texts you will be adapting, as well as the marker filtering for both any current document (if open) and the default settings for your projects. The default set of markers is the United Bible Society’s UBS USFM 2.0/3.0 Set Only.  The USFM and Filtering page looks like this:
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If you upgrade to Adapt It WX Unicode from an older legacy version of Adapt It which used the older SILPNG 1998 Set of markers, the default may initially be set to use that set. All documents in a project should normally use the same set of standard format markers. The important thing to remember is to choose the set of markers here that is consistent with the markers actually used in the source texts you will be adapting from. 
The lower section of this page allows you to “filter” or “hide” the text associated with certain individual markers so that they are not presented to the user for adaptation. Some markers within a given sfm set are always filtered (hidden) and are never shown in this list. Those that are shown in these lists are eligible to be filtered (hidden). 
After you start creating documents the USFM and Filtering page can be accessed from Edit menu’s Preferences… selection.
Click on the Next button and you will see Adapt It's Choose a Document page. The Choose a Document page allows you to create a new document or open an existing one. Once your project setup is complete it is this page of the Start Working wizard you will always use to either create new documents for adaptation, or to open existing documents to continue working on them. The Choose a Document page looks like this:
[image: image11.png]Start Working
Choose a Document

Ifyou want to create a new document, double clck <New Document>. I you want to continue work on a
‘document you created previously,you will see ts name in the st - double click the name to open that document.

Book folder mode is OFF Whatis adocumen
Documents are being saved to the Adaptations folder

Make diagnostic ogfile during document creation and opening
change UsFM fixed space markers (-) to regular spaces
Force UTF-8 encoding for source data input

<Back Finish  Cancel





There is a button near the top called "What Is A Document? …" which you can click if you are not too sure what an Adapt It document is, and how it differs from a documents made by other applications. It will show you a brief explanation. If you have already created some Adapt It documents, their names would appear in the list box under the "<New Document>" entry.


You can create a new document using the "<New Document>" item in the list box. Information you need to know about new Adapt It documents is the following: they do not start off "empty." Since you will want to adapt some source text, a new document starts off having the whole source text for adaptation within it. So the new document loading process will ask you to locate the file containing the source text for adaptation. The source text you use must be in a "Plain Text (*.txt)" type of file. Adapt It will not accept for input source texts that are not plain text. Do not try to use a MS Word *.doc, *.docx or OpenOffice *.odt type of file – this is a common error new users make. Adapt It will warn you if you attempt to input one of these types of document files  as source texts for adaptation. Also you should never try to use an XML file (such as the one of Adapt It’s already created .xml adaptation documents) as an input text for a <New Document>. Use only a plain text file to create a <New Document>; one which preferably contains standard format markers.
Note: If you previously attempted to create a “<New Document>” and experienced a program crash, you can create a document creation/opening log by ticking the check box “Make diagnostic logfile during document creation and opening” before attempting to create/open a document for adaptation. The log file, when created, is stored in the _LOGS_EMAIL_REPORTS folder in the “Adapt It Unicode Work” folder. Please send the document creation/opening log file to the Adapt It developers for analysis – if you experience a program crash when creation/opening an Adapt It document.


Double click the "<New Document>" item, or single click on it and then click the Finish button. Adapt It will then call up a standard file dialog from your computer’s operating system. Use it to navigate to whatever text file you wish to adapt, or to a file of "play" data if you wish to try the application with some test data - the data should be plain text, or it can be standard format marked plain text data. The file can be anywhere, on any drive, in any folder. Select the file you wish to open and work on. Adapt It will then put up the following small window asking you for a name to be used to name the output file which it makes when it wants to save your work. For example, if you selected the file Tok Pisin fragment 1 John.sfm, you will see the same name used for the file name suggested in the dialog that appears as shown below:
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You can adjust the name to whatever you want – just be sure that the name describes what is in the file. When Adapt It saves your documents, it automatically adds an ".xml" filename extension to whatever name you supplied in the above dialog. Adapt It also "remembers" in a configuration file where you got that file from, so when you next create an Adapt It document, it will show you the same folder that you used last time. The dialog box also indicates which characters are NOT valid file name characters for the operating system you are using - Adapt It will not accept those characters as part of the name you enter here.

When you click the OK button in the "Type a name for this data" dialog, Adapt It will then parse the file you selected earlier, and display it in the view window.  For instance, the display showing some Melanesian Tok Pisin text (some verses from 1 John) when first opened, may look similar to this:
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Collaboration  (with Paratext, or with Bibledit) An Overview
Until Adapt It version 6 was released the main way that Adapt It created new documents - or opened existing adaptation documents - was by means of the Start Working Wizard. With version 6 the wizard is still the default method for getting started in adaptation work and the “Select a Project” page will always appear regardless of the way Adapt It is configured. However, with version 6 of Adapt It an administrator can use the hidden Administrator menu to set up Adapt It to collaborate directly with an external editor’s on-disk storage such as  the storage for Paratext or Bibledit. When an administrator configures an Adapt It project to be able to operate in collaboration with Paratext or Bibledit, Adapt It will still show the “Select a Project” page of the wizard, but the “Select a Document” page of the wizard may not appear after the user selects a project – depending on whether that selected project is capable of collaboration with Paratext or Bibledit. If the administrator has configured the selected project for possible collaboration the following dialog will be displayed to the user:
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The user has three options for entering a project that the administrator has configured for collaboration. There is also a “Tell me more about these options” button which explains the three options in more detail. 
The three options correspond to the three radio buttons in the above dialog. The first two buttons are designed to allow the user to decide whether he wants to work on texts in that project with collaboration on or off. When he elects to “Work with my Paratext/Bibledit Scripture texts (Collaboration on)" and clicks the OK button, the wizard will close and he will see the main book/chapter selection dialog (see below). If he elects to “Work with other Adapt It texts (Paratext/Bibledit texts not available: Collaboration off)" the wizard will continue on to the "Select a Document" page of the wizard, where he can then select any non-collaboration documents that are available for adaptation work. With collaboration turned off the user will work with Adapt It, adapting non-collaboration texts in the same way that Adapt It worked before its collaboration features were added in version 6. Thus, a single Adapt It project may contain documents that are created both when collaboration is on, and when collaboration is turned off. When collaboration is turned on, the user never needs to interact with any document files - he only chooses scripture books and chapters the collaboration dialog (see below). When collaboration is turned off for the same Adapt It project, the user will see and interact with only non-collaboration documents using the "Select a Document" page of the wizard.
The third option for entering a project is designed for advisors and consultants to use. It is labelled "Read-only mode (All texts accessible but not editable – I’m an advisor or consultant)". When this option is selected, collaboration mode remains off and the "Select a Document" page of the wizard appears. In this case all documents, both collaboration documents (whose names begin with "_Collab...") and non-collaboration documents will appear in the list of documents, and any of them can be opened. However, with this third option in effect, all documents opened will be in read-only mode. This mode is designed so that an advisor or consultant can view the user's work without risk of making any unintended changes. When in this mode, the background of the main Adapt It window will be pink as a reminder that read-only mode is in effect and no changes to the document can be made.

When the user selects "Work with my Paratext/Bibledit Scripture texts (Collaboration on)" after a short pause the following collaboration dialog will appear:
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This is the main dialog that the user will see when collaboration is turned on for the given project. From this simple dialog the user can select a Scripture book and chapter for collaboration. The dialog shows a list of the scripture books available in Paratext's/Bibledit’s Source Project. When collaboration is being done with Paratext, it indicates which version of Paratext is being used (“Using these Paratext 8 projects” above). It also shows the chapters for the book together with information about the status of the target text as it is currently stored in Paratext's/Bibledit’s Target Project. The user can select any Paratext book and chapter to work on. When OK is clicked, Adapt It automatically fetches the source text and any existing target text from Paratext/Bibledit and displays them in Adapt It's main window, ready to continue the adaptation process. When work is saved within Adapt It, Adapt It automatically transfers the saved target translation back to the appropriate Paratext/Bibledit project. If a Paratext/Bibledit project is set up for storing free translations, those are also saved in the appropriate Paratext/Bibledit project.

In the past working chapter by chapter in Adapt It and then moving the results to Paratext/Bibledit involved a lot of manual work -- copying and joining chapter files together into whole books and copying them back and forth between Adapt It and Paratext/Bibledit. Not any more! Adapt It knows how to handle the consolidation of books into chapters and how to break books into chapters. All the details and organization of files are processed behind the scenes and invisible to the user. During collaboration work the user never needs to navigate around in the computer's file system and never needs to find or copy or move files.

Note: When Adapt It works in collaboration with Paratext/Bibledit, it not only transfers data between Adapt It and the selected Paratext/Bibledit projects -- it also maintains its own collaboration project in the computer's "Adapt It Unicode Work" folder. If the Adapt It project has already been established and work has already been done in the two languages, the collaboration project can take advantage of the previously developed project knowledge base. The collaboration project continues to develop the knowledge base. You should be aware however that you cannot continue to work on previously created documents while Adapt It is in collaboration mode. Collaboration mode must turned off to work in standard Adapt It documents. (There is no difference in internal format between standard documents and collaboration documents. The difference is in the filename only. Collaboration documents’ filenames have a fixed structure, and always begin with "_Collab_". In collaboration mode, Adapt It only "sees" documents which begin with "_Collab_", the others are not made accessible to the user while collaboration is in effect.)

See the Help for Administrators help file for more information about how Adapt It 6 can now be set up for collaboration with an external editor such as Paratext or Bibledit.

Note: If you previously attempted to select a book/chapter and experienced a program crash, you can create a document creation/opening log by ticking the check box “Make diagnostic logfile during document creation and opening” at the bottom of the dialog before attempting to create/open a collaboration document for adaptation. The log file, when created, is stored in the _LOGS_EMAIL_REPORTS folder in the “Adapt It Unicode Work” folder. Please send the document creation/opening log file to the Adapt It developers for analysis – if you experience a program crash when creation/opening an Adapt It document.

You might like to read a little further – a few pages down to the section about Selection Rules, to get an idea of ways you control Adapt It so that it does what you want. Then do the Tutorial Exercise, which will get you understanding how Adapt It works without having to do a lot of reading. Or you can go straight to the Tutorial now (it is in Adapt It Tutorial.doc).

From version 6.6.0 Adapt It’s collaboration feature has been improved, some bugs fixed, and the option for user-guided conflict resolution has been added. The new conflict resolution features involve two new dialogs. The first allows you to choose between 3 options. The second is what you will see in the second dialog which only comes up if you chose the last of the three options. More detail follows.

 Adapt It is able to resolve some conflicts automatically. This has always been the case, and those capabilities are unchanged. For example, if an adapt it verse is empty, but the Paratext verse has content, Adapt It does not change the Paratext verse. Or if the Paratext verse is empty, and the Adapt It verse has content, Adapt It always transfers the Adapt It verse to Paratext. The kinds of conflicts that up to 6.6.0 were not able to be handled by Adapt It were:

(a) You did some edits in the Adapt It document with collaboration mode turned off, then later on your turned collaboration mode back on. Versions earlier than 6.6.0 would fail to transfer those edits done outside of collaboration mode into the Paratext (or Bibledit) data storage.

(b) You did some edits within Paratext (or Bibledit if that is the external editor you are collaborating with). It was dangerous to do this because prior to 6.6.0 if you later edited within Adapt It the same verses, and did those Adapt It edits differently, then the Adapt It edited form of those verses would automatically replace what was in the Paratext same verses.

To avoid problems like the above, Adapt It will detect conflicts of that nature, and show you a dialog with 3 radio buttons, and explanations for what they do. The three options are:

(Top button) 

The legacy "keep the Paratext or Bibledit form of the conflicting verses"

(Middle button) 

Force the Adapt It form of each conflicting verse to be transferred to Paratext 




(or Bibledit) without any more user interaction. (This is the option you would 




choose if situation (a) above was the case.)

(Bottom button)

You want to see each conflicting verse (and the source text for the verse too)




so you can choose which version of the verse to accept, or possibly to do edits




to make the Paratext or Bibledit version be different than either of the conflicted




versions of the verse. This option gives you full control. But you must interact




with a further dialog.

Shown below is what this first dialog looks like, it is a ‘Conflict Actions’ dialog. You choose what kind of conflict resolution action suits your situation. You can’t force this dialog to open by any menu choice. Adapt It opens it automatically, and only when you have just done a File > Save (Transfer Target Text to Paratext) menu choice (or Ctrl+S), or the equivalent choice for Bibledit, the first programmatically unresolveable conflict has just been found.

Please note. Normally, you  need use the bottom button only once; thereafter, provided you do not produce changes outside of collaboration mode, you would use the top button at subsequent saves of the adaptation document. Once your conflicts have been resolved, using the top button keeps things that way. However, if you do special things such as one of the following three, then you should use the bottom button a second time after doing one of these:

(1) You edit some verses manually within Paratext (or Bibledit).

(2) In Adapt It you do an “all documents” Consistency Check. (Because that can produce changes in one or more documents that current is not open in the collaboration.)

(3) In Adapt It, you end the collaboration, then do edits to a document formerly part of the collaboration process, then later you reestablish the collaboration again. (Your edits done outside of collaboration will be seen, when the collaboration is restored, as new conflicts.)

After doing one of the above three scenarios, then when at a save you see the Conflict Actions dialog again, you should choose the bottom button so as to do a full conflict resolution. After doing that, and provided you do not do one of (1) to (3) again, just use the top button choice.
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If you select either the top button, or the middle button, then when you click the OK button, the dialog goes away and you see no other dialog, and the Save and transfer of data to the external editor’s storage (for  Paratext, or for Bibledit) then runs to completion, and conflicts are resolved in the way you chose.

Note the checkbox at the bottom: Turn off conflict resolution. (Turn it on again, in Preferences).
This checkbox suppresses further showings of this dialog while you continue to work on the current adaptation document. It also, when clicked, suppresses the showing of the conflict resolution dialog discussed immediately below. (That dialog also has the same checkbox in it, so you can click there instead if you wish.)

Clicking this checkbox does not actually suppress all conflict resolution; it just causes the legacy conflict resolution protocol to operate – which is to retain unchanged in Paratext, or in Bibledit, any conflicted verse’s contents. And as the label says, at any time you can go to the View tab of Preferences, and a checkbox there at the bottom of the pane allows you to turn the full conflict resolution mechanism back on. 

When is a good time to turn conflict resolution off using the checkbox? After you’ve done a full conflict resolution for the current document, and you then won’t need to redo the check provided your editing is changing only the currently open document. It is impossible to create a conflicted verse by working in Adapt It’s main window. So having resolved all the conflicts once, you can safely turn off the dialogs by using the checkbox, for that particular document.

Turning of conflict resolution only works until you close the current adaptation document. Once you start work on another document, all the conflict resolution options are turned back on automatically. 

The checkbox in the View tab of Preferences for turning the full conflict resolution feature back on, looks like this:
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If the top radio button, or the middle one,  in the dialog do not give you the control you need,  or if you are unsure about what level of conflict resolution suits your current situation, you should click this bottom radio button: You want to see the conflicting verses, and manually choose which versions to accept.
If you click that option, then after all the conflicts have been gathered you will see the dialog below. When it appears it lists all the conflicted verses found in the current chapter, or the current book if you are collaborating in "whole book mode". You make your choices within it, do any edits you feel are needed (edits can only be done in the right hand text box of the two side-by-side text boxes), and then press the Transfer The Listed Verses button. Then the File > Save (Transfer Translation Draft To Paratext) operation runs to completion, and after that your conflict resolution choices and any edits are applied and the data storage of the collaborating external editor (whether Paratext of Bibledit) is updated accordingly.

Note, wxWidgets dialogs are resizeable. You can click on any corner and drag the dialog wider, or deeper, or both. You can click on any side and widen it, or deepen it. Resizing it larger may be useful so you can read all of large verses without having to scroll the text boxes.

The conflicting verses are listed, with a 3-letter code for the book, and then the chapter and verse number. There is a checkbox for each conflict in the list. If you click on the book or chapter:verse reference, the dialog will display the conflicting verses for that reference. If you click instead on the checkbox in the list, two things happen: first, you see the conflicts of course, but you are also choosing that the Adapt It version of that verse (what you see in the left text box – which is read-only and so cannot be changed) is the version of the verse that will be sent to Paratext (or to Bibledit). If you don’t want that Adapt It version sent, just click the checkbox again to remove the tick.

The right hand text box (which displays the Paratext, or Bibledit version of the verse) is fully editable. Even though the left had box will not accept typed characters, you can select and copy to the clipboard anything in the left box, and then copy that into the right hand box. Whatever is in the right hand box is what gets sent to the external editor after the Transfer The Listed Verses button has been pressed. If you make edits and change you mind, you can restore the original text that was in the right hand box by clicking the Restore button.

The checkboxes in the list work in sync with the two radio buttons "Send this Adapt It version" and "Send this Paratext version". Clicking Send this Adapt It version results in the checkbox in the list becoming ticked. Clicking Send this Paratext version results in the checkbox in the lists losing its tick.

Because the most likely conflicts will be because you or someone has edited the Paratext or Bibledit verses, if the list of conflicts is long, the best option will be to leave all unticked, and just tick the few that you are certain are better versions than the external editor’s version. In the unlikely event that the Adapt It versions are mostly the best, you can use the Tick All Verses button, and then un-tick the few that you are sure are better in Paratext or Bibledit already.

Note that this dialog also has, at the bottom, a checkbox which allows you to turn off subsequent attempts to show this dialog to you while you are editing the current document. And you can, at any time, turn back on the manually guided conflict resolution feature - by going to Preferences, to the View tab, to the checkbox:
Turn off conflict resolution. (Turn it on again in Preferences.). 
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What does Cancel do?  It does not cancel the File Save, nor does it cancel the transfer of data to the external editor. Instead, it causes the legacy "safe" conflict resolution to happen. Every conflict, not matter what edits you made and any choices for Adapt It versions to be preferred, all those things you may have done are ignored. Every conflict is then resolved by sending the original Paratext (or Bibledit) verse version back to the external editor. It’s the same as if you made no manual edits, and left nothing ticked in the list, and then clicked Transfer The Listed Verses.

Protecting Paratext / Bibledit texts from getting any further changes from Adapt It

After drafting texts in collaboration with Paratext or Bibledit, there comes a time when those texts are revised and polished within Paratext/Bibledit, and further changes from Adapt It should no longer be transferred to those texts in Paratext/Bibledit. Adapt It now has a feature that allows the administrator to designate which books and chapters should be ‘protected’ from getting any further changes made in Adapt It. There is now a menu item on the Administrator menu called, “Manage Data Transfer Protections to Paratext or Bibledit...”. This menu item presents the following dialog:
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The dialog allows an administrator to select an Adapt It collaboration project and designate which books and chapters should no longer transfer changes made from within Adapt It to the Paratext or Bibledit version of those books/chapters. The appearance and functionality of the dialog depends on whether a collaboration project was set up to collaborate using “Chapter Only Documents” mode or “Whole Book Documents” mode. The above image shows an example of the default “Chapter Only Documents” mode. 

In the dialog the administrator follows the 3 numbered steps:

(1) Selects an AI collaboration project from the drop-down list - in our example case it would be the 'Language S to Language T adaptations' project. The possible books appear in the 'Books' List.

(2) The administrator selects the book of Mark from the 'Books List' - and the dialog displays the 16 chapters of Mark in the 'Chapters List' with empty check boxes next to each chapter.

(3) The administrator then clicks on the "All Chapters of Book" button to put ticks in the check boxes of all 16 chapters.

Finally the administrator clicks on OK to save the 'protection' settings for all chapters of the book of Mark. The draft that exists in Paratext for that book is now 'protected' in the sense that any changes that get made back in the chapter documents of Mark within Adapt It will no longer be transferred to Paratext.

Some teams set up a collaboration project in Adapt It to collaborate with Paratext using ‘Whole Bookents’ mode rather than using the default ‘Chapter Only Documents’ mode. In such cases the "Manage Data Transfer Protections to Paratext or Bibledit" dialog appears like this:
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In this version of the dialog the administrator again follows the 3 numbered steps:

(1) Selects an AI collaboration project from the drop-down list - in our example case it would be the 'Language S to Language T adaptations' project. The possible books appear in the 'Books' List.

(2) The administrator selects the book of Mark from the 'Books List'. The ‘Chapters List’ is disabled since in ‘Whole Book Documents’ mode, collaboration only gets whole books from Paratext, and the Adapt It documents are whole books rather than individual chapters.

(3) The administrator then clicks on the check box for the book he wants to “protect” in Paratext, or alternatively selects one of the range buttons below the ‘Books List’ to select a range of books.

Finally the administrator clicks on OK to save the 'protection' settings for the whole book(s) selected. The draft that exists in Paratext is now 'protected' in the sense that any changes that get made back in the book of Mark within Adapt It will no longer be transferred to Paratext.

The team continues the revision process of the book of Mark within Paratext until the book has gone through all the revisions to an advanced/polished state. That polished state might include consultant checking and even publishing. Up to this point no further work has been done on the old drafts that still exist in the Adapt It project.

What advantage is there to “protecting” documents from data transfers?  With all the chapters of Mark 'protected', and after the book of Mark has been revised to an advanced state in Paratext, the team can then bring the ‘final’ revisions back into the Adapt It documents and thereby greatly improve Adapt It’s knowledge base for the project. The expanding and improving of the knowledge base makes adapting/drafting of future collaboration documents in the project much more accurate and faster. And, during the updating process, the advanced drafts in Paratext/Bibledit are “protected” from getting spurious changes when the texts are saved within Adapt It and its knowledge base. 

How should the knowledge base updating take place? One way is as follows: Once the book/chapter protections are done, the administrator asks the translator to open the old Adapt It 'Language S to Language T adaptations' project in one desktop window, and Paratext in another window with the Language T Paratext project displaying within Paratext, so that the translator can compare the polished version in Paratext’s Language T project with the ‘target’ Language T in the old drafts in the Adapt It project. Alternatively, the administrator could print out the advanced draft and have the translator compare the printout with the old draft within Adapt It. The administrator asks the translator to open each chapter (or book for whole book mode) of Mark in Adapt It and compare the old drafts with the more polished version in Paratext - and make changes in the Adapt It drafts to make them read as much the same as possible as the polished version. 

The purpose of this updating of the draft in Adapt It is to update Adapt It's knowledge base for that project so that it contains the updated translations /adaptations that were added in Paratext after work ceased on the draft in Adapt It. Since the book of Mark has been marked as "protected from transferring changes to Paratext" the updating changes will only be saved in the local Adapt It project, and not transferred to Paratext - thus "protecting" the advanced Paratext draft from unintended changes as the translator saves the updates in the chapter documents of Mark being saved within the Adapt It project. This extra updating work on the part of the translator will pay off big-time since all the revisions and updates that were done for the book of Mark in Paratext will be brought back into Adapt It’s knowledge base and be immediately available for the next book that is adapted/drafted in that Adapt It collaboration project.

A translation team might follow this process for each book translated, so that each collaboration book in turn can be drafted in Adapt It, the polishing work done exclusively in Paratext or Bibledit - the administrator having used this new feature to "protect" Paratext/Bibledit from any old drafts being transferred or overwriting the advanced drafts. 

As described above the new feature is available to administrators for ‘bulk’ setting of books/chapters through the “Manage Data Transfer Protections for Collaboration Editor” dialog (from the Administrator menu). This protection feature is also available in a more restricted form to non-administrator users via two new menu items in Adapt It' Advanced menu:

      Prevent Paratext/Bibledit from getting changes to this document
      Allow Paratext/Bibledit to get changes to this document

The above two menu items are enabled in the Advanced menu only when a collaboration project document is opened within Adapt It. With these menu items a user can tell Adapt It to "Prevent..." or "Allow...." changes made in the document transferring from/to Paratext/Bibledit when Adapt It saves the document. As with the bulk dialog (available from the Administrator menu), the protection status for the document is saved and remains in that protected state unless it is explicitly changed - either by using one of the two Advanced menu items or by the administrator in the bulk change dialog from the Administrator menu. The two new Advanced menu items are limited, because the user can only change the protection status of the open collaboration document, and cannot change the protection status for all chapters of a book (or whole book) without opening each chapter (or book) and invoking one of the above Advanced menu choices on the open document.

See the “Help_for_Administrators.htm” document for more details and how a collaboration scenario might play out, using this data transfer protections feature. If you do not need ZWSP  nor East Asian Languages support, you can skip down to the Understanding The Adapt It Interface section of this document.

ZWSP Support
Some languages of East Asia are supported in a special way. Zero width spaces (ZWSP) are used for separating words. Adapt It supports a special mode (which Paratext also supports) in which a solidus (a /  or "forward slash") is shown, replacing each ZWSP, when the text is in a text box and therefore potentially editable. The forward slashes make it clear where words begin and end. But when the text is displayed elsewhere, such as the interlinear layout, the forward slashes are replaced again by ZWSP. This special mode is supported in the above conflict resolution dialog – but only provided the user first chooses the special ZWSP & Solidus supported mode first. The latter choice is made in Preferences..., the View pane, with this checkbox:
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If the user has that choice ticked (the choice is remembered in the Project configuration file), then when in collaboration mode and the conflict resolution dialog opens, there is an additional checkbox at the bottom right, as follows:
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The "Show Slashes ( / ) "  checkbox allows the user to turn on the conversion of any ZWSP to forward slashes in the side-by-side text boxes. That helps editing. Then, if he wants to see how the text looks when normally displayed, he can tick the checkbox again, and then the words are shown with their ZWSP characters replaced.

You do not need to worry about whether / or ZWSP is being used at the time that the Transfer All Listed Verses button, or the Cancel button, is pressed. Adapt It will check, and automatically re-establish the ZWSP delimited text format if the other format was in effect at the time of the button click. Other information concerning ZWSP support can be found below in this document, or by searching for ZWSP Support.

The sections below are reference information, and so they have more details than you may be able to absorb right now. Read them when you are ready for them, and want to know the details. 

East Asian Languages Support

ZWSP Support (“zero width space” support)
Version 6.6.0 supports ZWSP  (Zero Width  SPace)  used as a word delimiter (and other special or similar characters). In versions earlier than 6.6.0, these were supported only on input of text to create the laid out Adapt It document. Now, starting with  6.6.0 version, the word delimitation character is remembered, and restored at the export of the target text (or in other exports). (Free translations will export ZWSP delimited text too, but only provided you type the free translations with ZWSP explicitly where appropriate, in the first place.)

The provision of ZWSP support was occasioned by the lack of restoration of ZWSP (Zero Width Space) characters when exporting translation in scripts like that of Lao or Kmer in some South East Asian languages. Now the ZWSP characters will appear in the export where expected. ZWSP can be mixed in the document with latin space, and other special space-like characters in the 0x2000 to 0x2009 range (ZWSP is 0x200B), and Adapt It will remember them and where they occur and restore them in their proper places in the export. Note, immediately after any beginning USFM marker, only normal latin space should be used, never ZWSP; the text which then follows can, of course, have ZWSP between the individual words.

Legacy documents which do not store the wordbreak characters will still open correctly. For them, a normal latin space will be automatically provided and stored – so their appearance, and their exports, will not change in any way.

Adapt It will automatically break words when constructing a document anytime a ZWSP or similar space, or Latin space, is encountered when parsing in the source text. It is up to the user, however, to decide whether restoration of the spaces stored is to be done, that is the default, or to force the use of only Latin spaces in the exports. A radio-button choice for forcing the use of Latin spaces is in the Define KB and Miscellaneous Options page of the Preferences:
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Note the radio button that says:

Copy the source text word breaks to use them for the adaptation word breaks
The default option is to have that button turned on.

If instead you chose the lower button:

Programmatically join adaptation words only with normal spaces
then Adapt It will ignore the stored ZWSP spaces if any are stored in the document, and only use normal latin spaces in the exported translation text.

The View page tab of Preferences also has some settings related to ZWSP support:
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In the above Preferences View tab page, there is a checkbox and a slider control that looks like this:
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These controls are provided to users who want to type in ZWSP characters, but do not have any working keyboard mapper software to make such a task easy. Note the checkbox with the label: “Enable ZWSP insertion by Shift+Ctrl+spacebar”. The default setting is to have it turned off. If you turn it on, then after you return from the Preferences dialog, you can at any time hold down the Shift and Control keys while pressing the spacebar, and Adapt It will insert an instance of ZWSP at the current cursor location in the phrasebox, or in the active text control within whatever dialog that is open. If you notice that some diacritics are being cut off, you can also drag the slider button to the right to add extra pixels of height to the target text cell height.
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There is a further checkbox.

Some Paratext translation projects support ZWSP in Paratext views other than its Unformatted view; but when the user enters Unformatted view, a consistent changes table converts each ZWSP into a solidus (a / or "forward slash" character) to make the location of the start and end of each word more clearly seen. This is an editing aid that the Paratext developers have provided for some East Asian languages. If the user switches back to a different view, a different consistent change table converts each / character back to ZWSP.

Adapt It, now supports this kind of edit-ability help. But it is not turned on without an explicit choice being made by the user or administrator. The choice to turn this mode on requires a tick in the above checkbox. The choice is saved in the project configuration file, and so is restored each time the user re-enters the project in order to do more work.

When this mode is operating, the Adapt It layout will show groups of words with ZWSP word delimiters in place, so that the text looks natural to speakers of the languages being worked with. But in the phrasebox and any other locations where editing is permitted, it automatically will convert the ZWSP characters to / characters  in order to aid the editing process.  When text is exported, it is always exported in the natural form – that is, with the ZWSP characters restored.

There is one difference from the Paratext feature. In Paratext, no / character is shown where a punctuation character occurs – the reason being that the punctuation suffices to indicate where a word break is. Adapt It however needs to parse the text reliably when creating its documents, and so it needs to have ZWSP or / at punctuation breaks. Therefore, Adapt It has a couple of precomposed Consistent Changes tables stored in the folder:   _CCTABLE_INPUTS_OUTPUTS within the Adapt It Unicode Work folder. These CC tables can have additions made to them by you if necessary, but hopefully they contain all that is needed for any languages of the East Asian area. The filenames for these table files are:


FwdSlashInsertAtPuncts.cct   (this one inserts / characters at the correct places for different kinds of punctuation)

FwdSlashRemoveAtPuncts.cct  (this one removes the inserted / characters contiguous to different kinds of punctuation)

Do not remove these files, or move them to some other folder, otherwise this feature will not work correctly.

Version 6.6.0 also changes some of the limits within the View tab of Preferences.

a) The width of the inter-pile gap can now be set as low as zero. Setting a low value, such as 4, is helpful for some East Asian languages, to make the laid out interlinear text look more natural and easily readable.

b) The minimum pile width can now be as low as 5 pixels.

c) The phrase box whitespace slop multiplier can be made lower, now as low as 5. (Lower values give a less wide phrasebox.)

Understanding The Adapt It Interface

A typical document loaded into Adapt It might look something like this:
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Now that you have a document open and visible on the screen, we need to talk about the features of the interface, and define some terminology. In point form, here are the main features of the interface:

· The source text appears in a series of horizontal strips – for example, the picture shown above shows the first six strips for the Tok Pisin verses from 1 John. The strips you see will have, initially, just one line in them. Ultimately, they can have up to four lines – the default is to work with two lines. The top line is source text, and the default setting is to show the punctuation in the original document. When you make adaptations, the second line will contain target text, with punctuation showing. 

· An extra line is also possible – for doing glossing of the source text (glossing is an optional feature we’ll describe later).

· The strips are separated from each other by a gap, and you can adjust the size of the gap, and other parameters, using the Edit … Preferences … command, and then selecting the View tab, and then altering the appropriate number shown in that tab (i.e. Vertical gap between multi-line text strips). 

· Adapt It will replace punctuation in the translated text as you work, so you don't have to type it as you work if you don't want to. This works irrespective of whatever settings are in effect for the buttons shown above. If you do type punctuation, anytime your typed punctuation differs from the source text punctuation, Adapt It will give priority to the punctuation you typed, ignoring what was in the source text at that location. If Adapt It is restoring punctuation at a place where you don't want the punctuation restoration to happen, you can use the Edit Source Text… command on the Edit menu to get rid of it. (If you change your mind and want to restore the source text punctuation, use the command again, after selecting the word on which you want to restore the punctuation.)

· The horizontal gap between strips is where navigation text is displayed. You will see things there like chapter and verse numbers, and the names or functions of certain standard format markers displayed in the gap. Asterisks are also displayed there. An asterisk means that the text below it is not stored in the knowledge base.
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On the start of the second line of the first strip, you will see a box structure. This box is called the phrase box. It is the place where you type adaptations for the words or phrases of the source text. The phrase box expands or contracts as you type, or delete, within it. In the Tok Pisin document above the phrase box looks like this immediately after creating the document: 




The phrase box has a default size which takes into account the length of the text within it, plus some “slop” at the end of the text so that you have room to type some characters if needed. 
If you have trouble using Keyman for special characters, then you probably need to change the settings so that the box has more white space after the text. You can change the setting in the View tab of the Preferences dialog (on the Edit menu), just use a larger value for the number in the edit box called “Phrase Box white space slop and expansion multiplier”. The default value is 8; try a value of 15 or higher if you are having trouble with Keyman not interpreting keystrokes for special characters. (If a box expansion occurs between keystrokes, Keyman loses track of the fact. A bigger value gives you a much bigger box, and so box expansions will happen less frequently, so that Keyman will behave correctly more frequently.)
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As of version 6.9.1 the phrase box will appear with a drop down Choose Translation list directly underneath the phrase box. This drop down list will popup automatically whenever there are two or more translations available from Adapt It’s knowledge base. This drop down list looks like this:

When the drop down list appears you can select one of the translations in the list, or simply type a new translation in the drop down’s edit box and press Enter, or type the new translation directly in the phrase box. Note: In the Linux version, you need to close the dropdown list first by clicking the down button or press the Esc key (or click on any white space area of the main window) before you can enter text into the phrasebox’s edit box.

· The place where the phrase box is, at any point of time, is called the active location. The active location will move as you work. Whenever you hit the ENTER key, the phrase box will advance to the next empty location if you are in Drafting mode, or to the next location in normal reading order if you are in Reviewing mode, and the old contents of the phrase box will get saved in the knowledge base when the box moves.

· If the View menu command "Copy Source" item is on (ticked), then when the phrase box jumps to a new active location, that location's source text is copied to the phrase box and shown selected. The text is copied because it is likely that quite often the target text will be the same as the source text, or be very similar. This text is therefore a first guess, or "default" text, which you can either change, or substitute something new by starting to type whatever text you want. If the Copy Source command is off, the phrase box will be shown empty when it jumps to a new active location.

· Each strip is divided up into a series of piles. Each pile is formed from a 'pile' of cells. The number of cells in a pile may differ depending on the mode that Adapt It is currently using. Usually the top cell has source text, and the cell directly below it has target text, provided Adapt It is in its most basic adaptation mode. In the picture above, which illustrates two lines per strip, the first pile has the text "1JN" in the top cell, and the same text is in the phrase box which is visible at the location of the cell on line 2 of the strip (target text in this case).

· Each pile is a visual representation of a document storage element. Each document storage element, when a document is first created, stores just a single source text word. Adapt It can work with source text phrases, not just single words. Adapt It allows you to very easily select several storage elements, and merge them into a single storage element containing a source text phrase, rather than a single source text word. How to do this will be discussed later. 

· A vertical scroll bar permits you to navigate up and down in the document. If your source text has chapter markers, you can also step down or up in the document to the beginning of each chapter, or go to the start or end of the document using other toolbar buttons. Adapt It automatically adjusts things, moving you down through your document as you work. PgUp and PgDn buttons also work, moving you up or down by approximately one full screen. There is also a Go To… command for navigating to specified chapter and verse.

· If you want to have Adapt It start a new strip whenever certain standard format markers are encountered in the source text (such as \c for chapter, \p for paragraph, etc.), choose the Wrap At Standard Format Markers command on the View menu. This is the default. If you do not like this type of display, and would prefer every strip to be filled to capacity with storage elements, then click the same menu item again to turn it OFF (when OFF, it does not display a checkmark).

· There is a toolbar with a number of buttons, some of them you have seen in the above paragraphs. These buttons allow you to do very useful things, such as grouping words into a phrase, or making a retranslation, or inserting a storage element to add some extra text, and many other things. We will discuss them in detail later. There is also a bar with a number of checkboxes, some of which are used for changing modes of operation. We will discuss these later also.

· The menus are deliberately kept as simple as possible. Therefore, most of the buttons on the toolbar do not have equivalent menu commands. Place the cursor over the toolbar buttons, and you will see a short description of what each one does. Some of the toolbar buttons do have key combinations which make life simpler for you. These are discussed in the next section. Some of these buttons have accelerator keys too.

· On the View menu, there is a command called Compose Bar. If you select this command, an extra bar will appear immediately following the mode checkboxes bar. It will look like this:
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The Compose Bar is a handy place for you to type any text you might like to type, without having to worry about where the phrase box is. For example, you might be working on a complex adaptation for a whole sentence, and wish to work it all out before you enter it into the document. The buttons Clear Contents, and Select All, do exactly what their names suggest. Click the Compose Bar command a second time and it will disappear (its contents will be retained though). Removing a retranslation also results in the retranslated text being copied to the Compose Bar, in case you want to retain it temporarily. Most people never use the Compose Bar, so unless you feel it will be important for your work, you can just forget about it and it will stay hidden.

· Adapt It remembers the size and location of the main window at the end of your work session, and will restore the window to the same size and location when you next launch the application. And if you select the same document you were previously working on, the phrase box will be restored to wherever in the document it was located when you last closed down the application.

Now you are nearly ready to start adapting some of the source text, but first you need to know about some special keys, and how to make selections.

Special Keys Used For Controlling Adapt It

Adapt It uses some shortcut keys for commonly used commands. Here is a list, and a brief note about what they do (on each supported platform):

	Windows 
	Linux*
	Macintosh
	Keyboard Action in Adapt It

	ENTER
	ENTER
	ENTER
	When in Drafting mode: stores your adaptation and jumps the active location to the next empty pile; when in Reviewing mode: the same behaviour except that the jump only goes to the immediately following storage location (i.e. pile). If a dropdown list selection was made with an Up/Down arrow key to highlight an item different from the Phrasebox contents, the Enter key selects the list item and puts it into the Phrasebox without advancing the Phrasebox.

	CTRL+ENTER
	CTRL+ENTER
	CTRL+ENTER
	When in Use Transliterate Mode: stores 
<Not In KB> in the Knowledge Base, so that the selected SIL Converters transliterator will be used for that conversion rather than the Knowledge Base contents.

	Alt+Backspace
	Alt+Backspace
	Alt+Backspace
	Equivalent to Ctrl+Enter as explained in the row above

	SHIFT+ENTER
	SHIFT+ENTER
	SHIFT+ENTER
	Move the active location backwards to the immediately preceding pile

	SHIFT+TAB
	SHIFT+TAB
	SHIFT+TAB
	Move back, same as SHIFT+ENTER

	SHIFT+Up Arrow
	SHIFT+Up Arrow
	SHIFT+Up Arrow
	Scroll the main window, same as if the vertical scroll bar's up arrow button were clicked.

	SHIFT+Down Arrow
	SHIFT+Down Arrow
	SHIFT+Down Arrow
	Scroll the main window, same as if the vertical scroll bar's Down arrow button were clicked.

	ALT+Delete
	ALT+Delete
	Use CTRL+U
Alt+Delete is reserved on Macintosh
	Unmerges a source phrase, that is, separates the source phrase into a sequence of single words; this is a shortcut for the Unmerge toolbar button. There is an accelerator key for this operation too:  CTRL+U 

	SHIFT+PgUp button
	SHIFT+PgUp button
	SHIFT+PgUp button
	Scroll the main window up by approximately one screen full.

	SHIFT+PgDn button
	SHIFT+PgDn button
	SHIFT+PgDn button
	Scroll the main window down by approximately one screen full.

	ESCAPE (Esc) 
	ESCAPE (Esc) 
	ESCAPE (Esc) 
	This key does an Undo operation in the Phrasebox, restoring whatever was in the Phrasebox when it first arrived at the current location. If the guesser put a guess in the Phrasebox, the Esc key can also be used to restore the Phrasebox’s original contents. 

	TAB
	TAB
	TAB
	Tab does exactly the same thing as ENTER.

	ENTER on NumPad
	ENTER on NumPad
	ENTER on NumPad
	ENTER on NumPad does exactly the same thing as ENTER.

	ALT+ Right Arrow
	ALT+ Right Arrow
	ALT+ Right Arrow
	Select from the active location rightwards, highlighting the selected source text in yellow.

	ALT+ Left Arrow
	ALT+ Left Arrow
	ALT+ Left Arrow
	Select from the active location leftwards, highlighting the selected source text in yellow.

	ALT+Up Arrow
(Ctrl+R only works if a selection is current)

Use Ctrl+E  to edit an existing retranslation
	ALT+Up Arrow
(Ctrl+R only works if a selection is current)

Use Ctrl+E  to edit an existing retranslation
	ALT+Up Arrow
(Ctrl+R only works if a selection is current)

Use Ctrl+E  to edit an existing retranslation
	When a selection is current, causes the Retranslation dialog to open for the selected text, but if no selection is current, the Retranslation dialog opens just on the text in the storage element at the current phrase box location. When a selection is current (only then) this operation also has an accelerator key: CTRL+R. Use CTRL+E to edit an existing Retranslation.

	SHIFT+ALT+Left Arrow
	SHIFT+ALT+Left Arrow
	SHIFT+ALT+Left Arrow
	Causes a placeholder to be inserted BEFORE the first selected storage element, or if none is selected, then it is inserted before the active location. 

	SHIFT+ALT+Right Arrow
	SHIFT+ALT+Right Arrow
	SHIFT+ALT+Right Arrow
	Causes a placeholder to be inserted AFTER the first selected storage element, or if none is selected, then it is inserted after the active location. 

	CTRL+Down Arrow

	CTRL+Down Arrow
	Use Ctrl+I
Ctrl+Down Arrow is reserved on Macintosh
	Causes a placeholder to be inserted AFTER the last selected storage element, or if none is selected, then it is inserted after the active location. There is an accelerator key for this operation too: CTRL+I. 

	ALT+ENTER
	ALT+ENTER
	ALT+ENTER
	(only when a selection is current) merge selected storage elements into one, thereby making a source phrase at the active location, and select the contents of the phrase box. (What appears in the phrase box is determined by whether you have already typed something in it or not. If you have typed into it, or clicked in the box, or pressed the right or left arrow keys, then your typing is preserved. If you have not typed into it, and provided Copy Source is turned on, then source text is copied to the box – and if Use Consistent Changes is turned on, it is first run through the change tables before being shown in the box.) There is an accelerator key for this operation too: CTRL+M. 

	SHIFT+CTRL+SPACE
	SHIFT+CTRL+SPACE
	SHIFT+CTRL+SPACE
	Enter a ZWSP (zero width space) into the compose bar's edit box.

	Up Arrow
	Up Arrow
	Up Arrow
	Move the selection in the dropdown list up.

	Down Arrow
	Down Arrow
	Down Arrow
	Move the selection in the dropdown list down. Opens dropdown list if list is closed and has multiple items. 

	PgUp button
	PgUp button
	PgUp button
	Move the selection in the dropdown list up.

	PgDn button
	PgDn button
	PgDn button
	Move the selection in the dropdown list down.

	type any key when a selection is current and the active location  is within the selection
	type any key when a selection is current and the active location  is within the selection
	type any key when a selection is current and the active location  is within the selection
	Causes a merge of the selected storage elements, and the key typed becomes the adaptation you are typing. 

	Function key F8
	Function key F8
	Function key F8
	Force open the Choose Translation dialog at the current active location. There is an accelerator key for this operation too: CTRL+L

	Additional Accelerator Keys:
	Additional Accelerator Keys:
	Additional Accelerator Keys:
	(These have to be learned by heart, as they cannot be seen anywhere because they apply to toolbar buttons which have no menu command equivalents): 

	CTRL+I
	CTRL+I
	CTRL+I
	Insert a placeholder into the source text (i.e. a placeholder) after a location - such as after the phrase box location, or after the end of a selection

	CTRL+D
	CTRL+D
	CTRL+D
	Delete a placeholder

	CTRL+E
	CTRL+E
	CTRL+E
	Edit a retranslation


* In the Linux version you may need to close the dropdown list of translation choices before you can use some of the special keys described above.

Selection Rules

Adapt It shows a selection by making the background of a selected cell have a yellow colour. Here is a picture of a selection in text taken from the Nyindrou back-translation of Acts, one storage element is shown selected and it contains the source phrase "atukum ame".
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While only one cell in a pile is shown selected (the top one), Adapt It regards the selection as applying to the whole storage element associated with the pile of which that particular cell is a part. Selections can span many storage elements too.

These are the rules that Adapt It uses for making selections:
· Selections will be bounded (i.e., cannot be made across certain boundaries) unless the Ignore Boundaries button is showing – the button with the yellow road and no boundary fence across it. Boundaries occur whenever significant sentence punctuation exists, or when the text type changes. Selections made on the source text line while punctuation is not showing, are not bounded, provided the text type stays constant. 


· Boundaries are invisible, Adapt It knows where they are, but you cannot see them. However, they occur at punctuation (except for comma), and wherever there is a significant standard format marker, so it is possible to work out where they are.


· The reason why Adapt It requires an extra step to make selections across boundaries, is to help you to avoid making source phrases which are unlikely to be grammatically useful in the adaptation process. Adapt It will enforce respect for boundaries, whenever the Stop Selection At Boundaries button is showing – the button with the yellow road and a boundary fence across it.


· Making a selection (with mouse and keyboard). 
Click on the source text where you want the selection to start. Then hold down the SHIFT key, and click where you want the selection to end. Selections of this kind can span many strips provided the text type stays constant. For instance, you cannot start a selection in a verse containing 'verse' text type and finish it in subheading text, because those are two different text types.


· You can also use the following button to make Adapt It ignore boundaries temporarily: 
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  when you click this button, its image will change to this:  [image: image20.png]


  and then you can select past the boundary.  The button will revert to respecting boundaries again after your next action in Adapt It.


· Making a selection (with the keyboard). This is the recommended way to make selections because it saves you from having to grab the mouse; for people who want to work quickly, this is best. Selecting this way only makes bounded selections, unless you also use the above buttons to temporarily ignore them.

Hold down the ALT key and press the Right Arrow button. The selection will be made in the source text line, starting at the active location, and will extend to the right, to the next pile. Click again (while holding the ALT key down) and the selection will extend further to the right, each time you click. It will stop if a boundary is encountered, unless you have the ignore boundaries setting in effect. You can click the left arrow instead, if you go too far and wish to shorten the selection. You can also use the ALT key and Left Arrow button to select to the left of the active location, it works just the same as using the Right Arrow, but in the opposite direction.


· Making a selection (mouse dragging with button down). 
Click on a source text word and while keeping the mouse button down, drag left or right (or down or up) to the last source word you want to be in the selection. All the words between those two points will be selected.  If your selection stops at a punctuation boundary, hold down the CTRL key with your other hand while you continue dragging, and the selection will then cross over any punctuation boundaries. Many people like this way best, particularly people just starting to learn.


· Other selection techniques. 
If you use the Tools … Find… command, or the Tools … Find and Replace … command, whenever your search text is matched, the storage elements which contain the matched text will be selected.

Moving About In The Document

Adapt It does not force you to keep moving ahead in the document as you work. You can move back and forth to wherever you like. You could, for instance, adapt some of the source text at the beginning of the document, then scroll or jump to the end of the document and adapt source text near the end, leaving the middle of the document for later on.

The way to move about is simple. Just use the mouse to click immediately below the source text in whatever storage element you want to become the new active location. When the application makes the phrase box jump to the clicked location, the text that was in the box will be saved to the knowledge base before the jump is done. If there is no adaptation at the new location, Adapt It will look up the knowledge base and try to find a matching source text phrase, or word. It if finds a word or phrase, it will insert the appropriate translation in the phrase box, and if a merge of two or more source words is required, it will automatically do that for you as well. You can use this behaviour to insert translations at random locations if you wish – just click at each location you want a translation inserted, rather than using the ENTER key to move forward sequentially.

If nothing matches in the Knowledge Base, then the source text will be copied as the "default" adaptation, and shown selected. If the Use Consistent Changes menu item is turned on (Tools menu), then the copied text will first be run through the changes table(s) before you see it in the phrase box. If there is already an adaptation at the place where you clicked, it will be shown selected in the phrase box.

Another way to move back, a pile at a time, is to use the SHIFT+ENTER key combination, or SHIFT+TAB key combination. Moving ahead is simply a matter of pressing the ENTER key or TAB key – which moves the active location to the next "empty" storage element - provided the Drafting radio button is ON (see the toolbar). This could be a long way ahead. If you want to jump ahead by only a single location, then you can click the Reviewing radio button, and then any ENTER key press will just jump you ahead by a single storage location. This will not work if the active location is immediately preceding a retranslation. If you press TAB there, or ENTER when in Reviewing mode, you will get a message saying the operation cannot be done. (Note: With version 5.2.0 there is command-line switch that can be used to “force reviewing mode” when Adapt It is launched. See the -frm command-line description in "Using Adapt It with command-line options" section near the end of this documentation).

Adapt It is not just a “text-adapting” environment. 
It is also a “text editing” environment.
A useful way to use Adapt It if there are not too many differences between the source and target texts, is to just quickly adapt the whole document without worrying about source text phrases or errors. Then jump back to the start and start reading through the target text. Any time you see an error, or a place where a source phrase is needed, or a retranslation, then click or select there as the case may be, and do whatever correction is needed. This is a good way to work because the adaptation part of it can run at full speed – it is not slowed down by you halting it all the time in order to read what was inserted automatically for you. 

Each time you make a correction, the new adaptation information goes into the knowledge base, and Adapt It becomes progressively smarter. Then, when you adapt the next document, it will do an even better job on the first run through; and you will have fewer corrections to make as you read through your first rough adaptation of the new document. Then do the next document similarly, and Adapt It will do even better again, and so on through all your document files.

You can tell Adapt It to store nothing as the adaptation of a source word or phrase, merely by clicking the 
<no adaptation>  button on the mode buttons bar, which looks like the following:
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If you use the button, then whenever you look at the empty entry in the Choose Translation dialog, or in the Knowledge Base Editor, you will see this entry:  <no adaptation>. This is just to tell you that the knowledge base is actually storing no translation text at all with the particular source text which is being examined. If you select the <no adaptation> entry in a dialog, you are in fact selecting an "empty" text, that is, text which is nothing – which in some contexts is a perfectly acceptable and correct adaptation; and what would be stored in the knowledge base is not literally "<no adaptation>" but an empty translation. This is useful when you want to give a source word or phrase no translation in the target language in some locations, and still have the possibility of it having a translation in other locations.

Note: if you have used the <no adaptation> button to give a source text word or phrase an empty adaptation, you can  remove the setting and make the word or phrase act like a "hole" again (see next paragraph), just place the phrase box there, and then press either the Backspace key or the Delete key. Doing this also automatically updates the knowledge base to reflect your change as well.

If you cause an empty phrase box to move on (either by pressing the ENTER key, or clicking elsewhere in the document) then Adapt It will just leave the source text at that location unadapted; and nothing would be stored in the knowledge base when the move takes place. This leaves a safe ‘hole’ in the document at which the phrase box will stop when searching ahead for the first empty location it can find. In some circumstances you can make good use of this behaviour: for example, if you don’t know how to translate a word, just leave it untranslated and go on to the later words – later on you can place the phrase box at a location near the start of the document and then press the ENTER button, and Adapt It will find these empty ‘holes’ which you have left untranslated earlier.

Adapt It Modes

Adapt It has several possible modes of operation. Each mode gives Adapt It a slightly different behaviour. Modes are set by using either certain menu commands, or the radio buttons and checkboxes which are visible immediately above the main view window, in the mode bar. A couple of these buttons are not, strictly speaking, modes of operation but they are included in the bar for your convenience.

When you first open the application, the radio buttons and checkboxes in the bar will look like this:
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Here is a description of the mode buttons.  There are three of them: two radio buttons and one checkbox; and if glossing is made visible, an extra “Glossing” checkbox will be visible near the right end – as in the picture below. The current setting of the "Delay" (in hundredths of a second) will also be shown in a read-only edit box – by default the delay is set to zero when the application is launched, but a Delay… command on the Advanced menu allows you to change the value to anything between 0 and 300 (that is, up to 3 seconds of delay.) The Use Auto Correct check box may or may not appear in the mode bar. It is described below.
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· 
Automatic

In Automatic mode, Adapt It will wait at the new active location only if it cannot work out what the correct adaptation text should be; otherwise, it will insert the appropriate adaptation text, and then move on automatically to the next possible location – continuing in that way until either you click anywhere in the window to halt processing, or until Adapt It comes to a location for which it does not have any known adaptation, or it comes to the end of the file.

If you click to turn this mode off by un-checking the checkbox, the application is in Single Step mode. That means that the phrase box, when it moves, moves to the next empty location, inserts the correct adaptation for you if it knows what it is and stops there waiting for you to do something. 

Automatic mode versus Single Step mode is available only while the Drafting radio button is ON. Drafting (translation) is the default mode. When you wish to look back at your work, you should click the Reviewing radio button. It prevents the active location from jumping too far when you press ENTER. (Note: With version 5.2.0 there is command-line switch that can be used to “force reviewing mode” when Adapt It is launched. See the -frm command-line description in "Using Adapt It with command-line options" section near the end of this documentation).


The above are the mode checkboxes, radio buttons and menu commands. There are three other checkboxes which are not modes. Here is a description of them.

· Save To Knowledge Base

You may have noticed that this checkbox is ON by default. Provided it is on, then when the phrase box moves to a new location its contents are "Saved To (the) Knowledge Base". This is what you would expect. This process ensures that as you work, Adapt It becomes smarter and smarter, because it is learning and storing the adaptations you make. Then it can reuse those adaptations on your behalf when it does the look up process as you work, so that it can put them in for you automatically where appropriate.

However, there may be circumstances where you feel that a certain source word (or phrase) should not be stored in the knowledge base, even though you might have given it an adaptation at the current location in the document. You can click OFF the Save To Knowledge Base checkbox, then Adapt It will not store anything in the knowledge base for the active location at which the phrase box currently is located. Whatever is in the phrase box is just left there in the document, whether it is some text, or nothing. If Adapt It encounters the same source text later in the document, it will by default put no translation text at that location on move on; but if you want some text to be there you can go back manually and type it there explicitly. Whichever is the case, Adapt It will treat whatever translation you give at that location automatically as text not to be stored in the knowledge base. This can be useful if you want the translation always to be nothing, or if you want a different translation in each of very many different contexts.
 
If you turn the Save To Knowledge Base checkbox off, for that particular source word or source phrase, then Adapt It "learns" that you want that particular word skipped when the phrase box is about to move there. Adapt It also shows an asterisk (*) above that storage element, so that you have some visual feedback that that particular source word or phrase has no adaptation stored in the knowledge base. 
 
When you turn the checkbox off, the effect is only temporary - it stays off only for that word. As soon as the phrase box moves, the checkbox is automatically reset to be on.

If you change your mind later and want to allow that source word or phrase to have an adaptation, just put the phrase box there, then type the adaptation you want and click the checkbox back on. When you move the phrase box elsewhere your adaptation will be stored in the normal way, and the asterisk above that pile will be removed.


· Force Choice For This Item

When Adapt It is looking ahead to see if there is a suitable adaptation in the knowledge base it may find that there is more than one valid adaptation for that source phrase (or word).  In that circumstance you need to tell Adapt It which particular adaptation is the correct one for that particular context. So Adapt It will put up a dialog box, and in the box you will see a list of all the permissible adaptations of that particular source text that Adapt It knows about so far. The dialog is called the "Choose Translation" dialog. Normally you will see this dialog only when there are two or more possible translations. 

However, there are circumstances when you might want Adapt It to put up the dialog, even though so far Adapt It has previously "seen" only a single adaptation for a certain word or phrase of the source text. Use the checkbox when you are certain that the translation you are typing is the first of one of several possible translations. This prevents the application from always putting in the one translation you have already typed; instead, the dialog is opened, and you have the chance to type a new translation, or accept the existing one.

If you turn the Force Choice For This Item checkbox on, before you press the ENTER key to cause storage to the knowledge base to take place, then Adapt It will put a little electronic "mark" on the entry in the knowledge base. This "mark" tells Adapt It that when that particular source word (or phrase) is next encountered, the currently known adaptation should not be automatically inserted. Rather, the Choose Translation dialog has to be put up instead, so that if the active location happens to be at the context where the other possible adaptation is appropriate, then you can type the other adaptation in the dialog box immediately, and Adapt It will insert it in the text. Thereafter, because there would now be two adaptations for the same source text, Adapt It will automatically put up the dialog for you to choose the adaptation which is correct for the current active location.

This checkbox does the same job for either adaptation mode, or glossing mode.

If you find this discussion of the Force Choice For This Item checkbox difficult to follow, do not worry. There is another way to fix up your documents quickly if you find that Adapt It has inserted adaptations which are not the ones you wanted. It is not appropriate to discuss this yet, but just be assured that there is a way to fix things, and it is easy to do.

Some people never use the Force Choice For This Item checkbox and manage quite well without it, others find it very useful and use it a lot - particularly when they are just starting into an adaptation project, because that is when it is likely to be most useful.

· Use Auto Correct
This option is not visible unless Adapt It finds a properly configured autocorrect.txt file within the Adapt It project, and an adaptation document is open that is from that Adapt It project. The Auto Correct feature works only for the text editing boxes (including the phrasebox) that accept target (adaptation/translation) language text. It is similar to the same feature that is available in Paratext 8 and 9 (when an autocorrect.txt file is located in the Paratext project’s folder). When the Use Auto Correct check box appears at the end of the mode bar, it always starts with Auto Correct enabled (has a tick in its check box). A user can temporarily suppress the Auto Correct function by un-ticking the check box, and later re-enable Auto Correct by re-ticking the check box. The purpose and structure of an autocorrect.txt file is described in the Paratext documentation available at: https://paratext.org/2018/10/03/using-autocorrect/.

An Administrator or user can configure Adapt It to use the Auto Correct feature by doing either (1) or (2) below:

(1) Create a “plain text” file named autocorrect.txt that contains the Auto Correct rules as described in the link above, and place that autocorrect.txt file within the Adapt It project folder in which the Auto Correct feature should operate. The Auto Correct feature will function automatically when editing target text in documents that are open within the Adapt It project. The Adapt It project can be, but need not be configured by an Administrator to collaborate with Paratext for the Auto Correct feature to function within Adapt It. 

(2) An Administrator can configure Adapt It to use an existing Paratext project’s autocorrect.txt file during the process of configuring Adapt It to collaborate with Paratext using the (normally hidden) Administrator menu’s “Setup Or Remove Collaboration...” menu item. The Administrator follows the ordered steps in the “Setup or Remove Collaboration” dialog. In Step 3 the Administrator picks an existing Paratext project for its “Source” and a different Paratext project as “Target” for transferring/storing the adaptations/translations that are created within Adapt It. When the Administrator clicks on the “Select Target Project from List” button in step 3, Adapt It presents a list of all available Paratext projects that might be available for Adapt It to transfer its adaptations/translations to. Once the appropriate Paratext project is chosen, Adapt It will scan that project for its suitability, and will then detect whether that Paratext project contains an autocorrect.txt file within its project folder. If so, Adapt It will offer to automatically copy that autocorrect.txt file over to the Adapt It project being configured for collaboration. This copying of an autocorrect.txt file from a Paratext project is only done at the time the Administrator configures the Adapt It project for collaboration with Paratext. Therefore, if an Administrator configured Adapt It for collaboration with Paratext before Adapt It version 6.10.5, any autocorrect.txt file that existed in the Paratext project, won’t be automatically copied over to the associated Adapt It project. If that is the case, the Administrator can manually copy the desired autocorrect.txt file from the target language Paratext project (that is collaborating with Adapt It) over to the appropriate Adapt It project’s folder.

· <no adaptation> button
This button appears as <no gloss> when Glossing mode is activated using the Glossing checkbox (see below). It erases anything in the phrase box, and immediately stores an empty translation for that particular source word or phrase in the knowledge base. The phrase box does not move. If you are in glossing mode, then the empty translation is entered into the glossing knowledge base instead of the adaptation knowledge base.


· Delay
The Delay edit box is a 'read-only' display of the currently set delay, per insertion, to be applied when Adapt It is inserting adaptations from the knowledge base in Automatic mode. The delay is initially zero when the application is launched, so that insertions will by default run at maximum speed – which for most computers will be much faster than your eye can follow; you must manually set it to some other value if you want to slow insertions down to a speed suitable for reading the text that gets automatically inserted. (Or you can turn Automatic mode off, and use the ENTER key to manually progress through the document.)

The delay setting is calculated in hundredths of a second; you can set a maximum value of 300 which is equivalent to a delay of 3 seconds. To change the current delay value there is a Delay… command on the Advanced menu. If you wanted a 1.5 second delay, the dialog would look like this:
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· glossing checkbox
This checkbox is only visible after you have chosen the See Glosses command on the Advanced menu. When you click the checkbox on it will show a tick, the <no adaptation> button will change to <no gloss> and the application will enter glossing mode. The active knowledge base automatically becomes the glossing one, and the line on which the phrase box appears will contain glosses; while any adaptations which have already been done will appear on the line immediately below the glossing line. The adaptations will be visible, but not selectable and cannot be changed while the application is doing glossing; and certain operations will not be possible – such as merging, retranslating, and inserting placeholders.

If you click the checkbox again to turn it off, glossing mode will cease and the application will switch to adaptation mode; and the adaptation knowledge base automatically becomes the active one again. The line containing the phrase box will show adaptations, and any glosses which have been done will be visible on the line immediately below the adaptations line. Glosses will then not be selectable and cannot be changed while the application is doing adaptations.

You can switch back and forth from glossing mode to adaptation mode as often as you like. Also, you can gloss merged phrases, the merging having been done beforehand when in adaptation mode; the glosses for such merged phrases are treated no differently than the glosses for single source words – that is, they are entered into the same single list in the glossing knowledge base as stores the word glosses. This means that glossing can be done before adaptations are done (best – because each single source word will then have a gloss which can be a word or phrase), or afterwards (not so good – because probably mergers will have been done and so the glossing knowledge base will contain both source words and source phrases), or at any time between the beginning and the end.

Toolbar Buttons

Adapt It has a toolbar containing a number of buttons which do very useful things. First we will describe the individual toolbar buttons. The next main section will tell how you can adjust the toolbar button sizes and hide/display individual toolbar buttons. 

The first 7 buttons are standard ones, which do not need any discussion here. They are alternative means to access the following menu commands:
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	New
	Open
	Save
	Cut
	Copy
	Paste
	Print


The last button, at the far right of the toolbar is the standard button for getting Help information which looks like this:[image: image30.png]


.

The rest of the buttons in the toolbar are unique to Adapt It, they are discussed below. First a picture of the button is shown, then the explanation that you will see if you place the cursor over that button in the toolbar, and then in parentheses is the button name used in this documentation. Then follows an explanation of what the button does.
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  Change Guesser Settings
Adapt It provides a Guesser function which attempts to guess the adaptation's suffixes and or prefixes for source words or phrases which currently have no translations stored in its knowledge base. It cannot guess what the target text word root forms might be. Press the Esc key to reject an unwanted displayed guess.
The Guesser is statistical so it suggests guesses only after a knowledge base has sufficient data in it to make relatively accurate guesses. Version 6.5.5 of Adapt It allows the user to improve the accuracy of guesses by permitting the user to enter sets of affixes – either prefixes, or suffixes, or both (in separate lists). 

The Guesser is OFF by default but can be turned ON or its settings adjusted easily by clicking on the above toolbar icon. When a guess has been placed in the phrase box the background colour of the phrase box turns to an orange colour. The colour can be changed in the Guesser Settings Dialog – see the Guesser discussion.

The Guessing level can be changed using the slider bar. The default level is 50 out of 100, which represents reasonably conservative guesses. You can experiment with the guesser to see what setting works best. Move the slider to a lower setting for fewer guesses, or higher for more guesses. Remember that the guesser is more likely to guess correctly when your knowledge base has many entries; and using a slider value greater than 50 will markedly increase the possibility of inaccurate guesses being presented in the phrasebox.

The Guesser Settings Dialog, and the new child dialog for entering suffixes and/or prefixes, will be discussed in detail, with screen shots, later in the Guesser discussion section of this document.
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  Create a Note
This button can be used to open a note dialog where you can create a note at the location of the phrase box, or if a source phrase is highlighted (in yellow), the note will be created at the location of the selected source phrase. For more information on Adapt It Notes, see the section on “Notes Support” later in this documentation.
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  Go to the Previous Note
This button can be used to jump to the previous note if one exists earlier in the document. For more information on Adapt It Notes, see the section on “Notes Support” later in this documentation.
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  Go to the Next Note
This button can be used to jump to the next note if one exists later in the document. For more information on Adapt It Notes, see the section on “Notes Support” later in this documentation.
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  Delete All Notes 

This button can be used to delete all notes in the current document. Be careful! This action cannot be reversed. For more information on Adapt It Notes, see the section on “Notes Support” later in this documentation.

Some buttons are "toggles". For those unsure what "toggle" means, it means to change to an opposite situation or an opposite state. Toggle buttons typically turn something on, and when clicked a second time, turn it back off, or vice versa. Some of the toggle buttons also change the appearance of the button when clicked.

The next two buttons work together as a toggle. Only one is visible at a time, so consider them as one button having two different appearances.

[image: image36.png]W



 Untoggled (default): The button image shows what Adapt It is currently doing: Stopping Selection at Boundaries. The Tooltip shows what will happen if the toggle button is clicked: Ignore Boundaries.

In its normal state the appearance of this button shows a border crossing gate down across the  road - indicating that selection boundaries are currently in effect. The tooltip and help text indicate what you accomplish by clicking on this toggle button, i.e., to “Ignore Boundaries”. you click it, and it changes to show that the application is now ignoring selection boundaries – the gate in the up position allowing to cross. Click it when you wish to make a selection (e.g. using ALT+Arrow key), and you want the selection to be able to span punctuation or standard format marker boundaries. Clicking this button is useful when you wish to make a long selection – such as before clicking the Retranslation button. The button described below works together with this button to operate as a single toggle button with two different appearances.
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 Toggled: The button image shows what Adapt It is currently doing: Ignoring Boundaries. The Tooltip shows what will happen if the toggle button is clicked: Stop Selection at Boundaries.

This is the temporary appearance of the button described above. When the button has this appearance, it means that boundaries are being ignored - the road is not being blocked by the boundary gate, selections can go past the normal boundaries. Click it, and it changes to the Stop Selection At Boundaries button described above. This state and appearance of the button is only temporary. Adapt It will restore the button to the Stop Selection At Boundaries state automatically whenever a selection is removed or the phrase box moves; because the Ignore Boundaries state should not be allowed to remain in effect indefinitely. The button described above works together with this button to operate as a single toggle button with two different appearances.

The next two buttons work together as a toggle. Only one is visible at a time, so consider them as one button having two different appearances.
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 Untoggled (default is showing punctuation): The button image shows what Adapt It is currently doing: Showing Punctuation. The Tooltip shows what will happen if the toggle button is clicked: Hide Punctuation. In its normal state the appearance of this button shows punctuation marks bold and blue - indicating that punctuation is currently being shown. The tooltip and help text indicate what you accomplish by clicking on this toggle button, i.e., you click it and it changes to greyed out to show that the application is now hiding punctuation. Click it when you wish to hide punctuation from view - and it changes to the Hide Punctuation button. After clicking this button, you will only see source and target text without punctuation. Punctuation is still restored for you automatically if you do not type any in the phrase box. The button described below works together with this button to operate as a single toggle button with two different appearances.
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 Toggled: The button image shows what Adapt It is currently doing: Hiding Punctuation. The Tooltip shows what will happen if the toggle button is clicked: Show Punctuation.

This is the alternate appearance of the button described above. When the button has this greyed out appearance, it means that punctuation is not being shown on either the source or target texts. Click it, and it changes to the Show Punctuation button described above. When clicked, you will again see source and target text which includes punctuation. Punctuation is still restored for you automatically if you do not type any in the phrase box. The button described above works together with this button to operate as a single toggle button with two different appearances.
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  Advance To End
Click to make the phrase box jump to the last possible active location in the document.
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  Back To Start
Click to make the view in the main window go right back to the start of the document, and put the phrase box at the first possible active location.
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  Move Down One Chapter
Click to make the application jump to the beginning of the next chapter in the document. The phrase box will be given a new location at the same time, but you can change the location by simply clicking on the line under the source text at the storage element where you want to continue working.
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  Move Up One Chapter
Click to make the application jump to the beginning of the previous chapter in the document.
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  Jump Back
Click to put the phrase box at the previous active location. If the previous location was at the end of the file (no phrase box is visible when at the end of the file), or if there was no previous location because the document has just been opened, then the button will be disabled.
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  Make A Phrase
When there is a current selection somewhere (it does not matter what line of a strip or strips shows the selection), if you hit this button then the selected storage elements are merged into one, and the source text words are collected together to make a phrase with a single space between each word. The phrase box will be placed there also, and then you can then type an adaptation of this new source text phrase. This method works whether or not the active location is within the selected storage elements.

 If you are merging words having no translation yet, and consistent changes are active, then the merged words will be run through the consistent changes processor before being displayed in the phrase box.

This button is not the only way that you can merge storage elements so as to make a source text phrase; however, all the ways have this in common: you must first select the source text in the storage elements which are to be merged. 

When word glossing mode is in effect it is not possible to merge selected source phrase words into a phrase. Merging can only be done when in adapting mode. Any mergers done before entering glossing mode will be handled just fine by glossing mode, they would be treated the same as if they were a single source text word.

Another way to make the merge take place is to make a selection by holding down the ALT key and then pressing the right arrow button repeatedly until you get a selection of the desired length, or the left arrow button if you wish to select to the left of the active location. If you encounter a punctuation boundary which stops the selection from being extended, you can click the Respect Boundaries button to toggle it to the Ignore Boundaries state, and then continue extending the selection. (However, the boundaries are there to protect you from making poor choices about what constitutes a grammatically sensible source text phrase, so only turn off boundary protection if you are quite sure you need to do so.) When you have the selection you want, you can do either of the following:

a) keep holding the ALT key down, while pressing the ENTER key – the merge will happen and the phrase will be selected for you,

b) or start typing the adaptation, and as soon as you type the first character the merge will happen and the phrase box will continue accepting the adaptation text which your are typing. (This way works only provided the active location is within the selected storage elements.)

A further way to make the selection is to click on a source word and while holding the left mouse button down, drag the mouse to the last source word you want to be in the selection (also hold down the CTRL key if the selection does not extend as far as the mouse location).

It is possible that at some time you may make a selection which includes punctuation within it, rather than just at the ends of the phrase. If you then merge this selection to make it into a source phrase, the punctuation which was not at the ends will be internal to the newly created phrase. When you make your adaptation of this source phrase and press the ENTER key to save it and go to the next active location, Adapt It will try to replace the punctuation for you in the normal way - and it will not have any trouble doing that with punctuation at the start of the phrase, nor at its end. However, it will not know where it should place the source-phrase-internal punctuation, since it may not be in the same location in the adaptation text. When this happens Adapt It knows it needs your help, so it will put up the following dialog which will enable you to interactively place the punctuation at the appropriate location. 
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As you can see, the four words "Yupela yangpela man, yupela" were selected and made in to a phrase; so that the comma ends up internal to the phrase and not at either end. The translation of this phrase is in the box at the bottom. It has five words, and if the comma were placed after the first two words, copying the location from the source phrase, then it would end up in the wrong place. A comma could be put after the word "you", but it really isn’t necessary to put a comma in the translation in this case. The items of punctuation which Adapt It was unable to place are in the list box at the left – in this case there is only one, the comma.

To place the highlighted punctuation, click in the text at exactly the location the comma should be inserted, then click the Place button. Adapt It will remove the comma from the list, select the next listed punctuation (if any), and place the comma in the text at the location you clicked. If there is more than one punctuation unplaced, use this procedure to place each one.

You don't have to place them all, you can ignore any or all of them – placing only those you wish and leaving the others. Whatever text is in the box when you click the OK button (or press the ENTER key), will be used to form the adaptation for the source text at the current active location, and will be stored in the knowledge base (with punctuation stripped out, of course).

The above dialog would not have come up at all if I had explicitly typed the comma in the phrase box when typing the adaptation. That is, if I had typed "As for you, young men" in the phrase box, Adapt It would have been able to work out that it does not need to ask me to intervene. Adapt It will do all it can to match whatever punctuation you may type with any punctuation it finds to be internal to the source phrase. If it can match all items of internal punctuation, it won't put up the dialog, but will just use the punctuated text you typed.

Merging is not permitted when glossing mode is current.
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  Unmake A Phrase
This button permits you to undo a previously merged number of storage elements. The old phrase's adaptation, if one existed, is preserved – and shown on the first of the restored storage elements, provided Adapt It cannot find a suitable adaptation for the source word shown on the first storage element; but if it can find one, it will use that instead.

Before you use the Unmerge button you must first either select a single storage element which you want to separate into individual words, or place the phrase box there. If the selection is not at the location of the phrase box, then the unmerging is done at the selection location, and the phrase box will then be placed at the first of the unmerged words. If there is no selection, the location of the phrase box is where the unmerging operation takes place.

There is a keyboard shortcut available, which is Alt+Delete, that is, hold down the Alt key and press the delete key.

Unmerging is not permitted when glossing mode is current.
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  Do A Retranslation
Sometimes you may feel that the original source text is not as well-translated (from original sources) as you would like, so that rather than adapting that section of source text, you would prefer to retranslate it so it has a different meaning. This button permits you to make a retranslation of a section of source text. First select all the storage elements which are to be included in the retranslation, then click the Retranslation button. If the selection needs to span punctuation breaks (where invisible boundaries are located), then click to get the Ignore Boundaries button showing, then you can make your selection across boundaries; or select by dragging - just click and drag across the source text words while holding down the CTRL key.

When you click the Retranslation button, Adapt It will collect the text you have selected, and present it to you in the Retranslation dialog. The dialog will also show you the preceding and following context, either source text or target text (selectable by a button in the dialog), and any existing translation for the selected words. Then you can compose your new translation in the edit box provided. The dialog will look something like the following:

[image: image49.png][
Yupela likik pikinini bilong m, long nem bilong Krais God

S e et o el e i
i lusim pinis ol sin bilong yupela.

i e ardtan st hr e e e et helocoon s el

(T o v i i oo )

S e ot for bl et (g e, 3

Olsem na mi raitim dispela tok long yupela. Yupela ol papa,
yupela i save gut long dispela man ... i stap bipo tru na i stap yet.
Olsem na mi raitim dispela tok long yupela. Yupela yangpela man,





In this dialog, the Copy To Clipboard button will copy the text box contents to the clipboard, so you could later paste it somewhere, into the phrase box, or into the compose bar's text box maybe. The Show Target Context button causes the top and bottom text boxes to show the target text which is in the preceding and following context; if you click it, it will then change to Show Source Context, which allows you to switch back to having source text context displayed. The Cancel button restores the state which existed before you opened the dialog, except that the selection will have been removed.

When you click the OK button, the new translation will be displayed on the storage elements you earlier selected – one word of target text per storage element. Of course, because this is a retranslation, there will be no meaningful relation between the source text in any one storage element and the single word of target text that is shown immediately below it. For this reason, Adapt It treats a retranslation as a "whole". You cannot, for example, place the phrase box within it. If you want to edit a retranslation, or remove it, you must use the two buttons described next.

Your new translation does not have to be the same length as the original section of source text that you selected. If your retranslation is shorter, then some of the storage elements at the end of the original selection will have no target text added to them. On the other hand, if your retranslation is longer than the original, then Adapt It will insert special extra storage elements called Placeholders at the end of the source text. These act as "placeholders" and the extra words will be added to these - the source text for these is just … (three dots).

There is a keyboard shortcut for this command. Hold down the ALT key and press the Up Arrow key. If there is a selection, the retranslation dialog will open and show you the text in the selected storage elements. If there is no selection, the retranslation dialog will still open, but only the storage element at the active location (that is, where the phrase box currently is) will be included in the retranslation.  The ALT + Up Arrow key combination is very useful to use after using the ALT + Right Arrow key to make the selection.

The following picture shows a retranslation (where the source text is a light brown colour), in the middle of verse 9:26. Each individual retranslation is kept distinct from any others which may adjoin it. The start of each one is indicated visibly by a # symbol following the * symbol (the * symbol means that that data is not entered in the knowledge base).
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Retranslating is not permitted when glossing mode is current. Also, when doing glossing, the application permits the phrase box to be placed within a retranslated section and the source words glossed normally, since retranslations pertain only to adaptation mode and so are ignored for the purpose of glossing the source text.
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  Edit A Retranslation
Click to select any one of the storage elements in a retranslation, and then click the Edit Retranslation button. Adapt It will display the retranslation dialog for you, and then you can edit your retranslation.

Editing a retranslation is not permitted when glossing mode is current.
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  Remove A Retranslation
Click to select any one of the storage elements in a retranslation, then click the Remove Retranslation button and your retranslation will be removed, and the storage elements will all be unmerged and left empty, ready for you to adapt that section of source text in the normal way.

When a retranslation is removed, the former retranslated target text is not just thrown away. It is placed in the Compose Bar's edit box, and will remain there until you change the box contents, or remove another translation. You will not see the text in the Compose Bar unless you make the bar become visible; by default, the bar is not shown when the application is first launched. To make the bar visible, in the View menu click the Compose Bar item. You can then cut and paste parts of the old retranslated text if you wish.

Removing a retranslation is not permitted when glossing mode is current.
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  Insert A Placeholder to Left of Selection/PhraseBox 
Sometimes you may need to insert some extra target text in the translation, but there is no suitable source text to "hang" it from. This button allows you to insert an empty storage element or placeholder immediately preceding either a selection, or preceding the location of the phrase box if there is no current selection. A placeholder has an ellipsis (i.e. three dots, like this: … ) in the source text lines so that you can see it easily. Placeholders are not included in the knowledge base. The phrase box will jump to the just inserted placeholder, so you can begin to enter text into it immediately. 

Inserting a placeholder is not permitted when glossing mode is current, or within a retranslation. Otherwise, there are no restrictions on the use of placeholders. You can use as many of them as you like, and put them any place you like, except within a retranslation (the ones which you will sometimes see at the end of a retranslation are put there automatically by Adapt It, that is not something you can control, and you cannot manually place extra ones there). Each placeholder can store a target text phrase of arbitrary length. (But the ones in a retranslation each only store a single word. Again, this is not something you can control yourself.) 

In addition to the above toolbar button, there is a keyboard shortcut for inserting a placeholder to the LEFT of a selection/phrasebox. You can hold down both the SHIFT and ALT keys and press the LeftArrow key. You can press the SHIFT+ALT+LeftArrow combination and have a selection somewhere, the placeholder will be inserted immediately before the first selected storage element, regardless of where the phrase box is. If no source word/phrase is selected, and you press SHIFT+ALT+LeftArrow, the placeholder will be put immediately before the phrase box location. 

Insertion of placeholders is intelligent. If you insert one preceding a storage element containing initial punctuation, or standard format markers, or both, then the punctuation and markers, together with the navigation text shown above the strip, are moved on to the placeholder. If you remove a placeholder which has had punctuation or markers transferred to it in the above way, then they will be automatically transferred back to where they were before.
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 Insert A Placeholder to Right of Selection/PhraseBox
This button allows you to insert an empty storage element or placeholder immediately after either a selection, or after the location of the phrase box if there is no current selection. A placeholder has an ellipsis (i.e. three dots, like this: … ) in the source text lines so that you can see it easily. Placeholders are not included in the knowledge base. The phrase box will jump to the just inserted placeholder, so you can begin to enter text into it immediately. 
Inserting a placeholder is not permitted when glossing mode is current, or within a retranslation. Otherwise, there are no restrictions on the use of placeholders. You can use as many of them as you like, and put them any place you like, except within a retranslation (the ones which you will sometimes see at the end of a retranslation are put there automatically by Adapt It, that is not something you can control, and you cannot manually place extra ones there). Each placeholder can store a target text phrase of arbitrary length. (But the ones in a retranslation each only store a single word. Again, this is not something you can control yourself.) 

In addition to the above toolbar button, there is a keyboard shortcut for inserting a placeholder to the RIGHT of a selection/phrasebox. You can hold down both the SHIFT and ALT keys and press the RightArrow key. In addition to the above toolbar button, there is a keyboard shortcut for inserting a placeholder to the LEFT of a selection/phrasebox. You can press the SHIFT+ALT+RightArrow combination and have a selection somewhere, the placeholder will be inserted immediately after the first selected storage element, regardless of where the phrase box is. If no source word/phrase is selected, and you press SHIFT+ALT+RightArrow, the placeholder will be put immediately after the phrase box location. 

Insertion of placeholders is intelligent. If you insert one following a storage element containing final punctuation, or standard format markers, or both, then the punctuation and markers, together with the navigation text shown above the strip, are moved on to the placeholder. If you remove a placeholder which has had punctuation or markers transferred to it in the above way, then they will be automatically transferred back to where they were before.
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  Remove A Placeholder
Select a placeholder and click this button to cause it to be removed. Any target text will be thrown away, so if you want to retain the target text, first copy it to the clipboard using the Edit … Copy command, or CTRL+C key combination.

Removal of placeholders is intelligent. If you remove a placeholder which has had punctuation or markers transferred to it in the above described in the above discussion of the Insert A Placeholder to Left/Right of Selection/PhraseBox buttons, then they will be automatically transferred back to where they were before.

Removing a placeholder is not permitted when glossing mode is current.
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  Show The Choose Translation Dialog
Click this button (or CTRL+L) to have the Choose Translation dialog displayed for the storage element at the current active location (i.e. where the phrase box is currently located). When the dialog is open, any of the functions supported by this dialog are available; such as altering the order of the adaptations in the list box, or adding a new adaptation, or removing one or more adaptations. (You can also do these things in the knowledge base editor.)

The Choose Translation dialog has the following appearance:

[image: image134.png]Forts | Puncusion Toolbar Case  BackuptandMisc View  Auto-Swing Units | USFMand Fiteing

Define USFM and Marker Filtering (Marker Hiding)
¢ you tend £ change he SFM st el ke i change, <hange the ST st .
st St Slchion:

T Documents Setings: Prject Defuts:
@UBSUSM 20305 Only | ® UBSUSM 20730 5exOnly
OSLENG 1885et0ny | OSLENG 1885t Oty

OBt UBs and SIPNGSes O Beth UBS and SLPNGSets

0] Change USPM faed space marer (- el spces
Rt USFAdiscrtonary e bk /) e shays removed fom i tots

To it ou (i) the e st it  markr,check the b ns 1o he marker. T adapt he s ssocted it
2 marer,un-chckthe bo o the make. e checked, the maker and ssocited e il fred o0t
idden o the adpted document.

This Documents Fiter Settings:

Second semate) chaptrmumbes (o coing ot verscsior ol o ploce where feren
Dot sudynotecesory

[\ Chapte Desciplion (Publsing option®, e, inRsson i)

N0 Chapteriaolues forrmiatons ot a3 s soch - Chepte Seore chaptc s (e, Pl
Dltcone  Back mates concorgance v

[ \ee Scond (hemat)chater e (o codin dul vricatn; el o lces wheredifrnt ok
Dot sty notectesory

[\ ChapteDesciplion (Publsing option®, e, inRssan Sbls)

[N Chaptrisbl s forrmiotons ot s s s soch Chepte seore chapte mumbers (e, 1l
Dltcone  Back mates concorgance B





The dialog shows at the top right the source text phrase (or word) which is at the active location. At the left is a list box, the contents of which are not in alphabetical order, and which displays all the adaptations of this particular source text currently known to Adapt It. By selecting an adaptation and using the Move Up or Move Down buttons, you can change the order of the entries in the list box. (The Phrase Box and the Knowledge Base Editor will also show them in the new order. Or if you change the order in the Knowledge Base Editor and the new order will be reflected in the Phrase Box and the Choose Translation dialog.)

You can use the Remove From KB button to remove a selected adaptation from the knowledge base. (This will make your documents inconsistent with the knowledge base, so you should consider using the Edit … Consistency Check… command afterwards, though no harm to the application's operations will result if you don't do the consistency check.)

If you wish to give a new adaptation at the current active location, and the adaptation you want is not in the list box, then type it at the New: text box at the bottom, then click the OK button and your new adaptation will be entered into the phrase box. When you press the ENTER key, it will then be stored in the knowledge base. If you click in the box and leave it empty, you will be able to have <no adaptation> stored.

If there is only one adaptation in the list box, and you had previously clicked the Force Choose Translation Dialog For This Item checkbox for this source text's adaptation, then an extra button called  Do Not Ask Again  will appear. You can use this button to clear the setting of the Show Alternatives If Matched checkbox for this entry back to an OFF state. 

The Choose Translation dialog is also used when glossing mode is currently turned on; and in that circumstance it will display the current glossing alternatives at the active location.
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 Untoggled (default): The button shows what Adapt It is currently doing – showing both source and target text. The Tooltip shows what will happen if the toggle button is clicked: Show Target Text Only
In its normal state the appearance of this button shows both the source text and target text lines paired together in strips - indicating that both source and target text are being displayed on the screen. The tooltip and help text what you accomplish by clicking on this toggle button, i.e., you click it and it changes to show target text only. After clicking this button you will only see target text showing on the screen. The button described below works together with this button to operate as a single toggle button with two different appearances. 

When glossing mode is turned on, the button restores the display to the normal situation for glossing mode – which means the phrase box line shows glosses, and the line below it shows any adaptations.
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 Toggled: The button image shows what Adapt It is currently doing – showing target text only. The Tooltip shows what will happen if the toggle button is clicked: Show Source and Target Text
This is the alternate appearance of the button described above. When the button has this appearance, it means that only the target text is being shown. The lines are shown closer together and the gaps between storage elements are approximately the size of a single space character, making it easy to read back over your work. You can still edit the target text, you can click anywhere to place the phrase box at a different location, you can use the Go To… command, and the Step Up, Step Down, To Start, and To End toolbar buttons still work, and so too does the Choose Translation button, as well as some other buttons. However, commands which require you to first make a selection will not be available in this view. Click this button to switch the view of the document back to the normal view – that is, back to showing both source text and target text lines. This button and the Show Target Text button work together as one button, you see only one of them at a time. 

When glossing mode is turned on, this button will display the glossing text only.
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  View Translation Elsewhere
Click this button to cause the View Translation or Glosses Elsewhere In The Document dialog to appear. This dialog is not modal, so you can hide it by clicking in the main window, or close it by clicking the Close button. The dialog permits you to examine the translation which you did at some location specified by a chapter and verse reference, possibly distant from where the phrase box is currently located, and to jump there if you wish. You can show just a single verse, or by using a button you can show more context as well. The dialog has the following appearance (displaying some Tok Pisin back translation text):
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The top edit box shows the source text, and the large edit box in the middle shows the target text (your translation) at the chapter and verse which you specify using the two edit boxes at the lower left. When specifying a verse number, you cannot use a range such as 2,3 or 4-6, however if in the document itself there is a range of verses specified, the dialog will be able to find it correctly. For example: suppose in chapter 2 your translation had combined three verses 4, 5 and 6 into a range, and specified that range as 4-6; and when you have the above dialog open you specify chapter 2, and verse 5. What will happen? The combination of verses for 4-6 will be correctly shown in the dialog; it would also be shown if you specified either 4 or 6.

To use the dialog, specify the chapter and verse you wish to look at - it can be anywhere, then click the Get Chapter Verse Text button. The source and target text will then appear; and the chapter and verse range will be shown at the bottom. 

If you change any of the text in the boxes, the changes will not be put into the document. If you really want to edit the text, you must do it in the main window. You could use the Close and Jump Here button to close the dialog and jump immediately to the chapter and verse shown in the edit boxes at the bottom left. If you click the Close button, you will just return to wherever the phrase box was located when you opened the dialog.

The Show More button allows you to request that more context be shown. One press of the button will add a single verse preceding the current text, and also a single verse after the current text, for both source and target. You can press the button up to ten times. The chapter and verse range displayed at the bottom will update each time you press the button. Chapter and verse references are also inserted into the text in the form n:m to help you to know what part of the text you are looking at. The edit boxes can be scrolled. You can use the Show More button when at or close to the start (or end) of the document, the dialog is smart enough to detect when no more context is available and act appropriately. You can return quickly to just showing a single verse by clicking the Get Chapter Verse Text button again.

The Show Less button just undoes the effects of the Show More button, each press removes the outermost verses of the context. It can be pressed a maximum of ten times, or as many times as the Show More button was pressed. You can return quickly to just showing a single verse by clicking the Get Chapter Verse Text button again.

When glossing mode is turned on, the dialog displays glossing text in the lower edit box, and the title of the dialog from version 2.0 and onwards is “Display Translation Or Glosses Elsewhere In The Document.”
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Untoggled (default): The button image shows what Adapt It is currently doing – copying punctuation from the source to the target. The Tooltip shows what will happen if the toggle button is clicked: No Punctuation Copy. In its normal state the appearance of this button shows some punctuation on a green background - indicating that punctuation is currently being copied from source text to target text during adaptation. The tooltip and help text indicate what you accomplish by clicking on this toggle button, i.e., you click it to suppress the copying of source text punctuation. This button only toggles temporarily and reverts immediately to its default state when the phrase box moves to another location.
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Toggled: The button image shows what Adapt It is currently doing – Not copying punctuation. The Tooltip shows what will happen if the toggle button is clicked: Enable Punctuation Copy
This is the alternate appearance of the button described above. When the button has this appearance, it means that punctuation is not being copied from the source text. You can click it to immediately change the behaviour back to the default behaviour. The button described above works together with this button to operate as a single toggle button with two different appearances.
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Display Help Topics
Click this toolbar button to display Adapt It’s built in online helps. A Help Viewer window opens in which you can explore the Adapt It helps by topic by index or by searching. By default a glossary of terms appears in the first display window.  You can resize the Help Viewer and position it in a convenient place on the screen, and Adapt It will remember where you put it the next time you open the help viewer.

Adjusting Toolbar Sizes and Hiding Toolbar Buttons

(See the Toolbar tab discussion in the Edit menu discussion under Preferences.

Menu Commands

There are eight main menus: File, Edit, View, Tools, Export-Import, Advanced, Layout, Help. Note: The Layout menu only appears in the Unicode version of the program. A special ninth menu Administrator is normally hidden, but can be made visible by administrators using a password. The menus are discussed below.

File Menu

The File menu looks like this:
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New
When a project is open, this command will put up a standard file dialog. Use it to navigate to the file of source text data which you wish to adapt. (The File … Start Working Wizard … Document tab's "<New Document>" item also works the same way when double-clicked). The New command is disabled while a document is open. It becomes enabled when a document is closed as long as the Project is still open.

The standard file dialog will open showing the contents of the Adapt It Work folder - at least that is true when you have just started the application. Once you have used the New command once in a work session, Adapt It will remember which folder you navigated to in order to access the input file you wanted to use. If you then, in the same session, use the New command again, (or the Start Working Wizard's  <New Document> command), when Adapt It opens the file dialog again you will be back in the folder you last used.

Open
When a project is open, this command will put up Choose a Document dialog showing you the contents of the Adaptations folder which is a subdirectory of your project folder. You will see any existing Adapt It documents that you have worked on earlier. Adapt It documents are always stored in project folders (each project folder has a subfolder called Adaptations in which Adapt It stores any documents created within that project). Double click the one you wish to do further work on, or single click and click the Open button.

When collaborating with Paratext or Bibledit, this menu item appears as:

Open… (Get Source Text From Paratext) or Open… (Get Source Text From Bibledit) and the “Open” operation will summon the collaboration dialog in which the user can select a scripture book and chapter obtained from Paratext or Bibledit for adaptation work.

Save
When a project is open, this command will cause Adapt It to do an immediate save of the current document to your current project's Adaptations folder. Every time a document save is done, an automatic save of the knowledge base also occurs.

When collaborating with Paratext or Bibledit, this menu item appears as:

Save (Transfer Translation Draft To Paratext) or Save (Transfer Translation Draft To Bibledit) and the “Save” operation will save the document locally and also transfer the target text translation of the chapter (or book) back to Paratext or Bibledit for storage there.

If you have auto-saving turned on (see Edit … Preferences … and go to the Auto-Saving tab, and choose the auto-saving settings you wish to use), then you do not have to do any saving manually. Even when auto-saving is on, if you click the Save command, an immediate save is done. (There is no Save As… command, for it is not permissible to change the name of an Adapt It document while working on it. But there is nothing to stop you from exiting the application, and using system commands to edit the name of an Adapt It document. As long as you don't remove it from the Adaptations folder, Adapt It will be able to find the document with its new name.)

Save As…
Version 6 of Adapt It adds a Save As... command. It can be used to save a document with a new name (that is, the document is renamed, and no longer will be on disk with its earlier same). It can also be used to have the document saved in legacy xml format for compatibility with versions of Adapt It earlier than version 5.2.4. Using the Save As… command will save the document in the pre-version 6 xml format, however, when next opened in version 6 of Adapt It, the document will automatically be restored to the newer xml format. The Save As... command will not let you change the folder in which the document is to be saved, and the Save As… command is not available when collaborating with Paratext of Bibledit.

Save and remember in history… (see the section Saving Versions in a Document History (and Roll-back) farther below where this feature is described in detail)

Close
When a project is open, this command will cause Adapt It to close the currently open document. But first, Adapt It will put up a message box asking you if you wish to save the document first. If you click Yes, a save is done and the knowledge base is also saved, and then the document closes (the window becomes blank). If you click No, no save is done. Click whatever option you want, and then the document will be closed. The project, however, remains open, allowing you to open other documents belonging to the same project, or create new ones.

Pack Document… and Unpack Document…
Sometimes you want to take get the document open on the screen in front of you quickly into someone else's computer and have it be opened on that 'destination' computer with just a few clicks. The Pack Document... and Unpack Document... commands, located on the File menu, enable that to happen.

Packing of the document involves compression, and unpacking it on another computer involves decompressing it. The compressing and uncompressing is automatic. Packed Adapt It documents have an  .aip filename extension. To make a document be packed, it must be open in the main window of Adapt It. When packing is done, Adapt It includes not just the xml form of the document, but also the project's configuration file, and enough additional information for the setup to be done properly on the destination computer. When you click the Pack Document... command, Adapt It will present you with a file dialog so you can name the packed document's file, and if you wish, you can also specify where it is to be saved (typically, on a USB memory stick, a floppy, or on your hard drive ready for you to attach the file to an email).

On the destination machine, the other person loads Adapt It and then clicks the Unpack Document... command. Adapt It will present a file dialog in which he or she can navigate to the packed document file and double click it, or alternatively, select it and then click Open. Adapt It will then use the information in the file as follows:

· it will create the needed folder structures for the project if they are not already on the destination machine;

· it will turn Book Mode on or off to match the setting on the other machine when the pack operation was done;

· it will create (or replace) the project's configuration file using the one in the packed document file;

· it will save the xml adaptation document to the folder it belongs in and then load it into memory and show the document correctly laid out in the main window.

A knowledge base is not transferred in the pack and unpack process. So, when an unpack is done and there is no knowledge base in the destination computer for that project already, an empty one will be automatically created. This is not a problem because a populated knowledge base is not essential for the document to be visible and worked on.

Note: Adapt It and Adapt It Unicode each check the packed file to see if the packing was done on a machine running the same version of the program. So if you pack using the regular Adapt It, then the other person should unpack using the regular Adapt It; likewise, if you pack using Adapt It Unicode, the other person should unpack with Adapt It Unicode. If Adapt It is used to unpack a file packed using Adapt It Unicode, or vice versa, Adapt It or Adapt It Unicode will show a warning to the person doing the unpack. When he, or she, dismisses the message the unpacking operation halts; settings are restored to what they were before the unpack was commenced, and the main window is left showing whatever document was open.

What happens if the person on the destination machine tries to unpack a document, but there is already a document of the same name (and in the same project folder) on that machine? Answer: Adapt It will open a dialog which asks whether or not the existing document file is to be overwritten by the one being unpacked. The default action is to overwrite. If the person doing the unpack chooses not to have it overwritten, the unpack operation will be halted immediately and earlier settings will be restored, and the main window will show the document which was open before the unpack was commenced.

Pack Document... can be done on only one file at a time. Likewise, Unpack Document... handles only one file at a time. There is nothing to stop you, however, from packing a whole lot of documents, one after another; sending them to the other person who then unpacks them one by one. The File menu's Restore Knowledge Base could then be used to quickly produce a knowledge base from the unpacked documents on the destination machine. (For that command to work, no document should be open.)

You can pack and send documents from different projects quite safely. When each is unpacked on the destination machine, Adapt It will work out whether each one belongs to a project already on the destination machine and put it there, or whether to create a new project folder to receive it. In other words, just pack the documents you want to send, regardless of what particular project they belong to. Adapt It's Unpack Document... command will do the rest for the receiver automatically.

(For your information: Adapt It Unicode's configuration files are not fully compatible with Adapt It, and vice versa. The packing operation always incorporates a project configuration file, so we do not allow Adapt It, or Adapt It Unicode, to try to unpack the other's packed document files. Also, if the document contains Unicode characters not in the ASCII range, the xml document files are not compatible between the two applications either.)

Print …,  Print Preview, and Page Setup… (see the section on “Printing” later in this document)
The next three commands are project-related commands. 

“Start Working” Wizard…
The Start Working Wizard was discussed earlier in the section Using Adapt It For The First Time, so we will not discuss it again here. Unless Collaboration with Paratext or Bibledit is activated by the user, the Start Working Wizard is the normal way to start working on adaptation within Adapt It.

Close Project
Clicking this button will cause the current document, if one is open, to be closed. You will first be asked whether or not to save it. And then the project will be closed as well. The application remains running, so you can then open a different project, or create a new one, with the Start Working… wizard.

Change Folder…
Book Folders Mode
NOTE: Rather than using Book Folder Mode, we highly recommend that administrators set up Adapt It version 6 to collaborate directly with Paratext or Bibledit, which is a much simpler way of working for teams who are adapting Scripture and have access to Paratext or Bibledit. See the Help for Administrators document for more information.
The Advanced menu's command Storing Documents In Book Folders enables you to have your scripture documents stored in folders named after the 66 books of the Bible. The names of these folders are taken from an external control file called books.xml which also includes a 67th name, Other Texts, used for an additional folder in which anything which is not scripture can be stored (for example, adapted literacy materials).
These Bible book folders are stored in the project's Adaptations folder. They are written there, empty, when the Storing Documents In Book Folders command is used for the first time in that project. Once written, they cannot be removed from within Adapt It, but you could do so in Windows Explorer when Adapt It is not running.
The Storing Documents In Book Folders command is a toggle command. Each time you click it, you turn book mode on or off. Book mode is the name we give to the state in which documents are being created in, and saved to, a chosen Bible book folder. When you turn book mode on you will be asked to save the current document's contents, because it is a document stored in the Adaptations folder and so it cannot be open when you are going to be in a mode in which only documents in book folders will be accessible to you.
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After that the Document page of the Start Working... wizard will be displayed as in the picture above left. Note that by default it chooses the Matthew folder. This is not always going to be the folder you want to work in, so there is an additional button called Change Folder... which puts up the dialog below. It enables you to choose which book folder you want to work in.
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If you click the combo box a drop down list will display which will list, in Bible order, the 27 books of the New Testament - you can click the one you want there. If you want a book in the Old Testament, first click the appropriate radio button on the left, then click the combo box. For instance, to select Leviticus, you would like History books first, and then in the combo box Leviticus would be the third name displayed.
Because the names of the folders come from the XML file books.xml, any user who does not want to use Bible book folder names can change the book names in the books.xml file. That file also contains 5 other names for divisions of the Bible. These names are History books, Wisdom books, Prophecy books, New Testament books, and the last is Other Texts. These names are used in Adapt It to name five division buttons; so if you use non-biblical book names, you would probably want to use five different division button names. Your own custom names for the divisions and buttons can be whatever you like. The number of books in each division is determined by you - just add or remove content in the books.xml file. This dialog would then show your custom names for division buttons and book folder names.
The names in the books.xml file are also localizable, so you can spell the names the way they are spelled in your own language if you wish. In the books.xml file, if you localize the name in the "folder" attribute, the localized name is used in naming the folder on the hard drive; if you localize the name in the "view' attribute, that localized name is used in the combo box list shown in the above picture. You can localize either name, or both. The file also contains the unique 3-letter Bible book codes, so if you use non-scripture names in your modified books.xml file, then you should define some arbitrary 3-letter book codes of your own - other functionalities in Adapt It, namely the Split and Join commands, need to use whatever codes are defined - even custom ones defined by you.
The Change Folder... button is also repeated as a Change Folder... command on the File menu. This allows you to change to a different book folder without having first to open the Start Working... wizard. When you change to another book folder, the current document will be automatically closed (you will be asked if you want it saved if it contains unsaved editing changes) and the Documents page of the Start Working... wizard will automatically open and show you the contents of the book folder which you chose.
The next three commands on the File Menu are knowledge base commands. It is possible you may never need to use them, because saving and backing up the knowledge base can all be done for you automatically, and restoring the knowledge base is rarely called for.

Notice that none of these commands distinguish between the glossing knowledge base and the adaptation knowledge base as far as their visible names are concerned; however, these commands work on only one knowledge base – which one will depend on whether or not the application is in glossing mode or adaptation mode. For the former situation, the commands affect the glossing knowledge base; for the latter situation, the adaptation knowledge base.  However, saving documents or exiting the application will always update both knowledge bases if you specify that the knowledge base to be saved when asked.

If you wish to use these commands, here is a description of what they do. Their description will be in terms of the situation when in adaptation mode. For glossing mode the behaviour is virtually identical but on the glossing knowledge base, so no separate description need be given.

Continuing with a description of the commands on the File menu:

Save Knowledge Base
Click this to cause Adapt It to immediately save the knowledge base to disk. (The knowledge base is saved automatically after every document save, so if you manually save your document regularly, you don't have to worry about saving the knowledge base. Likewise, if you have auto-saving turned on, you don't even have to worry about saving documents manually either.). Adapt It maintains both a glossing knowledge base and an adapting knowledge base; so which of these is saved by this command will depend on whether or not glossing mode is turned on or off, respectively. When closing the application or a project, however, both knowledge bases are automatically saved unless the user tells the application not to do the save.

Backup Knowledge Base
You can cause Adapt It to make a backup file for the knowledge base by clicking this command. A backup is normally done only when the application is launched. The reason for this is that if the knowledge base has become corrupted, automatically making backups of it will then backup a corrupted knowledge base, which would make it useless as a backup. Adapt It does the following to get around this problem. Anytime a backup is attempted, it first does an integrity check of the knowledge base. It the integrity check succeeds, Adapt It goes ahead with making a backup file. Which knowledge base is backed up depends on whether glossing mode is on or off. When on, it will be the glossing knowledge base; when off, it will be the adapting knowledge base. Both knowledge bases are backed up when the application or project is closed, unless you tell the application not to save the knowledge base.

If the integrity check fails, Adapt It will put up a message asking you if you want to substitute the existing backup file for the corrupted knowledge base. If you respond by clicking the Yes button, it throws away the bad knowledge base, renames the backup so that it becomes the current knowledge base, and opens it ready for further work. If it should turn out that the backup is also corrupt, use the Restore Knowledge Base command. (See below.) This process also responds to the current mode – whether glossing or adapting.

You can turn off automatic creation of backup knowledge base files in the Knowledge Base tab in the Preferences dialog. It is strongly recommended that you do not do this. Backups are a valuable protection for your data. But if you are short of hard disk space, this would be one way you can save some space.

Restore Knowledge Base…
This command is available only when a project is open. Remember that which knowledge base is restored will depend on whether glossing mode is on or off.

Since all of the information about the adaptations of the source text words and phrases resides in the documents, as well as in the knowledge base, Adapt It can use the documents you have already created in order to build a completely new knowledge base from them. The rebuild outcome depends on the current setting of two mode flags. Whether the application is in glossing mode, or in adapting mode; and whether or not the application is in auto-capitalization mode. If auto-capitalization is in effect, the rebuild will produce only lower case knowledge base entries (which is what you would want;) but if auto-capitalization is turned off, it will produce entries which begin with either upper case or lower case, depending on what occurs in the documents. When glossing mode is currently in effect, only the glossing knowledge base is rebuilt; and when adapting mode is in effect, only the adapting knowledge base will be rebuilt. To rebuild both knowledge bases, you need to rebuild twice, once with glossing turned on, and then again with glossing turned off.

When you click the Restore Knowledge Base command, after a short message which gives you some information about the process and a chance to back out, Adapt It will put up the following dialog:
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Adapt It will use the files listed in the left hand list box to reconstruct your knowledge base. If some of the listed files have data which is of no value to your project (e.g. maybe you have files which you produced while learning how to use Adapt It, but which have no lasting value), then you can remove those files from the reconstruction process in the following way. 

Select a file you want removed, then hit the "X" button, and it will be moved to the list box on the right hand side. If you change your mind, select the file on the right hand side and click the "Tick" button and it will be moved back to the left hand side. You can move as many files to the right as you like. However, be aware that if you move files containing valid adaptation information, the reconstructed knowledge base with then lack some valid adaptations. This will not adversely affect Adapt It, but it may cause you to have to retype some translations you typed earlier but which were not included in the reconstruction.

If you want to be sure that the new knowledge base does not miss any information, leave all the files listed on the left, do not move any of them to the right.

While Adapt It can reconstruct all the adaptations from the document files, it cannot reconstruct the instances where you selected the Force Choice For This Item checkbox. Recall that you use that checkbox to force Adapt It to show the Choose Translation dialog when you have a single adaptation for a given source word or phrase, and you suspect that at some time you are going to have to supply at least one more adaptation. 

If your old knowledge base is not too badly corrupted, you might be able to get these settings, or many of them, back for free. Adapt It will put up the following message box before it begins rebuilding the knowledge base:
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As this message box says, if you choose the Yes option, the application may possibly crash due to the corruption. It just depends on how badly the knowledge base is corrupted. It might be worth a try. If Adapt It crashes, just launch it again, choose the same command, and when you get to this message, choose the No option. The No option causes the old knowledge base to be unconditionally thrown away; the Yes option causes Adapt It to try to rescue the additional settings before throwing away the old knowledge base. If you choose the No option, you can still use the Tools … Knowledge Base Editor … command at a later time and in that editor you can put back the missing settings manually (though you would have to remember which words and phrases require them, which might not be a simple matter if the knowledge base contains thousands of entries! On the other hand, if you have thousands of entries, these settings are highly unlikely to be of any further relevance - by their nature they are only of use when you are just getting started on the adaptation work, and you are way past that stage.)

When Adapt It is doing the reconstruction, you will see a message box containing a progress indicator and information about the filename, and how many files there are, and how many have been processed, and so forth. When the process is finished, another message box will show you some summary information; click its OK button to finish.

Before using the Restore Knowledge Base command, and provided your existing knowledge base is not corrupted, consider first using the Edit … Consistency Check command. The reason for this is as follows. If your documents are not consistent with the knowledge base (e.g. perhaps you removed some adaptations using the Knowledge Base Editor), the consistency check will permit you to fix any adaptation of some source text that is not found within the knowledge base. If you don't do that, then the restoration of the knowledge base will reflect the information in the documents, and if that information has not been made consistent with the former knowledge base, then the inconsistencies will become "consistencies" in the new knowledge base. You would then have to do the removals of the information you didn't want all over again. 

If you don't understand this now, don't worry, it is not a major problem. It will be discussed again when we get to the Consistency Check command. The important thing is this: if you edit the knowledge base, you should do a consistency check as soon as it is convenient to do so, so that your documents and the knowledge base remain consistent. On the other hand, inconsistencies between the documents and the knowledge base will not affect Adapt It adversely in any future adaptation work; it just means that some of your earlier adaptations in the documents might be wrong, and they would stay wrong.

Saving Versions in a Document History (and Roll-back)
As of Adapt It version 6.5.0, Adapt It allows a user to save a "snapshot" of adaptation documents in a document version history. This helpful feature is designed to allow a user to view any previously saved snapshots of a document, and roll-back the current document to exactly what it was in a previous snapshot. This feature requires that the Git program be installed on the user's system. Most Linux systems already have the Git program. As of Adapt It version 6.8.2, the Windows Adapt It installer can automatically download and install the Git program if it does not already exist. If Git is not installed on a Windows computer, the Adapt It installer will present a separate wizard page that looks like this:
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 This installer page presents three different options for installing Git on a Windows computer. The first option “Do not try to install Git at this time” may be useful if you plan to install Adapt It and Git on a number of different computers and have a slow and/or expensive Internet connection. The Git program download is about 47MB in size, and once downloaded, it can be installed on different computers by using the third (bottom) option “Browse this computer to find a Git installer”. The middle option is “Download and install Git from the Internet”. This is the best option for users who have access to fast and/or inexpensive Internet. 

When the middle option is selected both Adapt It and Git are installed on the computer. In addition, a small program called the Git Downloader will be installed, and a copy of the Git installer will be copied copied to the Adapt It installation folder. The Adapt It installation folder is normally at: c:\Program Files (x86)\Adapt It WX Unicode\. The Git installer will named something like Git-2.32.0-32-bit.exe. You can copy that installer to a thumb drive and carry it to other computers that need to have Git installed along with their Adapt It installations, then by selecting the bottom button in the Adapt It Git install options page, you can navigate to the location of the  Git-2.32.0-32-bit.exe file and have the Adapt It installer install it for you with all the appropriate Git options needed for Adapt It to be able to use Git to maintain its document history functions.

The above installer wizard page is also available as a dialog from within the running Adapt It program, as a menu item on the Tools menu named “Install the Git program...”. When invoked, that menu item detects if Git is already installed, and if so, what version is installed. A message box will inform you of the situation of Git on your computer, and ask you whether you want to proceed with Git installation options. If you respond “Yes”, it opens a dialog that looks similar to the installer wizard page shown above and includes the same three Git install options. The main difference when installing Git from within the running Adapt It program is that, if the middle option is selected (Download and install Git from the Internet), Adapt It will invoke a small Git downloader named something like Git_Downloader_2_32_0_4AI.exe that is also stored in Adapt It’s installation folder to carryout the download and installation of the Git program with the appropriate options for it to be able to manage Adapt It’s document history functions. 

There are three menu items on the File menu related to document histories. These menu items are functional only when the Git program is installed. The menu items are:

Save and remember in history...
At any time while adapting a document, the user can save and remember a snapshot of the document in the document's history. When this File menu command is selected the following dialog appears:
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This dialog asks the user to type a comment about the version of the document that is about to be saved. When OK is pressed Adapt It takes a snapshot of the currently open adaptation document, and saves that snapshot in the document's history along with the comment, the date-time and the author's identification information. The first time a version is saved and remembered in the history, Adapt It asks for a unique user name - such as an email address - along with an informal human-friendly name to use as the author's identification information associated with the documents being saved in the history. Currently document histories are only saved on the local computer using the Git distributed version control system (DVCS).

Look at previous versions in the document history...
This File menu command opens a navigation dialog which looks like this:
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This dialog allows the user to view previous versions (earlier) or next versions (more recent) that were saved in the document's history. The user can navigate backwards or forwards through the saved versions of the document which are displayed in read-only mode (with pink background). If desired, the user can "roll back" the document to the version that is being displayed by clicking an "Accept this as current" button in the navigation dialog - making that previous version become the current version of the document. If instead, the user clicks on the "Return to latest version" button or the "Cancel" button, no changes are made to the current document.

View list of previously remembered versions...
This File menu command displays a summary list of all versions of the document that were previously saved in the document's history, one line per version:
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Each line shows the author, the date the version was saved, and the comment entered by the user when the version was saved. From this list the user can select a version and click on the "Look at selected version" button, which displays that selected version in read-only mode, and opens the navigation dialog as described in the "Look at previous versions in the document history" menu command above. From the navigation dialog the user can navigate to prior or later versions, click on the "Accept this as current" button, or "Cancel" to return to the document as it was before viewing the list of previously remembered versions.

Document Ownership

The ability to roll-back to a previous version of a document should be limited to the author or "owner" of that document. Beginning with version 6.5.0 Adapt It asks the user to provide a unique username as well as an informal username the first time the user elects to "Save and remember in history". The dialog looks like this:
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Documents that are saved in the document history are associated with the usernames that are entered into this dialog.

Take ownership of this document
If more than one translator is working on the same project (on different computers) each translator should have separate and unique usernames. They may eventually share their documents, but each document should have a unique author or username associate with it when it is lodged in the version history. In the event that a different user views a document which he does not "own" the document automatically opens in read-only mode (with a pink background color). If the current user needs to edit the read-only document, he can use this File menu command to "Take ownership of this document", and the document's read-only status will change and it will become editable, and if it is saved in the document history, it will then be owned by the current user.

One's user name can be changed using the "Change Username..." command on the Edit menu (see below).

Edit Menu

Undo
This command is supported, but only for some operations in the phrase box. It will restore your last editing operation only, such as a backspace key press, delete key press, Cut command, or Paste command.

Cut
Use this command to cut selected text and place it on the clipboard.

Copy
Use this command to copy selected text and place it on the clipboard.

Paste
Use this command to paste text from the clipboard, inserting it at the cursor location; or if there is a selection, replacing the selected text.

Go To…
This command puts up a dialog which allows you to specify a chapter number and a verse number, and when you click the OK button, Adapt It will move the active location (and the phrase box) to the start of that particular chapter and verse. For a short book without chapters, such as 2 John, use a chapter number of zero. The dialog has the following appearance:
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Note: if your source text file did not contain standard format markers, then the Go To… command will not be of any use for navigation purposes. You file must have \c and \v markers for chapters and verses, respectively, for this command to work.

Edit Source Text…
This command allows you to edit a section of selected source text words or phrases; including any standard format markers (such as chapter marker \c, verse marker \v, and others too) which are stored on the selected document storage elements. This will be discussed at some length later in this document, under the heading Editing The Source Text.  The accelerator keystroke for this command is CTRL+Q.

Consistency Check…
This command is used to check one or more documents for consistency with the information recorded in the knowledge base. The default option is to do the check on the currently open document. A small dialog is first shown, use it to choose which kind of check you want. The dialog looks like this:
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Regardless of which option you choose, when the check is finished the current document will be reopened, and the phrase box will be placed where it was before you initiated the consistency check; except if the phrase box was not in existence (because you were at the end of the document), it will be placed at the initial position.

As of version 6.6.2 there is a checkbox added: “Do blind fixes whenever possible”. Read the explanation in

the picture above. 

When would you use this checkbox? 

Suppose you wanted to make spelling corrections to hundreds of words which are scattered throughout many translated documents. How can you do this simply, yet be sure all the words are updated correctly no matter where they occur? The solution is to do the editing of the words in the Knowledge Base Editor dialog. You would click each adaptation (or gloss if working in glossing mode), and in the Editor dialog you would make your spelling adjustments to the word or phrase, then click the Update button to have those adjustments accepted. Your adjusted word or phrase then replaces the older word or phrase. But of course, this replacement only happens in the knowledge base - all the documents still contain the older not-yet-updated forms of the words. So, after making all your updates in the Knowledge Base Editor, you click OK to close the Editor and have the updates stored safely. Then you click the Edit menu, and choose  Consistency Check...  and at that point you will see the above dialog. Then click “Check this and other documents in this project”, and also click “Do blind fixes whenever possible”. Then click OK. 

The consistency check will then be done, and your edits will be transferred into the documents at the right places. You may still see a few openings of the Consistency Check Dialog - this will happen whenever an updated word or phrase is just one of several possible meanings for the given source text. In that circumstance, because there is more than one option available and Adapt It cannot know your mind, it has to ask you in a dialog which meaning is correct for that particular context. 

Even so, if you have ticked the Do blind fixes whenever possible checkbox, you will be spared from having to interact with the Consistency Check dialog hundreds of times or more. This can save you a LOT of tedious work.

The command is very useful, both for doing an occasional consistency check to check that the information in your documents matches what is currently in the knowledge base, and also for fixing up your documents when you find that some of your earlier adaptations are wrong and you wish to change them. We will discuss the latter process towards the end of the discussion for this command.

The consistency check operates on only one knowledge base at a time; therefore it looks at the current setting for glossing mode. If glossing is turned on, it will check the consistency of the glossing knowledge base with the glosses that occur within documents. If glossing is turned off, it will check the consistency of the adapting knowledge base with the adaptations that occur within documents. So the comments below apply in the same way for both modes; the comments discuss only the situation when adapting is the current mode; for glossing mode, just substitute ‘glossing’ for ‘adapting’ and the rest is much the same.

The consistency check should be done with the same setting for Automatic Capitalization as was used when doing most or all of the adapting. If you had automatic capitalization on for adapting, but off when doing the consistency check, then you will notice that Adapt It finds a lot of inconsistencies – and they begin with upper case letters. If this happens, just cancel the consistency check, turn on Automatic Capitalization again, and then recommence the consistency check – it will then no longer treat the upper case instances in the document as inconsistencies.

When you take the "Check this and other documents in this project" option,  you will see the Remove Unwanted Files From The List dialog pictured above in the discussion of the Restore Knowledge Base command of the File menu. Use the dialog to remove any documents which you are certain are correct and so do not need to be checked. No harm is done by checking them, just a little time wasted. You won't see this extra dialog if you choose to just check the currently open document. When you click the OK button, the check begins. If Adapt It finds an inconsistency, it will put up one of the following dialogs depending on the kind of inconsistency. When a knowledge base adaptation entry is expected, but has been deleted, the following dialog will appear:
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At the top left you will see the source text word or phrase for which there is an inconsistency - meaning that the translation shown has been deleted from the knowledge base. The possible adaptations for it which Adapt It currently knows about will be shown in the list box at the left. In this case you may accept the adaptation shown in the Adaptation text box, or click the other radio button to change the adaptation shown to something different for this location in the document. 

When an adaptation exists but there is no translation unit stored in the knowledge base, the following dialog will appear:
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The Source text and Adaptation text are stored in the document, but a knowledge base entry cannot be found in the knowledge base file. In this case you may select to store the Adaptation text shown in the KB in the normal way, or to store <Not In KB> if the source text should never have and adaptation entry.

When an adaptation is empty, but a knowledge base entry is expected, but empty, the following dialog will appear:

[image: image71.png]pe—
The adptaton s empty, novledge bse ety i xpected bt ssent





The Source text has no adaptation entry, but a knowledge base entry is expected, but is absent. In this case you may select to do one of four different things: (1) Enter an empty adaptation in the knowledge base via a <no adaptation> entry, (2) Leave an empty “hole” in the document and make no KB entry, (3) Assign a <Not In KB> to this source text which should never have an adaptation entry, or (4) Type a new adaptation in the supplied text box.

Note: if auto-capitalization is turned on before the consistency check is done, then words you need to type and which begin with a capital letter can just be typed in lower case – the auto capitalization functionality will do the capitalizing for you when the dialog closes.

If you believe that every future time the same inconsistency is found in a document it should be fixed in the same way that you fixed it this time, you can click the Auto-fix later instances the same way checkbox at the bottom of the dialog that is displayed. Then each time the same problem turns up, the fix will be made silently for you, and the above dialog will not be put up for that particular inconsistency.

Splitting adaptations – what to do if you discover some earlier adaptations are incorrect.
Suppose you adapted a certain source phrase with a certain target phrase, let us call it "target phrase A". For several documents, every time you come across this same source phrase, you adapt it with the "target phrase A" adaptation. Then you realize that in many places you really should have used "target phrase B", while in the rest of the places "target phrase A" was correct. What is the easiest way to fix this problem, so that at each location in every document where that certain source phrase occurs, the adaptation is the correct one?

One approach would be to open each document, use the Find command to search for the combination of source phrase and "target phrase A" adaptation, then edit it. But that would be a bit tedious, particularly if it occurred often. There is a better way, which uses the Knowledge Base Editor… command (see the Tools menu). Do the following steps:

1. Choose the Tools … Knowledge Base Editor command. Choose the tab which corresponds to the length of the source phrase you wish to fix. For example, if the source phrase had 3 words in it, choose the tab called "3 Words".

2. In the list box at the left, scroll to find the source phrase, or start typing it in the edit box at the bottom left. Select the phrase once you have found it.

3. In the list box at the top right you will see all the currently known adaptations for that source phrase. Select the one which you wish to fix. (That is, select whatever adaptation is represented by "target phrase A" in the discussion above.)

4. Click the Remove button so that that particular adaptation will be removed from the knowledge base, then click the OK button to finish the Knowledge Base Editor dialog. You have now made your documents inconsistent with the knowledge base, and the inconsistency is precisely the source phrase that you wish to fix by giving it two different adaptations in different contexts in your documents.

5. Choose the Edit … Consistency Check command, and in the Consistency Check dialog which comes up, choose the second radio button option: "Check this and other documents in this project." When the dialog for selecting which files to use comes up, leave all your document files in the dialog's left hand list box, so that they all get checked. Click the OK button to start the checking process.

6. Adapt It will find each instance which needs your attention, putting up the "Inconsistency Found" dialog shown above. Each time it comes up, you can type either whatever "target phrase A" represents, or "target phrase B" represents, whichever is needed in each context. And so all your documents will then be fixed correctly once the check is finished. You can move the dialog window to look at the document if necessary in order to check which particular context you are dealing with, because the document is scrolled to show you the place where the inconsistency was found.

Change Username...
As mentioned above in the section on Document Ownership, certain functions within Adapt It version 6.5.0 and later require the user to provide a unique username and an informal username. If a username needs to be changed it can be done using the "Change Username..." command on the Edit menu. The dialog that is used is the same one that is described above under the  section labelled "Document Ownership".

Change Punctuation or Markers Placement
During exports of the target text, sometimes (in ambiguous cases) Adapt It needs to have the user decide where to place certain markers and/or punctuation in that target text. This menu item, if enabled, causes the local storage of the former placements of markers or punctuation to be cleared in order to cause the placement dialog(s) to open again at that location, for a new placement to be done, which will be automatically stored.

Move Note Forward
If the user selects a source word or phrase that has an Adapt It Note attached to it, or places the phrase box under a source word or phrase that has an Adapt It note icon above it, this menu command can be used to move the note (and icons) forward through words or phrases of the source text. The note moves forward one word or phrase each time the menu item is selected.

Move Note Backward
If the user selects a source word or phrase that has an Adapt It Note attached to it, or places the phrase box under a source word or phrase that has an Adapt It note icon above it, this menu command can be used to move the note (and icons) backward through words or phrases of the source text. The note moves backward one word or phrase each time the menu item is selected.

Preferences…
This command is available only while a project is open (but no document from that project need be open). This command allows you to set up fonts, colours, whether or not to have automatic knowledge base backups made, the appearance of the main window and the size of the phrase box, which punctuation characters Adapt It will treat as punctuation, units of measurement, the USFM set of markers being used, and marker filtering. 

Fonts tab 
You have seen it earlier as a wizard page. It has this appearance:
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You can set the source, target and navigation text fonts, their sizes, styles and colours using the Change Font… buttons at the top right.  If you click one of these you will see a standard font dialog such as the following:
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In the Fonts tab you also can Set Custom Color…that each fonts uses. There are also two other font colours buttons for other types of text. Use Set Special Text Color… to set the colour of special text such as headings, subheadings, book titles, etc. which can have their own colour. Use Set Retranslation text Color… to set the colour of retranslation sections of the document. The Change Font… buttons allow you to change font colours within those dialogs on most platforms, but the Set Custom Color… buttons give more colours than you are shown in the standard font dialog. If you click the Set Custom Color… button you would see a standard colour dialog such as the following:
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Select the colour you want, or you can fine-tune it with the edit boxes provided or the slider control at the far right, or drag the cross-hairs in the spectrum box. Colours are easier to see if your text is displayed in bold style. Note: The appearance of the font colour selection dialog is different on different platforms.

Punctuation tab
You have already seen the dialog for setting punctuation character correspondences, in the discussion of the Start Working… Wizard. This dialog can also be chosen at any time a document is open by going to the Edit menu and clicking Preferences… and then the Punctuation tab. Depending on your punctuation settings, it might look something like this:
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Please note the Show U+nnnn button. This button can be used to have the Unicode values of the punctuation characters displayed visually, in case the user wants to check what particular Unicode code-point corresponds to the visible glyph in a box, or to edit the nnnn value. Clicking the button changes the button's label to Show Characters and also displays the values. The dialog would then look like this:
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Clicking the Show Characters button would then make the earlier form of the dialog visible again. The OK button can be safely clicked when the dialog is either showing glyphs, or showing their underlying Unicode code-point values.

If you edit the nnnn hexadecimal value, remember to keep it to 4 hexadecimal digits, not more or less – if necessary, add one or more extra zeros to the start. For example, if you want the glyph for the codepoint 21, you would type 0021.  In the boxes on the right, use a single place to separate any pairs of nnnn numbers. (Hexadecimal numbers are the numbers 0 to 9, plus A or a for 10, B or b for 11, and so on, up to F or f for the value 15.) Thus a left wedge "<" is represented by either 003c or 003C.

For the rules about what you can type in the cells, see the discussion earlier in the document, where this dialog is described as part of the Start Working Wizard's process.

Additional Comments Regarding Punctuation
If you access the above dialog from the Edit menu, and then change the source punctuation characters in any way, then Adapt It will reconstruct the source text in case the forms of the words shown as the source text are altered because of the different source punctuation. Adapt It does a pretty good job at this reconstruction, and so it is likely to be completely correct, or very nearly so. Any possible inaccuracies are most likely to be in your preserved translations – depending on what punctuation change you had made. You may need to inspect the translations after the document is rebuilt, and anywhere where the punctuation needs adjusting, do so. The preserved retranslations are associated with the reparsed source words, the rebuilt source phrases, and the re-inserted placeholders; and Adapt It puts all these into the knowledge base for you, so you don't have to go to the knowledge base to edit out anything, because that has already been done for you. Then Adapt It throws away the old no longer needed data. When you look at the screen, you are likely to see no obvious differences, and you may think that nothing has happened. But that is not so, everything has been completely reconstructed. So there might be some subtle differences that only a careful visual inspection will detect.

Be aware of this fact. Adapt It has special behaviours for the punctuation characters < (left wedge), > (right wedge), ' (apostrophe) and – (hyphen). Adapt It will not include apostrophe and hyphen in the default list of punctuation characters – for the reason that these are often used as word-building characters in many orthographies. Also < and > have a special use in "standard format". If you don't include < and > in the lists for source and target punctuation, Adapt It will detect this and automatically include them, and give you an information message to alert you to the fact. If you try to delete them from the punctuation, Adapt It will just put them back in for you, so don't try – you'd be wasting your time.

In SIL's conventions for standard format mark-up, single quotes are represented by < and > characters, and double quotes by <<  and >> pairs. It is possible to have nested quotes, so combinations such as << < <<  and later on >> > >> can be found in texts you may encounter, as well as other combinations. Adapt It will put all these nestings, whether at the left or at the right of the quoted text, on whatever storage element at the left of the quotation text, or at the right of the quotation text, respectively, as you would expect.

If you want to use a hyphen as a word building character, just omit it from the punctuation correspondences dialog. That is the default anyway. Then, if hyphen appears between spaces in the source text of your document, Adapt It will treat it as a word – but so long as you specify that its adaptation is just another hyphen, the result will be what you would want in the target text – you will get a hyphen between spaces. And if you Export… the document, your hyphen will occur between spaces just like you would expect for punctuation. So if Adapt It internally treats the hyphen as a word, that does not matter so long as the output at the end is what you are wanting to see. 

Similarly, if you wish to use an apostrophe for things such as the English  's  construction, like in the phrase  "boy's father", you are likely to get best results by omitting apostrophe from the punctuation correspondences dialog, and explicitly typing it in the translations wherever it is needed within words.

Toolbar tab
The Toolbar tab on the Preferences dialog can be used to specify which buttons to display on the toolbar:
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This tab has the following controls:

Toolbar Buttons list: 
this list displays each available button on the toolbar, along with a short description of that button's function. To display a button in the toolbar, select the checkbox next to the button in the list.

Toolbar Icon Size: 
here the user can specify a button size of Small, Medium and Large.

Toolbar Display: 
here the user can select either to display just the icon, or the icon and a text label (displayed below each icon in the toolbar).

Minimal Icon Set: 
click this button to select a subset of useful toolbar buttons.

Default Settings: 
click this button to reset the displayed icon buttons to the default settings.

For all but very small screens, you may want to set the Toolbar icon size to at least medium, as shown here:
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Case tab
Defining lower to upper case equivalences is described earlier. If you have told Adapt It that the source text contains both capital letters and small letters, and you want Adapt It to distinguish between them as you work, the Case tab will look like the following in the Preferences dialog:
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Note: To enable editing of the equivalences, both checkboxes must be ticked. Read the instructions above the three list boxes for more information.

Backups and Misc tab
This contains two checkboxes at the top of the dialog, the first is for turning on or off the creation of a backup knowledge base; the second allows you to have a backup document file created each time a document is closed. These backup files have the file extension .bak and they will not be visible in any of Adapt It's dialogs. If you ever want Adapt It to use a backup file because the normal one of the same name has become corrupted, then just edit the .bak extension so as to become .xml and then Adapt It will recognise the document and allow you to open it. The check box at the bottom of the dialog allows you to specify whether Adapt It should copy what it puts in the phrase box from the adaptation or gloss lines, depending on what seems most appropriate for the program mode  you are using (see: more explanation below the dialog illustration).
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The tab also contains four pairs of text boxes, where the current project's Source Language Name,, Source Language Code, Target Language Name, Target Language Code, Gloss Language Name, Gloss Language Code, Free Translation Language Name, and Free Translation Language Code are displayed. The source and target names are stored in the knowledge base, and are reflected in the configuration files. If one or both names should become corrupted, retyping the correct names in these text boxes will fix the problem. (It is not sufficient to correct the names in the configuration files). 

The Source Language Code, Target Language Code, Gloss Language Code, and Free Translation Language codes are optional but recommended. They are required for LIFT exports of KB data. 

(A version of Adapt It later than 6.6.0 will support sharing knowledge base information between two or more machines where the users are working within the same project, and that project is 'connected' to a remote server that supports such sharing. When this feature is implemented, using language codes will become mandatory, because the remote server will only know what knowledge base to store entries in by use of these codes). 

If you do not know the codes you may look them up using the “Lookup Codes” button which shows this 
sub-dialog:
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You can type either a language name or a code in the appropriate “Search for” box, then press the “Find” button to search the list. You can use the longer buttons to enter the code from the highlighted item in the list into the appropriate edit boxes at the top of the dialog corresponding to the languages used in your Adapt It project. 

Back in the “Define KB and Miscellaneous Options” dialog there are two radio buttons related to “Set Order of Adaptations and Glosses for Vertical Editing Steps”. These buttons determine the order in which Adapt It updates documents after source text editing is done (when a document contains both glosses and adaptations). The default is to do adaptations updating before glosses updating.

There are two radio buttons within the box labelled with the instruction: “Choose the top option to support copy of source text zero width spaces into the adaptation”. These two settings have to do with Adapt It’s support of languages that require zero width space (ZWSP) support.  Detailed information concerning ZWSP support can be found elsewhere in this document by searching for the phrase ZWSP Support.

View tab
This tab allows you to control the appearance of the view of the document in the main window. The tab looks like this:
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You can adjust the amount of white space between strips with the "Vertical gap between multi-line text strips" edit box. If you make it too small, the navigation text may come too close to the strip, too large and you will not see many strips on the screen at once, so a value of around 24-32 is a happy compromise if your text size is 12 points. On some computers with 200 dpi screens (like the OLPC XO) you should increase this value to about 50 or 60 to prevent the inflated text from overlapping.

The "Width of the inter-pile gap" edit box allows you to control how much white space there is between each document storage element's display. Recall that each document storage element is displayed in a single pile. The gap between these piles can be set to any value between 6 and 40. Too small a value makes it hard for you to see which piles store a source text phrase, and which store just a single source text word.

The third edit box controls how close the text of the first pile in each strip comes to the left boundary of the view's window.

The next edit box controls the minimum width that a pile will occupy.

The "Phrase Box white space slop and expansion multiplier" edit box lets you control the initial size of the phrase box when it is created at a new location (higher values of the multiplier number in the box give you more white space at the right hand end of the box), and the amount by which the box is expanded when your typing starts to get close to the right hand size - (again, higher values give you a bigger expansion of the box).

If you are using a keyboard manager application such as Keyman in order to have multiple key presses interpreted as special characters in the target language font, it can happen that the keyboard manager will not interpret your key presses correctly if between two successive key presses the Phrase Box is resized larger. This would be very annoying if you can do nothing about it. Fortunately the problem can be fixed. If you increase the multiplier value in the edit box to be much larger - for example, if the value is currently 8, try a value of 12 or 15; then the problem with uninterrupted key presses should disappear because you will be able to type much more before Adapt It will want to expand the Phrase Box. You might need to experiment a little until you get a multiplier value that suits your requirements without the box becoming overly large. You will only need to do this once, because this value is saved in the basic configuration file written out when you exit the application.

Incidentally, phrase box expansion takes place when your typing gets to within about 3 character widths of the right hand edge of the phrase box.  (A character width is based on the size of the 'w' character in the target language's font and at the current point size.) You cannot change this value while the application is running. However, the value is also stored in the basic configuration file. If you are having trouble with characters not being entered in the phrase box, or the cursor is not where it should be, then probably this value needs to be increased to about 5 or 6. You can do that by opening the basic configuration file (AI-BasicConfiguration.aic) in your plain text editor (Notepad, gedit, etc.), and change the "TooNearEndMultiplier" value from 3 to your new value. Your new value will be used from then on - or until you change it again. It is not a good idea to use a value greater than 6 - you would make too much white space at the end of the phrase box be unusable for typing.

The "Font size for dialogs" edit box allows you to set the size of the vernacular text (source and / or target) which is shown in dialogs – in edit boxes and in list controls. The allowed sizes are from 10 points up to 24 points, but because some edit boxes are restricted to a maximum of 22 points vertically, it is recommended that you use point sizes of 20 or less. The default size is 12 points. Your setting will be saved in the project's configuration file, and will therefore be used whenever you enter the same project. You can change the setting at any time, while in the same project. The ability to change the font size in dialogs was added for version 2.4.0, because some fonts (eg. Arabic) are too small to be read comfortably at 12 point size.

You can suppress, or enable, the showing of the "Welcome to Adapt It" splash window when Adapt It is launched. Use the Make the Welcome window visible on startup checkbox to suppress or enable that welcome screen.

Highlighting
The “Highlight automatically inserted translations” checkbox controls highlighting, i.e. changing the background colour of automatically inserted adaptations or glosses. Highlighting is turned on by default, and the default colour is a light purple. You can turn this feature off by clicking the checkbox. Work is easier to do if highlighting is left turn on. You can change the background colour used for the highlighting by clicking the Choose Highlight Color… button. You will see a standard colour palette dialog which will enable you to set a suitable colour very precisely. You colour settings are stored in the basic configuration file, and so are restored each time you launch the application.

Show Administrator Menu (Password protected) 

Version 5.2.0 and later of Adapt It has a hidden password protected Administrator menu. The menu can be made visible by checking the checkbox labelled “View Administrator Menu… (Password protected)” here in the View tab of the Preferences dialog. The Administrator menu can also be made visible from an item of the same name on the top-level View menu. When selected, Adapt It will ask you for a password, as shown below.
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When you enter the password and click OK, an Administrator menu will appear on the program’s main menu. The Administrator menu supports extra capabilities of interest to the administrator of a number of computers running Adapt It on a LAN, setting up collaboration with Paratext or Bibledit, setting up a work folder in a custom location, locking or unlocking the custom work folder location, restoring the default work folder location, setting a password, moving data to or from the accessed custom work folders (e.g. for archiving in a version control repository, etc.). See the Help for Administrators document for more information on setting passwords.

Options for Scroll Into View
The scroll-into-view feature now can work in one of two ways. The default setting is the second option, which keeps strips stationary vertically, while the phrase box moves rightwards and downwards, until it nears the window bottom – at which time an automatic scroll happens and it starts out afresh near the top of the window. The alternative keeps the phrase box about 2/3 down the window and when the phrase box moves from one strip to the next, it is the strips which scroll - keeping the phrase box at approximately the same vertical distance down. Your choice is saved automatically in the project configuration file and so is restored whenever you re-enter that project.

The next two check boxes and their related slider control, have to do with the handling of zero width space support that is needed in some east Asian languages. Search in this document for the phrase ZWSP Support for more detailed information about these settings.

The next checkbox says: “Copy the default phrase box contents from adaptation or gloss, depending on the mode”. This checkbox tells Adapt It whether to use adaptations or glosses when copying information into the phrase box. It works as follows. When turned off, copies are taken from the source text as was always the case in legacy versions of Adapt It. This is still default setting. However, when turned on, the rules for the copy are as stated in (1) and (2) below - that is, when you switch from adapting to glossing mode, or glossing mode to adapting mode, either rule (1) or rule (2) will apply.

(1) After you have changed to adapting mode, if the phrase box lands at an empty location, the gloss at that location is copied to the phrase box; however if there is no gloss available, then the source text word is copied instead.

(2) After you have changed to glossing mode, if the phrase box lands at an empty location, the adaptation at that location is copied to the phrase box; however if there is no adaptation available, then the source text word is copied instead.

The project configuration file remembers whatever setting you have for the checkbox, so it will be restored when you next enter the same project.

The last check box on this tab page says: “Reduce “blinking” effect when doing automatic insertions”. This checkbox can be used to reduce screen flicker when Adapt It is automatically inserting many adaptations at one time in the target text. Ticking this check box causes Adapt It to freeze the screen during the time it is inserting the adaptations automatically, and then unfreeze the screen again when it has finished inserting them.

Auto-Saving tab
This tab allows you to turn on, or off, the automatic saving of the document, and the knowledge base. The tab looks like this:
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When auto-saving is turned ON, you have the option of specifying whether document saving should be based on elapsed time, or on how many times the phrase box moves to a new active location when you hit the ENTER key as you work. If you do a lot of thinking as you adapt, it would be best to use the "moves of the Phrase Box" setting. If you work quickly so that the phrase box is moving often, it might be better to use a time setting – such as 5 minutes. The time setting for documents can be as low as 1 minute, or as high as 30 minutes. The 'moves' setting can vary between 10 and 1000.

You can also independently have the knowledge base saved every so many minutes. Since the knowledge base is automatically saved every time the document is saved, the knowledge base time setting will have no effect if it is larger than the document time setting. The range of permissible values is 2 to 60 minutes.

When auto-saving is turned OFF, then saving is done only when you manually initiate a save using the File … Save command, or the File … Save Knowledge Base command, or when you are asked if you wish to save when you close the document. You can do a manual save anytime using the commands on the File menu, and it will be immediately done, whether you have auto-saving turned on or off.

Units tab
The Units tab of the Preferences dialog looks like this:
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Note: In the Windows version of the cross-platform (WX) program, only metric units are available in the page setup dialog, even though you might choose “Inches” in this Preferences tab page. This is a known limitation.

USFM and Filtering tab
Two Standard Format Marker Sets Supported
Adapt It supports the UBS USFM standard. The current version of this standard is 3.0. Support for this standard is provided by an external XML control file called AI_USFM.xml. As this standard evolves, that file will be updated to incorporate the new markers and styles.
Adapt It also supports the SILPNG 1998 marker set (about three dozen markers). Only one marker set, however, should be in effect at any one time. The default is to use the USFM marker set, and attempting to use the outdated SILPNG 1998 marker set is discouraged. 
Adapt It also supports a third setting which allows you to use both of the above sets at the one time. This could be an unhelpful option to use because there are some marker conflicts between the two marker sets - and one conflict in particular is quite unhelpful, namely, the \fe marker. In the PNG 1998 marker set, it means "end a footnote", but in the USFM marker set it means "open an endnote". This particular inconsistency can cause confusion to Adapt It's handling of footnotes. Marker conflicts are automatically resolved by assuming the USFM marker definition is the one wanted, but if the document is using it to mark the end of a footnote, then Adapt It's internal data structures will get messed up a bit at that point. (It doesn't fail, but it doesn't behave quite like you would expect either.)
Why do we allow Adapt It to support both sets at once, but advise you not to use this option? We have included it for the few cases where someone may have partially converted a document in the older PNG 1998 standard to USFM, and used the partially converted source text to create a document. Accepting both sets at once in such a circumstance gives a cleaner appearance for the document than using either set alone. HOWEVER, if the source text has footnotes and/or endnotes, before using the data to create an Adapt It document you should ensure that all instances of footnotes and endnotes are marked correctly according to the USFM standard alone.
Setting which SF marker set is to be in force is done by the USFM and Filtering wizard page, which is available either when creating a new project, or at any other time from the Preferences... command on the Edit menu. The USFM and Filtering tab page in Preferences looks like this:
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The marker set for the project defaults, for a new project, to the factory setting which is to use the USFM set. 
If you open version 3 of Adapt It on legacy documents, it will assume that the PNG 1998 set is wanted. Regardless of what set Adapt It thinks should be used, you can override the suggested setting manually, by clicking the button for your choice in the This Document's Settings group.
If you want the project setting to be a different one that what is suggested, you can also change the setting in the Project Defaults group. When working with documents newly created, it is best to have both the project setting and the document setting be the same. Each different setting has certain implications. For example, which markers would be regarded as unknown markers will depend on the set you choose. An \fr marker is unknown to the PNG 1998 set, but is known to the USFM set as one of the markers involved in footnotes. The appearance of the document on the screen will therefore depend a lot on which set you choose. Unknown markers are shown in the navigation text area, with a question marker before and after, so the display can look rather cluttered if you use the wrong set. Also, different marker sets have different defaults for which markers get filtered, which will also affect what you see on the screen.
It is perfectly safe, however, to experiment by making different choices and seeing how the document looks as a result. If in doubt about what is best, use the USFM set. Changing the set while a document is open will automatically cause the document to be rebuilt. This rebuild process is robust. It might take several seconds to do if the document is large.
The lower part of the page deals with Filtering settings. If you are going to change the marker set, you should always make your choice in the USFM page before you change any of the marker filtering settings in the lower part of the page. 
Filtering (Hiding) of Standard Format Marked Information
A very powerful feature of Adapt It is the ability to filter (or hide) certain standard format markers from the adaptation process. Filtering a marker has the effect of hiding it and whatever text content follows it (and any end marker if there is one) from the user's view. Filtered material remains in the document, its marker and following information content is not deleted, nor lost. Instead, it is stored with the document storage element which is located immediately following the filtered information. Several different markers and their information content can be filtered (hidden) at the same place - there is no limit to how many markers can be hidden at the one location, nor how large their contents can be.
Whenever information is filtered, a wedge (usually a green colour) will appear at the top left of the source word or phrase which occurs at that location. The wedge may have other colours in certain circumstances (see below). Each wedge is a button which gives you access to the filtered information stored there.
The lower part of the USFM and Filtering page, it is divided into two sections, one for the document setting, and one for the project setting. Normally you should keep the document setting the same as the project setting, but if you temporarily want to change the document setting, you do it in the top list. You can do so as often as you like, but each time you change the settings and then click the OK button a document rebuild will be automatically done so that your new filtering or un-filtering choices are put into effect.
In both the PNG 1998 marker set, and the USFM marker set, each marker can have one of three properties. It can be designated as 'never to be filtered' (for example, a \v marker); or 'always to be filtered' (for example \r for a parallel section reference); or available for filtering or un-filtering at the user's discretion. Markers in the last category are shown in the list boxes of the lower part of the USFM and Filtering page. Notice that the default for footnotes in the USFM marker set is that Adapt It will not filter them. That means you will see the footnotes in the main window and their text will be laid out ready for adapting. If you don't want to deal with footnotes while adapting the inspired text, you would scroll to the \f entry as shown above, and click the check box next to the marker to indicate that it is to be filtered out. When you click OK to return to the main window, Adapt It will rebuild the document and the footnotes will have disappeared, and their hidden presence will be indicated by a green wedge at the first word in the text which formerly followed the end of the footnote. When you are ready to adapt the text in all the footnotes, you can come back to the USFM and Filtering page and reverse the procedure - the click the check box again to remove the tick mark, and when you click it and click OK, the document will be rebuilt again and the footnotes will reappear embedded in the inspired text at their proper locations. Then you can do the adapting of all of them at the one time.
The marker sets are defined in the AI_USFM.xml external control file. You should not edit that file yourself - doing so would change how Adapt It handles markers and such changes probably would be detrimental.
One nice property of filtering support in Adapt It is that unknown markers are all designated as available for the user to either filter, or un-filter. This can be very convenient. For example, one user uses a \chk marker (which is unknown to both the PNG 1998 set and the USFM set) to embed consultant questions in the source text used for creating a document. By using this Filtering page to nominate this particular marker as to be filtered, the consultant question is removed from the adaptation process, but can be viewed at any time by clicking the green wedge button which shows its location. (Incidentally, Adapt It permits such filtered information to be propagated from one adaptation project to another.)
Adapt It keeps track of all unknown markers and their names, and stores that information in the document when it is saved. This gives advanced users some creative options for including ancillary information within Adapt It documents, the information being hidden away but accessible on demand and fully editable as well. We do not recommend using unknown markers though, but if you do then you are assured they will be handled in sensible and flexible ways.
Adapt It knows about three special markers. \note and its end marker \note*, \free and its end marker \free*, and \bt. These are markers for Adapt It notes, free translations and back translations, respectively. These are always filtered, and Adapt It has special user-interface features for working with them. They are, however, unknown markers to the PNG 1998 and USFM marker sets; but nevertheless definitions for them are included in AI_USFM.xml. A fuller discussion of these markers and how Adapt It uses them occurs in the sections below. Each of these markers has one major difference from all other markers. Adapt It is able to create these markers internally whenever needed and store them, and the information they contain, in particularly helpful ways in both documents and exported text.
The \bt marker needs special mention. It is the only back translation marker that Adapt It can create itself. However, Adapt It can work successfully with a set of longer back translation markers each of which starts with the three characters \bt. For instance, you might designate \btv, \bts, \btq1, \btq2, and whatever others you like as back translation markers for verses, subheadings, poetry with level 1 indent, poetry with level 2 indent, and so forth. If you do this, you are responsible to manually type those markers into the source text file to be used for creating an Adapt It document before the actual document is created. You should include any such marker before the known marker to which it corresponds (it is permissible for other different markers to occur between them). So \btv should be before the associated \v marker, \bts before its associated \s marker, and so forth. You might do this if you wanted to include back translation information into a source text file before using it in Adapt It. While Adapt It cannot create any of these markers for you, it will automatically handle them all as back translation markers if it finds them in the Adapt It document. There is no limit to how many such markers you define, so long as the first three characters of each are \bt.
We mentioned above that each wedge icon in the Adapt It document layout is a button. This issue is discussed next.
Viewing and Editing Filtered Information
Whenever information is filtered, that is, hidden from the user's sight, it remains accessible to the user. All he need do is click a green (or blue, or khaki, or red) wedge icon in the main window at whatever point in the document he is interested to find out what is hidden away there.
The colour coding has the following meanings: 

	red
	both a \free marker and a \bt marker are filtered there, but neither has any content

	blue
	a \bt marker is filtered there, but it has no content

	khaki
	a \free marker is filtered there, but it has no content

	green
	markers are filtered there, and if \bt or \free are among them then each of the latter has content


Clicking a wedge icon opens a View Filtered Material dialog such as in the pictures below. If there are several markers filtered at that location, the list at the left will show their markers, and any which have an end marker will show the end marker in the list at the right. The central multi-line edit box displays the content of whichever marker is selected. Which wedge you clicked to make the dialog open is indicated by Adapt It automatically temporarily colouring the source text word or phrase in light yellow. The background highlighting remains while the dialog is open. The dialog is not modal, so you can do things in the main window while the dialog is open if you need to. When the dialog opens it tries to keep itself away from the location at which you clicked, so you don't get the context at that location obscured. You can move it by clicking on its title bar and dragging it to a different location.
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The text in the middle box is editable. If you edit it, the OK button will change its name to Save Changes. The picture shows that a free translation is defined at the clicked wedge's location. (Incidentally, this is not the only way you can view the free translation and/or edit it - see later sections.)
In the case of the two markers \free, or \bt (or any marker of form \btxxxxx where xxxx represents one or more non-space characters) the dialog displays an extra button which has the name Remove Free Translation, or Remove Back Translation, respectively. If you click on any other marker in the Marker list, that button will disappear. The button allows you to remove the marker, and its content, from the document at that location only. (If you want to remove all the document's free translations, or all its back translations, with one click, there are commands on the Advanced menu which do that.)
The Adapt It Unicode application has an extra button immediately above the OK button, it is called Switch Encoding. The Unicode application supports up to three different encodings (although usually two of the three, or all three, are the same). Source text, target text and navigation text can potentially each have its own unique encoding, and text directionality. When the View Filtered Material dialog displays filtered information in the box, it defaults to displaying it with the navigation text's encoding and directionality. This might not be what you require. Clicking the Switch Encoding button more than once will therefore cycle you through each of the three possible encodings, with their associated directionality in reading order (that is, either left-to-right or right-to-left) in turn. Hopefully one of the renderings will give you readable text. If clicking appears to have no effect, it is because two or three of the encodings are identical. You can change the encoding and directionality settings in the Fonts pane of the Preferences... dialog.
The settings you make in all of these tabs of the Preferences property sheet described above are saved in the configuration files when you exit the application or exit the current project, and restored automatically when you next launch the application, or open a different project. Some of them are also saved on a document, such as your colour settings – so each document can have its own unique colour settings if you wish.

Continuing with descriptions of the main menu items:

View Menu

Toolbar
Toggles showing or hiding of the toolbar. Normally you should always have Adapt It's toolbar showing, because the buttons on the toolbar do not have synonymous menu commands, so the toolbar is the only place to access those commands. However, if screen space is at a minimum you may want to hide the toolbar. The toggled setting is remembered from session to session.

Status bar
Toggles showing or hiding of the status bar at the bottom of the main window. This narrow strip at the bottom of the main window can also be hidden to make more screen space for viewing the adaptation work. The toggled setting is remembered from session to session.

Compose bar
Toggles showing or hiding of the Compose bar immediately below the mode checkboxes at the top of the window. The compose bar was pictured earlier, in the section titled Understanding The Adapt It Interface
Mode bar 

Toggles showing or hiding of the Mode bar (the bar with the Drafting and Reviewing radio buttons on it). This bar can also be hidden to allow more screen space to be visible on small screens. The toggled setting is remembered from session to session.

Copy Source

When Copy Source is shown checked, Adapt It will copy the source text word (or phrase) if it cannot find a suitable translation for the contents of the phrase box. Then it will wait for you to edit the text, or if it is acceptable without any further editing on your part, you need only press the ENTER key to cause Adapt It to move on to the next active location. Note: The action of this menu item can be altered by a check box setting at the bottom of the “Backups and Misc” tab of the Preferences dialog (see above).

(If you are using consistent changes, the copy of the source text is first run through the consistent changes table, or tables if you are using more than one, before it is put in the phrase box. This will be discussed later in the section on Using Consistent Changes.) 

If you turn off the Copy Source command (by clicking it,) then Adapt It will just leave the phrase box empty if it cannot find a suitable translation. (And if you are using consistent changes, no consistent changes would be done.)


Select Copied Source
The default is for this menu item to be unchecked (off). When Select Copied Source is shown checked, Adapt It will automatically select the copied source text within the phrase box when the box lands at a location. This option can make it easier to type an entirely new translation since the first key typed removed the selected text. That behaviour might be best if you often need to replace the copied source text to an entirely different word or phrase in the phrase box. If however, most of your phrase box editing requires simply adding suffixes to a word, it is more helpful to not have this menu feature checked, so that the insertion point remains at the end of the copied text.

Wrap At Standard Format Markers
This command toggles wrapping of strips at the presence of certain standard format markers. This is the default setting. When this option is chosen, a new strip is started when Adapt It encounters certain standard format markers in the source text. The previous strip will be therefore shorter than normal. A new strip is started when the application encounters a paragraph marker, start at margin marker, section header, or one of several other markers.

If you turn this option off by clicking this menu item so that the checkmark disappears, then the display will change.  Adapt It will fill each strip with as many document storage elements as can be fitted in. The only way you will be able to tell that the text type has changed is by the colour of the text, and by the navigation text above the strip which will state the name of each standard format marker encountered in the source.

Units Of Measurement…
This command allows you to choose between centimetres and inches for the margin and page measurements shown in print dialogs. It is only relevant to printing. 

Change Interface Language…
Earlier legacy versions (3.6.4 and earlier) required the preparation of separate Adapt It applications to have a different interface language. With version 4.0.x, however, Adapt It provides a more flexible means of changing the interface language of the application itself – without having to download and install a separate application for each localization.

When Adapt It WX is first run (and at any later time accessible from the View menu) the following dialog appears:
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English is the default choice. You may choose any choice that exists in the list. Be sure to choose a language that you understand, otherwise you may find it difficult to use the program in an unknown language! After making your choice of interface language, click on the OK button. Adapt It will present you with the following notice:
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Quit Adapt It and restart the program. When the program runs all parts of the interface that have been “localized” will appear in the language you chose. Currently, user interface localizations are available for English (default), Spanish, French, Indonesian, Portuguese, Russian, Azeri, PNG Tok Pisin, Swahili, and Mandarin Chinese. Sometimes it is the case that some localized text strings have not been tested or verified by native speakers. For some languages, parts of the interface have not yet been localized so they are incomplete. Wherever localizations are still incomplete, those parts of the interface will still appear in the default English language. If you ever happen to change the interface to a language which is totally unfamiliar to you (such as Chinese, for example), and you wonder how to get an interface language back that you recognize, just close Adapt It by clicking on the X in the upper right corner of the application window; then hold down the ALT key while restarting Adapt It. This will force the Choose Interface Language dialog to be shown before the program appears, and you can change the interface language back to something intelligible. See the Localization_Readme.txt file for more information.

Show Administrator Menu (Password protected) 

Version 5.2.0 and later of Adapt It has a hidden password protected Administrator menu. The menu can be made visible by selecting the “View Administrator Menu… (Password protected)” menu item from the View menu. The Administrator menu can also be made visible by checking a checkbox on the View tab page of the Preferences dialog. When selected, Adapt It will ask you for a password, as shown below.
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When you enter the password and click OK, an Administrator menu will appear on the program’s main menu. The Administrator menu supports extra capabilities of interest to the administrator of a number of computers running Adapt It on a LAN, setting up collaboration with Paratext or Bibledit, setting up a work folder in a custom location, locking or unlocking the custom work folder location, restoring the default work folder location, setting a password, moving data to or from the accessed custom work folders (e.g. for archiving in a version control repository, etc.). See the Help_for_Administrators.htm  document for more information on the menu items on the Administrator menu and on the setting of passwords.

Tools Menu

Find
This command allows you to search for text in either the source, the translated text, or both at the same time. The dialog has the following appearance when you first see it:
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There are blank spaces in the dialog because some items are hidden, and only become visible if you click certain radio buttons.

There is an important difference between the operation of "Finding" text in a normal word processor application, and "Finding" text in Adapt It. In a word processor application, the text is in the form of a continuous stream of words separated by spaces and punctuation. In an Adapt It document, there is no continuous stream of text; it has all been cut up into discrete pieces – either into single words, or into short phrases, or into a retranslation, and each discrete piece is stored on its own document storage element. The spaces which normally would occur between words have been removed (except within phrases). Because of this difference, if you want Adapt It to search across the boundaries between neighbouring storage elements (i.e. spanning neighbouring piles), you have to explicitly tell it to do so. The checkbox "Allow the search to occur in text spanning multiple piles" is what you must click to get this kind of search. If this checkbox is left off, the search is confined to text in a single storage element.

Known Limitation: Adapt It only Finds the first of multiple possible matching substrings in a word. This, eventually, will be rectified.

You can have target text punctuation included in the search by using the "Search, retaining target text's punctuation" checkbox. If you leave the box unchecked, it will search text that has had the punctuation stripped off it.

By default, the dialog assumes you want to search in the source text, so the leftmost radio button at the top is on. You can type your search text in the top left edit box, the only one visible. The search will be case-sensitive, but you can stipulate a case-less search by clicking the Ignore Case checkbox on the right.

When you click the Find Next button, the search commences – starting from the first pile immediately following the current active location. If the search text is matched, the document is scrolled to show the match. It is shown selected, and the dialog box will be placed either at the top or bottom of the screen – whichever allows the selection to be clearly visible. If you don't like the dialog box jumping around, shorten the main window by dragging the bottom boundary up a couple of inches, and then the dialog box will stay at the bottom of the screen on subsequent matches.

If you click the Translated Text Only radio button, the searching is done in the target text. If matched, the text is selected, the selection scrolled into view, and the dialog moved out of the way if necessary.
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If you click the Both Source Text and Translated Text radio button, then you will see two edit boxes as shown above.
The contents of both edit boxes have to be matched, for the search to succeed. Actually it is more complex than that. The source text is searched first, and if a match is made, the number of storage elements involved and their locations is noted. For the above simple word, only one storage element could be involved. But if the search text is a long phrase, and the Allow the search to occur in text spanning multiple piles checkbox is on, the matching text might span several storage elements (i.e. several piles). Or if the match is made within a retranslation, then the whole retranslation is considered to be matched. Then Adapt It tries to match the contents of the second edit box in the target text which lies within however many storage elements were considered to be involved in the match of the source text. If a match is made and it is contained by the storage elements already matched, then the whole match succeeds. If part or all of the match lies outside the storage elements already matched, the match is deemed to have failed, and Adapt It moves on to look for a possible match further along in the document.

Finally, if you click the Special Search button, then the three radio buttons at the bottom left become active, and a combo box for choosing a standard format marker becomes visible. At the same time, items at the top of the dialog which are no longer valid are hidden. The dialog would look like the following – in this picture the combo box has been clicked to show the list of standard format markers:

[image: image84.png]N M N ¥4 CapterDescroton Pubishng ooten D, ..
an, yupela i Win £ S ST RIS,
is is  something entimiEtiTer re

tok long yupela. e —
tome to you. B e




If you choose the Standard Format Marker radio button, the combo box to the immediate right will become enabled, and you can then select which particular marker you want Adapt It to search for. The document will be scrolled and the storage element which contains the standard format marker will be shown selected. (Note: there are other standard format markers which may occur in standard-format-marked text files, which do not appear in the above list. Adapt It will still strip them out when parsing input source text, and replace them silently when building an exported document file, but with such rare markers you will not have the option of searching for them. Only the ones which you are likely to find in the body text, rather than introductions, glossaries, etc. are included in the above list.)

If you choose the Placeholder radio button, Adapt It will search for the next placeholder which is not part of a retranslation. It will be shown selected if found, and the document scrolled to that point.

If you choose the Retranslation radio button, Adapt It will search for the next retranslation, selecting the whole of it if it finds one.

Cancel button
Click this button when you have finished with the dialog. If there is a selection current, then the selection will be retained (but the selected cell in the pile will become the top one, if some other cell was selected in that pile), and the phrase box will be placed at that pile, making it the new active location.

If there was no selection when you cancelled, then the phrase box will be placed at the location of the last successful match, or if there was none, where it originally was.

If you click on the main window anywhere, instead of using the Cancel button, then the effect is just as if you clicked the Cancel button except that the dialog and its current settings remains open, but is hidden. Choosing the Tools … Find… command again will show the dialog with the earlier settings still intact.

Find and Replace…
This command puts up a dialog similar to the Find… dialog, except that it has an extra edit box for you to type the replacement text, and the items related to special searches are hidden. When you first see the dialog, the Translated Text Only radio button is selected, and so the Source text edit box at the top left is hidden. It is not possible to use the Replace functions when matching just source text, since source text cannot be changed. Hence the Source Text Only button remains disabled. To search for a match in both source and target text together, as explained above in the discussion of the Find… dialog, is possible. When the Both Source Text and Translated Text radio button is selected, both edit boxes for the source search text and the target search text are displayed, giving the following appearance:
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For an explanation of the two checkboxes "Search, retaining target text's punctuation", and "Allow the search to occur in text spanning multiple piles", see the discussion of the Find… command.

The Find Next button works the same as in the Find… dialog.

The Replace button will replace whatever target text was matched, with the text you typed in the Replacement Text edit box at the lower left, and then pause for you to inspect the results. Then you can click on Find Next again to find the next occurrence matching text for you, and click on Replace again if appropriate. The replacement is "smart", in that it recognizes the kind of match that has been made. For example: if the matched target text spans two or more piles (so that those piles are selected), then Adapt It assumes that you wish the matched piles to be merged into a single pile containing a source phrase. It does the merge, and then replaces the matched text with the replacement text. Or, if the match was made in a retranslation then since a retranslation must be treated as a whole, the dialog for editing a retranslation is put up, and the target text is shown in the dialog with the replacement done. You can then do any additional editing of the retranslation, and when you click OK you will be back in the Find and Replace dialog ready for your next Find Next, or whatever else you wish to do.

The Replace All button does a series of Find Next and Replace operations, until no more matches of the search text can be made. Like the Replace button, if a match spans several piles, a merge is done first; and if a match is made within a retranslation, the dialog for editing the retranslation is put up, and you must finish that dialog with the OK button before the Replace All operation will resume.

The remainder of the items in the Find and Replace dialog are the same as for the Find… dialog, so refer to a discussion to the latter if you need further details.

Adapt Clipboard Text
The “clipboard adapt” feature permits you, whether a document is open or not, to quickly adapt the source text which you have loaded into the clipboard from some other place – such as from a literacy book. 

Of course, the Adapt It project you are in when you use this feature should be the one which has the correct source and target languages set up for adapting. The reason is because when you do the adapting,  the adaptations will be entered into the current project's knowledge base. It is up to you to ensure that the project you use this feature in is the correct one for the two languages involved in the translating work.

You do not have to have a document open in order to use this feature, but you do have to be in a suitable project. You can use this feature repeatedly with an empty window; in fact, that's the quickest way to use it.

When you click the command Adapt Clipboard Text, Adapt It does the following things:

· If a document is currently open in the main window, it is saved to an internal cache and the window cleared. Clipboard Adapt mode is turned on, and remains on until you click the Close button mentioned further below.

· The title of the main window becomes “Clipboard”, and the status bar text at the bottom of the window shows, at its end, “Clipboard Text” instead of a folder name. (Note the project is not changed, you are still using the same project, with its knowledge base, which were in operation before you clicked Adapt Clipboard Text.)

· An extra toolbar shows at the bottom of any existing toolbars at the top of the main window (see the picture below).

· The text in the clipboard is loaded into the window as source text, ready for adapting (and ready for free translating too if you wish to also do that).

At this point you would adapt the text. Any new adaptations not in the knowledge base are automatically added to the knowledge base. Automatic insertions into the document happen in the normal way, if the knowledge base has appropriate entries already in it. Additions to the knowledge base are permanently kept – so adapting will populate your knowledge base with new entries each time you use this mode.

To add a free translation as well, put the phrasebox at the start of the source text, then do Advanced > Free Translation Mode, and free translate what you adapted. Then you can send the adaptation to the clipboard, by clicking the Adaptations button – it will send just the adaptations, whether or not free translation mode is on. To send the free translation to the clipboard, click the Free Translations button – it will be sent even if free translation mode is currently turned off. 

The Free Translations button will be disabled if you have not typed any free translation. Of course, the clipboard can handle only one kind of text at a time, so whichever button you use, whatever was previously in the clipboard will be erased before the clipboard accepts your new adaptation, or free translation, text.

It is not possible to Save the adaptation or free translation when in this mode. If the clipboard is empty, or contains only spaces or tabs or newlines, this mode will regard the clipboard as empty and you will see a message saying there is nothing to do, and the earlier state of the application will be restored.

When you have sent to the clipboard whatever you wish, then click the Close button. The Close button does the following things:

· It turns off Clipboard Adapt mode

· The main window is cleared.

· If a document was in the main window, it is restored from the internal cache exactly as it was before you clicked the Adapt Clipboard Text command. If there was no document in the main window earlier, the main window is left blank.

· The earlier window title, and status bar text are restored.

· The text last copied to the clipboard remains there, and can be pasted into one or more locations as you see fit.

When is it helpful to use this feature?

a) When you want to translate small chunks of source language test, and paste the translations in some other software application.

b) When you want to translate a document (such as a primer) which does not have verses or chapters in it.

c) When a document is a mix of pictures and text, and you want to be able to quickly translate just the text.

The workflow goes like this. Open the document you want to translate in the “other” software. Launch Adapt It  and enter the appropriate project. If there is no suitable project, create one using the Start Working... command, and in the Projects page click the <New Project> item, etc. Position the Adapt It and “other” software's windows at helpful places on your screen. Then in the “other” software select the text to adapt, and do Edit > Copy to get it into the clipboard. Leave it selected in the “other” software while you switch to the Adapt It window (or click on it), then do Tools > Adapt Clipboard Text. The text will be loaded into the Adapt It window. Translate the loaded text, click the Adaptations button to load the adaptation back into the clipboard; switch back to the “other” software's window, and do Edit > Paste (or CTRL+V) – and the still selected text will be replaced by your translated text grabbed from the clipboard.

The picture below shows a topic primer open in LibreOffice Draw, with the source text selected at the bottom – that text was copied to the clipboard, then loaded into Adapt It using the Adapt Clipboard Text command, and the picture shows it almost all adapted. The Adapt It window is sitting on top of the Draw window, only to keep the picture small. Normally you would have these windows side by side, for convenience's sake.

The source text language in this example is Solomon Islands Pijin. The adaptations are in English. Therefore the project for this work is called “SI Pijin to English adaptations”  - which can be seen in the Adapt It status bar at the bottom of the main window.
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Load Consistent Changes…
Adapt It has the full-featured SIL consistent changes application incorporated within it. Adapt It allows you to specify from one to four consistent change tables, which will be used sequentially when Adapt It copies source text to make it the default target text - whenever an adaptation for the source text at the active location is not known.

You do not have to use consistent changes when you use Adapt It, if you do not want to. This functionality is, however, very powerful and highly useful if you have a lot of known changes which are regular – especially orthography changes; it can save you lots of time manually typing adaptations.

To define a consistent changes table file, there is a button for that purpose, called  Create CC Table… in the dialog which comes up when you give the above command. (See the picture below.) If you use that button, the application will ask you for a name for the new table's file; type the name in the dialog's edit box. Adapt It will give it a .cct filename extension. Adapt It will not recognize a file as a consistent change table unless its filename ends with a .cct extension. 

For those people unfamiliar with consistent change tables, you will not need to know the full capabilities. You can do many useful things with just the following information.

A consistent changes table is just a list commands, one command per line. The kinds of commands that novice users need to know about take the following form: 
'many'  >  'lots of'
The above command line would result in any instance of the word "many" being changed to the phrase "lots of". As you can see, on the left is an expression which is to be matched, it is enclosed by single quotes, but it could be enclosed by double quotes instead. Then follows a right wedge symbol (>), and then comes a replacement expression which will replace the matched text – and the replacement expression must be enclosed in either matching single quotes or matching double quotes (i.e. 'lots of'   or you could use  "lots of"  instead).

Word-Initial Changes  and  Word-Final Changes
Adapt It always temporarily places a space before and after a translation word, or translation phrase, just before the consistent changes are attempted. This allows you to set up your consistent change table beforehand so that it can do word-initial changes, or word-final changes, or both. You do that by explicitly including a space in the appropriate place on the text to be matched to the left of the wedge. For example: the following change would convert every word-initial "b" character to a word initial "w," but leave all other b characters unaffected:

" b" > " w"    
Notice that there is a space within the quotes; the following would also work  " b" > "w" (no space is needed on the right hand side.) The temporary spaces, if still present after your consistent changes to the translation text are finished, are stripped back off . This happens before you get to see the translation text in the phrase box in the main window. In fact, you can never get to see those temporarily placed spaces, but you can count on them being there when your consistent changes tables are actually being used on the data.

Comments In The Table
A c  character in a changes table is interpreted as a comment command. The consistent changes application will disregard everything else on the same line after the c character. This allows you to put documentation into your changes table for a human to read, to explain what the intention behind your changes is. For example, suppose you have source text in a dialect having l and r characters, but your target language is a dialect which only has the l character, so that all instances of r in the source text need to become l. But, loan words such has Kristos retain the r in the spelling. How would you do this in a changes table? The following lines would do it (I've included comments as well) – note that the order of the lines can be important, see the discussion immediately below.

c change every r to l, except in the loanword Kristos

'Kristos' > 'Kristos'

'r' > 'l'

The order of the last two lines is, in this instance, not important.  Longer changes are attempted before shorter ones, so the Kristos line will be attempted first, even if it followed the 'r' > 'l'' line. If order is important for two equal length lines, then put the line you want attempted first preceding the other one.

If the Kristos line were not present, then as the consistent changes processor worked through the text, it would come to the r character in an instance of Kristos in the document, and change it to an l, making the form  Klistos – which is not what you want to happen. Inserting the longer line 'Kristos' > 'Kristos' into the table makes Kristos in the document remain the same, and then the 'r' > 'l' consistent change will not affect it because the consistent change processor has already moved its working location past that instance of Kristos in the document. This is called "bleeding" – you "bleed out" those things which are not to be changed, by including in the table a longer consistent change which changes the thing you want retained to become identical to itself. That is, you have to match the thing not to be changed, and then change it to itself – that is why 'Kristos' is on the right hand side of the line. (Another way to change something to itself is to use the keyword   dup  on the right side of the wedge.)

Documentation for the consistent changes program is available from SIL, so this Adapt It documentation will not discuss change tables further.

When you choose the Load Consistent Changes… command, you will see the following dialog (the contents of the list box at the left will be empty, if there are no changes tables stored in the folder which is first shown):
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Your consistent changes file can be in any folder on any drive; the Browse To Find CC Table… button puts up a standard file input dialog in which you can navigate to the folder containing your consistent changes table file(s) and select one for opening. All the *.cct files in that folder will be listed in the list box of the dialog shown above, in alphabetical order, and the first in the list will be shown selected.

When you exit from one tab of the dialog, whatever changes table file is shown selected will be used by Adapt It. If you wish to open a tab but not have any table selected when you exit the tab, use the Select None button before exiting.

If you do not yet have a suitable consistent changes table defined, you can use the Create CC Table… button to create an empty one. Adapt It will then put up the following dialog:
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When you click OK, Adapt It will append the filename extension  .cct  to the  name you typed; create an empty file of that name, and immediately open the empty file as if you had just typed the Edit CC Table… button (see the picture below.) You can then type in the consistent changes you want to be used. When you click the OK button to leave the editor, you will return to the original dialog and see the table file you were just working on selected in the list box. When you click OK to go back to the main window, your consistent changes will be in effect. You can use the Create CC Table… button as many times as you like, to create as many different cc tables as you like. However, Adapt It can only work with a maximum of four tables, one after another, at any one time.

The Edit CC Table… button opens an editor window showing whatever consistent changes table file is currently selected in the current tab. Here is how it would look; this example is showing part of a consistent changes table file I use for doing certain spelling changes in a language called Gadsup, in Papua New Guinea.
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You can make additions to the table, even completely rewrite the whole table file; or edit the table. Then when you are done, click the OK button and the edited table will be saved to disk (with the same filename), so that your earlier version of the file will be lost. If you click the Cancel button, your file on disk will not be updated, and your editing changes will be thrown away.

If you make syntax mistakes when you edit the file, Adapt It will put up an error message which will show you where in the table the error occurred, including a message to describe the kind of error you made. You can then reopen the editor and attempt to fix the error. This might happen more than once, until all the errors have been edited out of the file.

When Adapt It uses you table, or tables – if you are using more than one, they are used in the order:

Table 1 is tried before Table 2. If there is no Table 1, Adapt It will go on to use Table 2 if it exists.

Table 2 is tried before Table 3. If there is no Table 2, Adapt It will go on to use Table 3 if it exists.

Table 3 is tried before Table 4. If there is no Table 3, Adapt It will go on to use Table 4 if it exists.

As you can see from these rules, if you only have one changes table to be used, you can select it in tab 1, tab 2, tab 3, or tab 4 – and no matter which tab it is in, Adapt It will use it. You don't have to put it in tab 1, though that is normally where you would put it. Nothing is gained by using higher number tabs if there is no table to be specified in them.

Finally, just because you have one or more consistent changes tables loaded, it does not mean that Adapt It will then use them. To cause them to be used, you also must turn ON the use of the consistent changes tables. To do this, you must make sure the Use Consistent Changes  menu command is ON. For your convenience, Adapt It will automatically turn ON this command (it will be shown ticked) when you exit the dialog using the Okay button. Then as you work, you can turn consistent changes on or off whenever you like, using this command.

Consistent changes, as mentioned before, are done when no adaptation is known for the storage element at the current active location, so that Adapt It copies the storage element's source text as the first guess at what the adaptation might be. When this copy is done, provided the Use Consistent Changes command is shown ticked, then the copied text is first passed through each consistent changes table you have loaded, in turn, starting from Table 1. This process happens when Adapt It copies a single source word to the phrase box, or when you are merging several source words which as yet do not have translations shown in the main window.

One other time when this process is invoked is when you cut from the Compose bars edit box and paste the cut text into the phrase box; the following message will be shown before the paste is done, so you will have the choice of having the changes applied, or skipped.
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Unload Consistent Changes
Choose this command if you want the changes tables unloaded. It is not important to do so, you can stop consistent changes being applied by merely turning off the Use Consistent Changes checkbox. It is not necessary to do the unload as well. Any loaded tables will be unloaded anyway, when the application is closed down.

Use Consistent Changes

The use of consistent changes is entirely optional, though it is a powerful feature for people who know how to make use of it. Adapt It does NOT use consistent changes for its normal operations. So if you do not know anything about consistent changes you can rest assured that you can achieve whatever you need to in your translation without having to make any use of this feature.

There is a command in the Tools menu called Load Consistent Changes… which allows you to define consistent change tables for Adapt It to use, to make whatever automatic changes you would like done. This is an advanced topic, so if you do not understand about consistent changes, you can ignore this topic. You don't have to use consistent changes in order to use Adapt It. However, knowing about how consistent changes work might save you a lot of typing work - especially if you are adapting from one dialect to another and there are regular spelling changes involved. The menu item will be discussed at length later on. The Use Consistent Changes menu command will not be enabled until you have at least one consistent changes table loaded.

The Use Consistent Changes command allows you to turn on, or off, the use of changes tables once you have the tables loaded using the Load Consistent Changes … command. When this mode is turned on, whenever Adapt It makes a copy of the source text to put it as the default adaptation text in the phrase box, it first does consistent changes on the copy of the source text. This, for example, is a great way to get any regular spelling changes done for you, without you having to type anything yourself; it's also a neat way to get affixes automatically respelled correctly in the target text.

If you do not have experience using consistent changes tables, you may need to get some help from a consultant, or another experienced person, to set up changes tables for your needs. The changes tables can be made in any program, such as Notepad. They should be saved as files of *.txt type, but change the .txt extension to a .cct extension after saving the file. If the tables do not have a .cct extension, Adapt It will not recognise them as consistent changes table files and they would not appear in the dialog which Adapt It puts up so that you can load them.

The changes are done typically on the copied source text belonging to a single storage element. If you want to involve several storage elements at once, you can make a selection and merge the storage elements into one - consistent changes will then be applied to each word involved in the merger. If you do the merger operation and want the changes tables to be applied  to each word during the merging process, do NOT type anything in the phrase box prior to causing the merger to happen! (However, you can click in the phrase box, or press the right or left arrow keys to remove the selection if you want the first word retained in the merger.) Adapt It will not run text through the tables, at the current active location, once you have typed something in the phrase box. So the best (and quickest)  way to do the operation is to use the ALT + Right Arrow key combination to make the selection and then use the ALT + ENTER key combination to make the merge happen (or CTRL+M, or click the Merge button on the toolbar). Then the individual words will be run through the changes tables before you see the resulting phrase presented to you in the phrase box.

Adapt It allows you to use up to four consistent changes tables at one time. They are used sequentially, table 1 is used first, then the output from that is sent to table 2, then the output of that is sent to table 3, and so forth. (If you want to use more than four tables at one time, there is a way to do it. See the "Consistent Changes" section of the Adapt It Quick Start.htm document.)

If you want to know the rules for consistent changes as they get applied to the active location, here they are. These rules apply only provided one or more tables are loaded, and the Use Consistent Changes menu command is on, i.e. ticked. 
(1) They are applied to a copy of the source text word in a pile which has no translation appearing there yet.
(2) They are applied after a manual selection of two or more source words and/or phrases, but only if a merger takes place (for whatever reason) and the words being merged have no translation as yet.
 
{For those of you who know about consistent changes, Adapt It supports the full functionality of the SIL consistent changes application. The full documentation for making consistent changes tables has been included in a folder called "CC Documentation" which is installed with Adapt It when the installer installs the application and documentation. On Windows installations, the installer also installs an executable standalone version of the CC program, the filename is CCW32.exe. You can create your own tables in a word processor, and test them with CCW32.exe, without having to launch Adapt It. A debugger for processing cc tables and observing what happens along the way is also available from the author. Unfortunately it was too large to include in the Adapt It installer file. It's size is 210 KB. The author can email it to you on request. It is also available from the JAARS software library.}


Accept Changes Without Stopping

This command puts Adapt It into a different mode. This mode only works when you have the following three modes turned ON: Automatic mode (the checkbox is on the toolbar), Copy Source mode (a command in the View menu), and Use Consistent Changes mode (a command in the Tools menu.). If those three modes are not set ON, then the Accept Changes Without Stopping command will be disabled.

When Accept Changes Without Stopping mode is turn on, Adapt It will do consistent changes as described above, but instead of having the phrase box halt and wait for you to do something or type something, Adapt It just accepts the text placed in the phrase box as the correct adaptation. It is then automatically entered into the knowledge base, and the phrase box jumps immediately to the next empty location. This process repeats over and over, until either you stop it, or the end of the file is reached. You can stop it by either choosing the Accept Changes Without Stopping command to turn it back off, or by clicking anywhere in the main window.

This mode is a great way to get automated changes done on a whole Bible book quickly, then you can go back to the start of the file and read through. Any time you see something that the consistent changes did not handle, just click to put the phrase box there and manually edit the text to make its contents be what you want.

Editing Consistent Changes Tables in the Unicode version
Editing CC tables in the regular Adapt It version is straightforward, because the encoding will be ANSI and typically both the left and right sides of each change rule will be rendered adequately using the source language font, and the text will be all left-to-right. In the Unicode version, however, while Unicode is used, the left text in a CC rule might be left-to-right, and the right text of the rule might be Arabic or Hebrew, or other right-to-left rendering writing system. Adapt It Unicode will use the source language's encoding and font for rendering the cc table data in the editor window. If the source text's Unicode font can properly render both source and target language data, then the table will look okay, except when the source and target languages render text in opposite directions. However, even in this case, while the changes rules may look weird, the underlying cc table data should be correct and the table would work. 

If the source text's Unicode font cannot properly render both the left and right sides of the rule, then you should not try to edit the table within Adapt It Unicode, nor try to create a table and add cc rules to it. In this case a better approach would be to create the needed CC table in a more sophisticated Word Processor, such as MS Word or OpenOffice, where you can change keyboards and fonts as needed in order to type the appropriate text for each side of the cc table rules. Then save the table as either UTF-8, or UTF-16. Adapt It Unicode can read cc tables in either of these two encodings.

To summarize the settings which Adapt It Unicode uses for the consistent changes functionality's editor window:

a. The window will show UTF-16 characters, for left and right sides of each cc table rule

b. The table can be input from a stored form which may be either UTF-8 or UTF-16

c. Adapt It Unicode will always save a cc table to disk as UTF-8, regardless of what the original encoding might have been (i.e. whether UTF-8 or UTF-16)

d. Any BOM at the start of the table data will be detected and automatically stripped out, so you can safely edit or create a table in MS Word, OpenOffice or any other Unicode compliant word processor.

e. The source text's font and encoding settings will be used for layout of the table data in the editor window.

f. Tables rules will be laid out left justified if the source text is a LTR encoding, but right justified if the source text is a RTL encoding. If mixed LTR and RTL languages are involved, you can expect the layout of each table's line to look unusual: the LTR script data will be shown correctly as left to right, and the RTL data will be shown correctly right to left. Whether all characters are rendered correctly will depend on the capability of the source language's font – the characters will have the correct glyphs only provided the font can handle both target and source language rendering correctly.

g. In the case of mixed encodings, even if one side of the rules is not rendered correctly, the underlying table data can still be correct (eg. if you produced it in a word processor) and still produce the desired consistent changes when Adapt It Unicode uses the table to do conversions.

SIL Converters (and Transliteration Mode)
See Transliteration Mode under Advanced menu commands.
Knowledge Base Editor…
This command (also CTRL+K) opens the knowledge base editor; you can do this when a document is open, or when no document is open – provided a project is open. You will get a dialog with 10 tabs, each tab corresponds to source text phrases of a certain length: tab 1 has phrases comprised of a single word; tab 2 has phrases containing 2 words, and so forth up to phrases which have 10 words in them. Any source phrases longer than 10 words cannot be stored in the knowledge base, but are automatically treated as retranslations.

If you want fast access to a certain source word or phrase, then before you click the Knowledge Base Editor… command, select the particular source word, or phrase, or move the phrasebox to that location. Adapt It will then try to have that particular entry visible as soon as the editor opens. If it cannot find it, it will beep and just show the first entry of the list.

The dialog you see will look something like the picture shown below. On the left is a list box which shows you all the known source text phrases which have a single word in them, shown in alphabetical order. Beneath the list box is an edit box where you can type something. When you type there, the list immediately above will scroll to show you the first entry beginning with whatever character(s) you typed.

The list box at the top right will show you all the known translations of whatever source text word or phrase is selected in the list box at the left. There must always be at least one entry in the right hand list box, and the entries are not sorted. Usually you will want the most frequently occurring adaptation to be at the top of the list, and if that is not the case there are buttons below the list box which allow you to change the order of the entries.

Near the bottom right you will see a numerical entry next to the label "Number of references:". This value tells you how many times Adapt It has encountered the selected adaptation previously in your documents. The value is not 100% accurate – there are some circumstances where it might be different. For instance, if you manually enter a new adaptation into the knowledge base using the "Edit or Add a Translation" text box provided for that purpose, then although the new adaptation has never as yet been encountered in a document, if will be given a reference count equal to 1. Adapt It only needs to know whether a reference count is 1 or a value greater than 1; so once the value is greater than one it does not matter what it is. Adapt It's performance will never depend in any way on whatever value greater than 1 actually occurs. The value 1, on the other hand, is important to Adapt It, as we shall see later on.

When you wish to finish using the editor, if you click the OK button, the knowledge base will be saved to disk, so that any editing changes you have made will be permanently saved. On the other hand, if you click the Cancel button, the knowledge base will not be saved, however, any editing changes you have made will still be resident in the copy of the knowledge base that is loaded into memory; so the next document save, or save of the knowledge base, will write those changes out to permanent storage. If you make changes and are certain that you don't want those changes to permanently stay in the knowledge base, do not hit the Cancel button; instead, stay in the editor and navigate to the things you don't wish to keep, and edit them to something you are happy to have permanently stored, or remove them using the Remove button.
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An important thing to remember is this. The knowledge base editor has the power to make your knowledge base inconsistent with the contents of your document files. This does not matter, Adapt It will not crash or perform in some strange way if there is an inconsistency. Inconsistencies arise when you
a)
edit one or more adaptations, or
b)
remove one or more adaptations, or
c)
remove all of the adaptations of a source phrase, which makes the source phrase itself also be removed.

What happens when you edit or remove entries?
 It just means that when Adapt It is looking ahead at the source text at the active location, something formerly in the knowledge base but now edited out, will not be found. So Adapt It will wait for you to type an adaptation instead of entering it for you. Or, if you edited out one of several possible adaptations, and then call up the Choose Translation dialog, the adaptation you edited out will not appear in that dialog's list box. As you can see, these effects are trivial – as soon as you type the earlier adaptation again, it will be put back into the knowledge base and be findable from then on. So you can be assured that you can freely edit or change anything you like in this editor, and Adapt It will not mind.

Note: if you do edit the knowledge base, rather than just use the editor to inspect its contents, then because you will have made some earlier adaptations in your documents be no longer found in the knowledge base, the documents at those particular points will not be consistent with the knowledge base contents. Presumably, what you have edited out of the knowledge base will be wrong or mistaken adaptations which you regard as no longer valid. If that is the case, then you will want to either edit the mistaken adaptations out of the document files as well, or perhaps edit out some occurrences while leaving some occurrences intact in certain contexts where they are valid. An easy way to do this is described in the next paragraphs.

How do you make the documents consistent with the edited knowledge base?
There is a command on the Edit menu called Consistency Check.... Use that command after you have edited the knowledge base, and Adapt It will scan through your document files, and everywhere it finds an inconsistency, it will put up a dialog and scroll the document to show you the inconsistency in context, and you can then accept the old adaptation, type a new one, or select an existing one from the list of possibilities which are still valid for that location. This is documented more extensively in the earlier discussion of the Consistency Check command in the section on the Edit menu, in its subsection entitled:


Splitting adaptations – what to do if you discover some earlier adaptations are incorrect.
This technique is a very easy way to fix your documents when you find out that some of your earlier adaptations are not correct; using this technique you can be certain that you will locate every instance of them, and be able to fix the ones which are not valid.

Update button

Use this button to alter the spelling of a translation. First click on the translation you wish to edit, it will then be shown in the "Edit or Add a Translation" edit box. Edit it to your requirements, then click the Update button to make the change permanent in the knowledge base. (As of version 6.2.2, the message that warns you that updating spelling will cause an inconsistency will appear a maximum of three times in any one Adapt It session. The reason for this limit is that it becomes tedious to dismiss the message perhaps dozens and dozens of times – it only needs to warn you a few times at most. After that, if you Update, it happens immediately.)

Add button

Use this button to add a new translation to the existing source word, or source phrase. Type the new translation in the "Edit or Add a Translation" edit box, and then click the Add button.

Remove button

Use this button to remove one or more translations. Click on the translation you want to remove, then click the Remove button.

Add <no adaptation> button

Use this button if you wish to add nothing as a possible translation of the selected source word or source phrase. Clicking the button will cause <no adaptation> to be added to the list box as an additional translation. (Remember, <no adaptation> is just there to show you, a human, that there is an entry which is "nothing". The actual translation corresponding to what you see is nothing at all. (For those who understand programming terminology, it means the translation is an "empty string".)

The Edit or Add a Translation edit box as discussed above shows you a copy of whatever adaptation text is selected in the list box immediately above. If you wish to edit the selected adaptation, do so then click the Update button. If you wish to add an entirely new adaptation, type it in the box, and then click the Add button. If you wish to remove one or more adaptations, select each one in turn and click the Remove button each time. Removing all of the adaptations will cause the source text word or phrase which is selected to be removed as well. To add nothing as a valid translation, click the Add <no adaptation> button.

Now we come to an advanced topic. You can skip the next two paragraphs if you find the discussion hard to follow.  Towards the bottom right you will see:


"Force Choice For This Item" is   OFF  
followed by a button called Toggle The Setting. (Instead of OFF, you may see ON, depending on whether or not you used the Force Choice For This Item checkbox earlier for the currently selected entry.) The button will be disabled if there are two or more adaptations in the list box above it. When the setting is displayed as OFF, then every time that Adapt It finds that particular source text word (or phrase) at a new empty active location, it will automatically insert the displayed target text adaptation into the document. This will often be the behaviour that you want. 

However, if you have only started adapting text and so far you have given only one adaptation for the current source text and you know that eventually there will need to be more than one adaptation for the same source text, then you will not want the one adaptation to be inserted for you every time. Instead, you will want Adapt It to halt and put up the Choose Translation dialog for you, so you will have the chance to type a new adaptation if it is appropriate in that particular context. The only way to force Adapt It to halt and put up the Choose Translation dialog is to have the above setting be ON. You can switch it to ON by using the Toggle The Setting button. (You can also use the same button to turn a setting which is already ON, to OFF)

In the discussion of the Restore Knowledge Base… command, it was stated that some settings may be able to be rescued from a corrupted knowledge base. The settings which were meant are this one, that is, the setting for the Force Choice For This Item checkbox. Also it was stated that you can use the Knowledge Base Editor to manually alter the settings to what they need to be, if the Restore Knowledge Base… command cannot do it for you. Well, the above Toggle The Setting button is what you use to do so. The default setting is always OFF; so you only may need to turn a few instances ON. Just find the relevant source phrases in whatever tab is appropriate in the editor, select the source phrase, and then click the button to turn the setting ON. 

It is not a serious problem for your work if you have the setting set to OFF when you should have had it set to ON. It will possibly result in some inappropriate adaptations being inserted in some places in documents, and you might not notice that they were inappropriate. Some places will be places where you may have preferred to stop and add a different adaptation. But so long as you read back through your document, you will find those inappropriate adaptations, and can place the phrase box there to make that the active location, then manually edit the adaptation. Or you can use the technique discussed in the subsection:


There are two special "adaptation" entries which you will come across occasionally in the editor. One has the form:

<Not In KB>
and the other one has the form:
<no adaptation>


When you specify that a certain source text is to have nothing added to the knowledge base (by turning off the Save To Knowledge Base checkbox), an entry having the form <Not In KB> will be added to the knowledge base. This is a special entry which informs Adapt It that, in reality, this entry does not exist! Yes, I know this sounds ridiculous, but that is the way that Adapt It likes it to be!

The <no adaptation> entry will be put in the knowledge base when you specify the adaptation to be nothing – by clicking the <no adaptation> button on the modes toolbar. The text <no adaptation> is not, actually, in the knowledge base; the latter actually stores an empty entry, so the only way you can be alerted to the fact that there is nothing there, is to see the <no adaptation> text in the editor dialog. In the document itself, you just see an empty space at the relevant location.

Do not try to edit these entries, they are important. You can, however, use the Remove button to remove a <no adaptation> entry, but do not use the Remove button to remove a <Not In KB> entry - Adapt It won't let you if you try anyway. (If you really want to get rid of a <Not In KB> entry, the way to do it is to exit the Knowledge Base Editor, and in the main window place the phrase box at the location which is "not in the Knowledge Base" - it will have an asterisk above it, the phrase box will be empty, and the "Store In Knowledge Base" checkbox will be OFF. Simply click the checkbox back ON. Whether or not you type an adaptation there as well will not matter; once the checkbox is back ON, the <Not In KB> entry is removed from the knowledge base.)

Clicking on a different tab will display source phrases of a different length. For example, in the Takia test project I have been playing with, if I click on the tab for 3 Words, I would see the following:

Knowledge Base Searches and Respelling
With version 5.2.0 Adapt It now has support for knowledge base searches and simplified respelling of groups of target text words or phrases. The controls for these new search and respelling features have been added to the bottom of the Edit Knowledge Base dialog:
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The new controls added to the KB Editor (shown above) are:

   (a) A multiline text box labelled Search For: where target text search strings can be typed.

   (b) A Go button which initiates the search and displays the results in a Respell or Inspect Matched Knowledge Base Items child dialog (see below).

   (c) An Erase All Lines button which clears out the multiline text box's strings if the user does not want what he has typed and wants to start over by typing different strings

   (d) A drop down box labelled Old searches: which lists all older search strings that the user typed while within the current project during the current session - this control is cleared automatically when the user leaves the project. 

Note: the KB search is "smart". In the multiline text box where search strings are typed, one or more words or parts of words, each separated by a space, can be typed. All the words in a "line" must match, in the order in which they were typed, for a KB adaptation (or gloss, if glossing mode is currently on) to be accepted as a successful match. The search text "line" can be longer than the width of the multiline text control - and although a long typed string may wrap over more than one physical line, it is still a single search string. The user must end the line by explicitly pressing the Enter key. Searching supports discontinuous matches. If the user wanted to match all KB entries in which there is somewhere the string "ing" followed somewhere, even if many words away, by the string "ed", then in the multiline text box he would type (without the double quotes) "ing ed" (note, there must be at least one space between each part which is to be separately matched). 

Once the Go button has been pressed, the whole KB is searched for matches to whatever occurs on any one "line" in the search box. As many search string "lines" can be typed for a single search operation as desired - the only thing to bear in mind is that if there are many search string lines, the searching will take longer. After the matches have been collected internally, the following dialog opens to display the matched KB entries in a list. The user may either use the horizontal scroll bar, or drag the dialog's boundary to widen it sufficiently to see all of the contents of a long entry.
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The Respell or Inspect Matched Knowledge Base Items child dialog provides the following features:

   (a) Select an entry in the Matches… list (at right), it then appears in an Edit box (near the bottom) where it can be respelled if the user wishes.

   (b) Click on the Update button to cause a respelled adaptation (or gloss, if in glossing mode) to be added to an Updated Spellings list which is to the left of the list of matched KB entries.

   (c) The items in the two lists are linked, so clicking on an item in either list causes the other list's corresponding item to be selected, and the Edit box to have the appropriate string placed in it.

   (d) The Remove Update button allows the user to reject a respelled item and it is removed from the Updated Spellings list and the formerly updated spelling is still shown in the Edit box, but the original spelling remains in the Matched list.

   (e) The Restore Original Spelling button does the same as the Remove Update button, except the Edit box shows the original spelling.

   (f) Because the Matches list may have many items in it, a Find in matched list text box is provided for a search string to be typed, and a Find Next button initiates the search, and if a matching item is found, it is scrolled into view. (This search is not smart; it tries to match the whole string as typed, including any spaces within it.)

   (g) When the OK button is clicked, Adapt It looks at the contents of the Updated Spellings list, and updates the KB entries to which they belong.

   (h) The Cancel button rejects the whole of the current search - no KB entries are updated, the search string lines which the user had typed are thrown away, any new spellings in the Updated Spellings list are ignored.

   (i) On return to the parent dialog (and provided the Cancel button was not clicked), the set of typed search string "lines" are added to the contents of the Old searches drop down box, so that at a later time it is easy to search for any of those "lines" again. Also, a message reminds the user that spellings were changed and that has made the knowledge base inconsistent with the adaptation documents. It suggests that a consistency check of the whole set of documents be done when the parent dialog closes, and if the Yes button is clicked, the user is shown the dialog for choosing to consistency check either the current document, or all documents (see Consistency Check… under the Edit menu commands).

Bulk removal of knowledge base entries and storage of entry lists in files
A new button, "Remove Some Entries or Save List..." is on every page of the Knowledge Base Editor dialog. Click it to see a list of the whole knowledge base (source & translation, with the count of how many times the translation has been used in the documents so far - a 'reference count'). 
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Two radio buttons allow two views of the list; one view (pictured above) is to show the source text first, and sort by the source text, but to group all the translations of each source text, in alphabetical order, together. The other view puts the translation first, and sorts the whole knowledge base by that  – and this is the default view. Click the checkbox on a line to have that line's entry removed (eventually). Ticked boxes remain ticked if you change from one view to the other - but their locations in the list will change because the lines are sorted differently in each view. When the button called "Remove the selected entries, and close" is clicked, all the entries that were ticked are then removed from the knowledge base.

Note: Adapt It relies on the international default sort order. If your script has special characters, and they do not appear in the place you would like them to be, Adapt it has no way to help you develop a custom sort order.

Finally, each view can be saved to a file which you can name, and have a datetime stamp added to the filename as well. The button for this is "Save the list to a file...". The data in the file does not show which items you may have ticked at that point. The saved file is useful for checking for obsolete entries, spelling mistakes, and so forth. The dialog sizes itself to the height of the physical screen, minus a little bit, to maximize how much can be seen without scrolling. The list can be any length. - for example, my test data had 14 thousand lines in the list.

Continuing the description of items on the Tools Menu:

Use Automatic Capitalization 
This command allows you to dispense with having to type a lower case translation (or gloss) at the beginning of words of phrases which begin with a capital letter in the source text, and then the application will automatically change the initial lower case letter you typed into the appropriate upper case one.

The command cannot be used if the source language does not have a distinction between upper and lower case. This is because the application will look at the source text words in order to figure out if a change to upper case is required; and if the source language does not have a case distinction, this check could never succeed. The application will also check to see if you have defined the appropriate lower to upper case letter equivalences in the Case tab of the Preferences dialog accessible from the Edit menu, and if none are defined it auto capitalization will not work, and your saved knowledge base entries will be the older style of entry which distinguishes between upper and lower case. When auto capitalization is in effect, only lower case entries are stored in the knowledge base. 

The application works safely with a mixture of both types of entry – older style entries and lower case ones; also, the Restore Knowledge Base command on the File menu can be used to change either the glossing knowledge base or the adaptation knowledge base to contain only one style or entry or the other – depending on whether or not the Automatic Capitalization… command is on when you give the command to restore.

Automatic capitalization can be turned on or off at will, as often as you like. The setting which is in effect when the project is closed will be saved to the project's configuration file, and so will be restored when that project is next entered.

Make All Knowledge Base Entries Available
This menu item relates to the automatic capitalisation feature. To explain what this does requires some preamble here about how automatic capitalization works. If you already understand how, skip to the next paragraph. When automatic capitalisation is OFF, entries to the knowledge base which have an upper case letter first in the word or phrase (e.g. "John"  with a translation "Ivan" ) go in as a separate entry from one in which the source text has a lower case letter as the first word - so "john" with translation "ivan" would be a separate entry. When automatic capitalization if ON, Adapt It ignores all knowledge base entries that have their source text starting with a capital letter. So the entry {John, Ivan} would not be seen when a lookup is done. And when saving a new entry which has source text starting with a capital letter, before adding the word pair (or phrase pair) to the  knowledge base, Adapt It will check if there is an upper case letter present in initial position in the source text, and if so, it will convert it to the equivalent lower case one - so that subsequent lookups can find the entry; and it also makes the first letter of the translation lower case too. When such entries are recovered from the knowledge base at the time of a lookup, automatic capitalisation being ON causes Adapt It to check if the source text at the active location in the document has a capital letter at the start. If it does not, then the translation is inserted "as is" - that is, with lower case initial letter - unchanged from how it was in the knowledge base. But if the source text does start  with an initial capital, the Adapt It will automatically change the first letter to the equivalent capital letter, and then show the resulting capital-initial word or phrase in the phrase box. 

Many users may have Automatic Capitalization turned off for many months of work, so that lots of entries of either case, lower or upper, are mixed in the knowledge base. Then they decide to work with Automatic Capitalization turned ON from that time onwards. When this happens, all the entries which have a capital letter   at the start of their source text, become ignored. That's potentially a lot of useful information about adaptations that belong with those entries that can no longer be "seen" by the lookup process. What the Make All Knowledge Base Entries Available command does is simple. It makes all that unsee-able information accessible to the lookup process. It does it by searching through the knowledge base, and for every entry with initial capital letter, it changes the capital to the equivalent lower case - doing so for both the source text and the translation text of each entry, and saves the resulting transformed entries with the rest of the already present lower-case initial entries. Of course, lower case equivalent entries may already be present, if so, nothing new is added. But if there are no lower case entries yet for any of such transformed entries, then the transformed ones are saved in the knowledge base, and become see-able to lookups.

This command does not need to be used often, or even at all. But if you have automatic capitalisation turned ON, and you see lots of listed upper-case  initial entries in the lists in the Knowledge Base Editor dialog, then you will know that a lot of useful information may not be being made available to the lookups done while you work. If that is the case, click this command. It's very quick - it may only take a second or two, and it could improve the usefulness of your knowledge base noticeably.

If you do use this command, you may decide that the upper-case initial entries in the knowledge base are no longer required. (That's only true so long as you always work with Automatic Capitalization turned on.) If you want to "bulk delete" them, enter the Knowledge Base Editor (see Edit menu), and use the button called Remove Some Entries or Save List... and in the dialog that comes up, tick the checkboxes for those you want to be removed. They are removed when you dismiss that dialog. However, please understand the following. The knowledge base editor is not slowed down by the presence of thousands of unused entries. So you won't be gaining any speed efficiency by removing such material. The only gain is that lists of entries shown to you will be shorter.

Retranslation Report…
This command allows you to have Adapt It produce a file containing all the retranslations in either the currently open document, or all/ many of the previously created documents. Adapt It asks
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Click Yes to get a report based only on the currently open document. Click No to get a report on many or all documents in the current project..

If the report is to be based on many/all documents, you will get the dialog which lists all of the known Adapt It adaptation documents for your project (we have seen this dialog earlier: see the Restore Knowledge Base command.) You can then specify which documents to exclude from the report, or include them all. 

If your administrator has configured Adapt It to protect the _REPORTS_OUTPUTS folder, your report will be automatically named and saved in that folder. Otherwise, you will also be presented with a standard output file dialog, so you can use that to navigate to whatever folder you would like to use for storing the report, and give it another name if you do not like the default name supplied for you.

When you finish using the dialog, Adapt It will then scan through the documents and produce the report. It will look something like in the following picture, which is a report on the Takia Hebrews document. (In whatever font you display this documentation, you might not see Takia velar n correctly, it may look like a y with an acute accent above it.)

Retranslation Report
File Path: C:\My Documents\Adapt It Work\Takia to English adaptations\hebrews report.txt
hebrews 1:2
iýsinan Nanun awan lo irupaiad a.
by the mouth of his own Son he told us.
hebrews 1:2
taman imado wo ipiliani a.
he will appoint him to be father
hebrews 1:3
iý Anut san lilaman iý lo yen dan isapudadeg
he is the light of God within him shining out for all to see
hebrews 1:5
Iý ta ago ibol na ya.
He not say.
hebrews 1:7
tim igo woý a,
are like winds
hebrews 2:1
Fun amaiak niýen o
For that particular reason
hebrews 13:24
iýaned ilo uyan ru aýsam na digane ipalu ya.
they send their greeting talk to you
The report lists each retranslation in order of occurrence in the document. The output filename for the document is used with the chapter and verse number to index the location of the retranslation. Then follows the source text, and on the following line is the target text's retranslation.

A report may be of use to a translation consultant wishing to check your work for exegetical accuracy. Presumably the adapted text does not need checking, but retranslations possibly might need a check. So this command gives you a quick and easy way to generate the needed report.

Split Document...
Join Document...
Move Document...
Split, Join and Move
Note: The Split, Join and Move commands are not available when Adapt It is collaborating with Paratext or Bibledit.
Since Version 3 Adapt It has had the ability to split any document at any arbitrary place, or where chapters begin. It can also turn a document into a set of files with just one chapter per file. There is also a document joining functionality. The document moving functionality permits documents to be moved from being stored in the Adaptations folder of a project, to being stored in one or more of the same project's book folders. Alternatively it can be used to move documents from one or more book folders into the Adaptations folder. These commands are on the Tools menu.
The Move command is only enabled when you have Adapt It in book folder mode. The Split and Join commands are always enabled, provided a document is open. In the latter case, Split will split the currently open document. Join will append other documents to the end of the currently open document - so in the case of document joining, you must make sure that the first document you want to occur in the joined resulting document is the one which you are looking at on the screen in the main window.
Use the Split command in particular with some care. There are two things that are important. The first is that you take care about where to make the split happen by placing the phrase box at the first word or phrase which is to be in what remains after the split is done. The splitting process makes a smaller document file out of everything which precedes the phrase box in the currently open document, and stores that smaller document file on disk without opening it. Whatever is left over after that is done is shown to you as the current (smaller) document - and it is open in the main window. It is legal to split a document anywhere, but it makes good sense to split it at sensible places such as between chapters. It's your responsibility to ensure the split location is a good one, with one exception - when you specify an automated chapter-by-chapter split.
The second important thing is to decide on good names for the smaller document files which result from a split. It is good practice to name the parts in such a way that you know exactly what chapters (and verses if you are splitting within a chapter) are in each document. You don't want to have to open a document to find out what its contents are; it is much better that the document's name tells you that. Also beware, if your un-split document has more than ten chapters, and you, say, split at chapter 2 and then at chapter 10, and you use 2 and 10 in the filenames, then the one with the 10 will sort earlier in any list of files than the one with 2. This might lead you to make errors if you later join the documents. To avoid this, use leading zeros in the numbers so that each number has the same number of digits in it. So you should use 02 and 10 in the filenames, and then the filename with 10 will sort after the one with 02, which is what you want to see when the files are shown in a dialog's list. The split dialog is shown below:
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In the illustration above, a Hebrews document is about to be split at the end of chapter 6. This location was found by pressing the Locate Next Chapter button several times until the phrase box landed at the start of the section heading. Why is the box located there? Well, you are likely to want the section heading which applies to the text in the remainder part of the document to be retained with that remainder. It would not make good sense to have the section heading at the end of the split off Hebrews 1-6.xml document, and the text it applies to be located in the Hebrews 7-end.xml document. The box landed at the Melkisedek word because Adapt It looks for where a \c marker occurs in order to determine where each chapter starts, and (conveniently) in correctly marked up standard format text, the \c marker will precede the \s marker which indicates the start of the section heading. So, if your SFM or USFM markup is correct, you can rely on Adapt It to include the section headings in the document files which they pertain to.
In the picture above, I typed the names into the text boxes manually. I could have used any names I liked. The radio buttons at the top of the dialog guide Adapt It about how to make the split. If I were to press the Split Now button, then Hebrews 1-6.xml would be split off from the open document and stored in the Adaptations folder; and the current document in the main window would then be called Hebrews 1-end.xml, and it would contain the rest of the former hebrews.xml document.
There is one other thing which Adapt It does when it makes a split. It looks at the start of the un-split document to try to find an \id field there, and if it finds it, it reads the 3-character book identification (ID) code which is obligatory for such a field as its first piece of data. When it finds whatever is there, it checks to ensure it is a valid book ID code, and if so, it creates an extra "word" at the start of the remainder part of the document - and that "word" is the book ID (for hebrews it would be HEB), and the \id marker is hidden away from view as would be expected. You should always have an \id field first in your source text files used for creating Adapt It documents, and make sure you use valid book ID codes. If you do that, Adapt It will be able to do some nice things for you automatically, and prevent you from mistakenly joining formerly split documents which don't belong together, and also prevent you from moving documents into book folders to which they do not belong (for example, it would prevent you from copying hebrews.xml in the Adaptation folder into the Matthew book folder).
If you do not supply a name in the lower of the two boxes at the right, then the remainder document is named the same as the currently open one. If you do supply two names, then after the split is done then the original document is automatically removed to prevent your disk filling up with copies of documents containing different parts of the same material. Splitting works in such a way that you only have one copy of the data stored, so there is no confusion about what is the most recently updated version of the data. That is, if you find and see the data on the screen, you can be sure it is the latest version of it.
The second radio button splits off the next chapter without moving the phrase box forward to show you where it will do so. You could press the Locate Next Chapter button a few times beforehand, and then when you click Split Now, it would split off several chapters at once rather than just one. Similarly for the first radio button.
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The radio button called Split into single chapter documents allows you to do an automated split. When you click this button one of the boxes disappears (see above), and you type a generic document name into the box which remains. When the split is done, multiple documents will be created and stored (and the original document consumed). Adapt It will take whatever name you have typed into the box and it will automatically add one or more digits to form a number. (The numbers will have leading zeros if needed, this is done automatically.) So, since Hebrews contains more than 9 chapters, Adapt It would, for the above dialog, create the files:
Hebrews chapter01, Hebrews chapter02, Hebrews chapter03, ... Hebrews chapter13.
Note that names can contain spaces and other characters such as - (hyphen) or , (comma) and so forth. In fact, normal Windows file naming conventions apply. Those conventions stipulate that : (colon) is illegal in file names, if you try to use it Adapt It will give you a message requiring you to fix the name before you can proceed; similarly for other illegal characters. Note also that you don't need to type any filename extension. If you do, Adapt It will strip it off automatically because Adapt It wants to be the one to decide what the extension should be. It will place one there itself - it will be an .xml extension since all Adapt It documents are saved in xml format.
This discussion of document splitting assumes the storage folder is the Adaptations folder for the project. It does not need to be so. If you have Book Mode turned on, the documents you will have access to are those in whatever book folder is currently open for work. Splitting will work on those equally well, and the results will be stored within that book folder. Similarly for the Join command.
The Join command's dialog is shown below. 
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To obtain this form of the dialog I first closed off Hebrews 7-end.xml - after all, I don't want to append chapters 1-6 at the end of chapter 13!
Then I opened Hebrews 1-6.xml which I had just split off, and then chose the Join command on the Tools menu.
Initially, all the files are listed in the list box on the left, because Adapt It does not know which files you want to join to the currently open document (which contains just chapters 1 through 6). The currently open document is never shown in the list.
If I pressed the Join Now button, all of those files would be appended - which is certainly not what I want to happen.
So I clicked the Move All Right>> button, which placed all the files in the right hand list box. Then in the right hand list box I selected the one file, Hebrews 7-end.xml, which I want to be joined back on to the open document, and clicked the central green tick button - that moved that one file back to the left list box, as shown in the picture.
Now I'm ready to press the Join Now button. Only what is in the left list box will be appended to the open document. In this case, it is just a single file. However, if there are more than one files listed in the box on the left, all will be appended starting from the top and working down in list order. If you inspect the order of the files and realize they are not in the order they need to be, you can select one or more of them and use the Move Down or Move Up buttons to move them up or down in the list. Do so until you get the order you want.
Notice that the name Hebrews which I typed into the box at the bottom does not need a filename extension be typed as well. Adapt It controls the extensions which are to be added. If you supply one, yours will be removed and then Adapt It will put whatever extension it decides should be used.
If I were to click the Join Now button, the two document files would be joined and renamed Hebrews.xml, and stored in the Adaptations folder. The original two documents would be consumed (i.e. would be removed) so that the data that was formerly in them would then only be found within the resulting Hebrews.xml file.
When the join operation is complete. The joined document is made the currently open one, and the Join dialog is left open in case you want to do other join operations. The phrase box is left at the last location in the document where a join was done.
Joining of documents can be done with equal facility within any folder which is open for you to work in while in Book Mode.
Finally, the Move command. As stated above, it will not be enabled until you have turned on Book Mode using the command Storing Documents In Book Folders on the Advanced menu. When you do that, Adapt It will close the current document (if you have unsaved work in it, you will be asked if you want to save it) and show you the Documents page of the Start Working... wizard, with the current book folder set to Matthew if you've not had any book folder open earlier in the same session, or the last opened book folder if you had.
You would then use the Change Folder... button to choose some other book folder than Matthew if you did not want to be working in the Matthew folder. The dialog for doing this is pictured above in the section called Book Folders Mode. As an example, I will move the Hebrews.xml file from the Adaptations folder into the Hebrews folder, so I must first make the Hebrews folder the current one.
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Then, while the Hebrews folder is the currently open folder (check the status bar at the bottom of the main window), I would click on the Move Document command on the Tools menu. The dialog above would then appear. No file would be selected in the list of files. The picture shows what the dialog would look like after I had moved one of my short Hebrews test files into the Hebrews folder, and I have then selected the Hebrews.xml file and am about to click the Move Now button to cause it to be moved into the Hebrews folder.
The radio buttons at the top right allow you to specify the direction of the move. Default is to move from the Adaptations folder into the currently open book folder (in our case, that was the Hebrews folder). If I tried to move it into some other folder than Hebrews, Adapt It would look at the book ID code in the \id line which occurred first in my source file from which the Hebrews.xml file was created, and warn me that the document could not be moved into that folder. If I want to move a file from the current folder back into the Adaptations folder, then I would click the From the current book folder to the Adaptations folder radio button first, and then the list box at the left would list the contents of the Hebrews folder instead, ready for me to select which file to move.
Only one file at a time can be selected and moved. 
There is a possibility that there might be a file of the same name in the destination folder. This could happen if you or someone copied an Adapt It file of the same name from some other project or computer, for instance. It would not be a good idea to overwrite such a file - so Adapt It will warn you if it finds a name conflict. You can instead click the View The Other Folder's Documents to see a little dialog which lists the contents of the destination folder, so you can check yourself for conflicts before you do the move. The picture below shows what it looks like. Currently, in this example, it only shows the one file I had earlier moved to the Hebrews folder.
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You can also use the Rename Document... button to rename whatever file is selected in the Move A Document dialog's list box. This is one way that Adapt It allows you to rename a document file while the program is running, whether or not you intend to go ahead and move the file you renamed. The downside of this is that you have to turn on Book Mode which would create 67 book folders in your Adaptations folder; and you probably would prefer to avoid that if you don't want to use Book Mode. (An alternative way to rename would be to use Split and then Join, and in the Join step supply a different document name. You can do it that way without turning Book Mode on.) Normally, however, you would use the Rename Document... button when you observe a file naming conflict which you want to resolve before doing an operation like the Move operation. If you go ahead with a Move without resolving a filename conflict, the move will not take place.
Install the Git program…
This Tools menu selection is mainly intended for users who do not want the Adapt It installer to download and install the Git program at the time the main Adapt It program is installed or updated, but want to install Git at a later time – either from a local copy of the Git installer or by downloading and installing Git when faster/cheaper Internet access is available. If this item is selected when Git is already installed one of the following messages will ask (depending on which version of Git is already installed):
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or
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or
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If you answer “No” the message will close and no action will be taken. If you answer “Yes”, Adapt It will present the following dialog:
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Which button is pre-selected in the above dialog depends of what version of Git is present on the computer. When Git is already installed the top button is pre-selected. If Git is not installed and Adapt It cannot find a Git installer in the Adapt It installation folder, the middle button is selected. If Adapt It successfully located a Git installer in its own installation folder, the bottom button will be pre-selected. In any case the user can override the default pre-selection and select which option to execute. The middle button - “Download and install Git from the Internet” will require Internet access and will require about 47MB of data download to accomplish. The most economical way of installing Git (especially on multiple computers where Internet is slow and/or expensive) is the bottom Selection “Browse this computer to find a Git installer”. After the Git installer has been downloaded at least once on one computer, an administrator or user may copy the Git installer (named something like Git-2.32.1-32-bit.exe) to a thumb drive from the first computer’s c:\Program Files (x86)\Adapt It WX Unicode\ folder. Then the bottom option will allow Adapt It to browse to the location of the Git installer file on the thumb drive, and install Git on each computer without accessing the Internet. Alternately, the Git installer can be copied from the thumb drive to the c:\Program Files (x86)\Adapt It WX Unicode\ folder of each computer needing to install Git, and by choosing the bottom button one could browse to the location of that installer and install Git without needing to connect to the Internet. In any case Git will be installed with all the appropriate options when the Git installer is used under the control of Adapt It.

Export-Import Menu
Exporting and Importing data
The different export and import types are: 

   (1) Export Source Text – as a plain text SFM, RTF, XHTML, or Pathway file

   (2) Export Translation Text – as a plain text SFM, RTF, XHTML, or Pathway file

   (3) Export Interlinear Text – with the various types of text aligned in tables – as RTF file

   (4) Export Glosses as Text – as plain text SFM, RTF, XHTML, or Pathway file

   (5) Export Free Translations – as plain text SFM, RTF, XHTML, or Pathway file

   (6) Export Knowledge Base. – as plain text SFM or LIFT xml file

   (7) Import Knowledge Base records – from plain text SFM or LIFT file

   (8) Import Edited Source Text – from a plain text SFM file that was subsequently edited outside Adapt It.

Export Source Text…
When a document is open, you can choose the Export Source Text… command in order to cause Adapt It to construct an export file of the source text currently stored within the Adapt It document. The Export Source Text dialog looks like this:
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The type of format used in the export can be one of the following (by selecting the appropriate icon):
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	Standard Format Text (TXT) File (.txt), containing your document's original language text, with punctuation and standard format markers replaced within it. This is the default export format unless you choose one of the other export type icons in the “Export to” list. 
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	Rich Text Format (RTF) Document File (.rtf), containing the formatting used by the Word Scripture Template standard which can be read by MS Word, OpenOffice or LibreOffice. The RTF export option will display the source text in a semi-publishable format when opened and viewed within MS Word, OpenOffice or LibreOffice.
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	XHTML Format (.xhtml), containing the formatting in an “extensible” xml format which can be viewed using a current web browser.
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	Pathway Format. This type of export is actually processed through the SIL Pathway program (if installed) to produce a file in other formats for mobile devices such as cell phones or e-book readers.


The name of the export file and its saved location depend on whether your administrator has configured Adapt It to assign source text exports to special default folders for exports of the source texts. The assigned special folder for source text SFM exports is _SOURCE_OUTPUTS. The assigned folder for source text RTF exports is _SOURCE_RTF_OUTPUTS. The assigned folder for Xhtml exports is _XHTML_OUTPUTS, and the assigned folder for Pathway exports is _PATHWAY_OUTPUTS. If your administrator has configured Adapt It to protect source text exports from navigation, Adapt It automatically assigns the export file a name and date-time stamp and saves the export file to the appropriate special folder. If your administrator has not configured Adapt It to protect such exports from navigation, Adapt It opens up a standard output file dialog which you can use to change the name of the file if you wish, and/or store the exported file in some other folder or drive. The default name within the file dialog will be the same as for the document unless you tick one of the “Export filename prefixes and suffixes” check boxes at the bottom of the dialog. If you tick the “Use project name prefix <SourceLang-TargetLang> on export filename” check box, Adapt It will add the name of the project as a prefix on the filename. If you tick the “Use export type prefix…” check box, Adapt It will add a “source_text_” prefix to the file name that appears in the file dialog. If you tick the “Use date-time suffix on export filename” check box, Adapt It will suffix a date-time stamp to the name of the file name that appears in the file dialog. In any case Adapt It provides an appropriate extension for the type of export format (.txt, .rtf, xhtml, etc). You might use this command after you have edited the source text in the document using the Edit Source Text command.

Export Translation  Text…
When a document is open, choose the Export Translation Text… command in order to cause Adapt It to construct an export file of the translation (target) text currently stored within the Adapt It document. You can export the file to any of the same four formats that are described in the above “Export Source Text…” command. These format options are available via a dialog similar to that shown above – except that the top line of the dialog says “Export Translation Text”.

The name of the export file and its saved location depend on whether your administrator has configured Adapt It to assign translation text exports to special default folders for exports of the translation texts. The assigned folder for translation text SFM exports is _TARGET_OUTPUTS. The assigned folder for translation text RTF exports is _TARGET_RTF_OUTPUTS. The assigned folder for Xhtml exports is _XHTML_OUTPUTS, and the assigned folder for Pathway exports is _PATHWAY_OUTPUTS. If your administrator has configured Adapt It to protect translation/target text exports from navigation, Adapt It automatically assigns the export file a name and date-time stamp and saves the export file to the appropriate special folder. If your administrator has not configured Adapt It to protect such exports from navigation, Adapt It opens up a standard output file dialog which you can use to change the name of the file if you wish, and/or store the exported file in some other folder or drive. The default name within the file dialog will be the same as for the document unless you tick one of the check boxes at the bottom of the dialog to have Adapt It prefix a project name, target_text_  and/or a date-time suffix to the filename that appears in the file dialog. Adapt It provides an appropriate extension for the type of export format (.txt, .rtf, xhtml, etc).

This exported translation file could then be sent to another application for editing of the formatting and for printing, or to a word processor application for further editing. The plain text form with standard format markers retained could also be used in Adapt It as the source text for a further adaptation into another language or dialect, in a new project; or for making a back translation.

If you have merged storage elements in the document which span one or more standard format markers, then as the Export operation takes place, Adapt It will put up a dialog whenever it finds that it cannot determine the correct location at which to restore the standard format marker(s). If you never make a source phrase spanning a standard format marker, you should not see the dialog, and the replacement of the markers will occur silently without the need for any manual intervention on your part. 

The most likely time you would see it is when there is at least one endmarker mixed in with two or more punctuation characters – in that circumstance, sometimes only the user can determine where the correct location for the marker needs to be. Some such situations can be handled automatically and those will not cause the dialog to appear, but not all are like that. If you do see the dialog, then it will look like this:
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At the top you will see the source text including any markers. The picture above has the \q marker. When markers at the start or end of a storage unit Adapt It can assume that markers should be at the same place in the target text. However, Adapt It needs your help to replace the marker(s). In the source it occurs between two words, but in the target text it cannot be assumed that is the correct place. Only the user can make this decision. Place the insertion cursor in the correct place in the target text and then click the Place button, and Adapt It will insert it correctly. If there are more markers in the list the next marker (if there is one) will be highlighted, ready for you to place it also. Once all have been placed, click OK to finish the dialog.

You don't have to replace all of the markers. You can ignore any or all of them. You can also manually type new ones at any location in the edit box. Whatever target text, including markers, is in the box when you click the OK button, that is what Adapt It will insert at that point in the exported file. Adapt It will automatically place a carriage return and line feed before each marker, so that in the exported file the markers will correctly appear at the start of  new lines. You should only type a space to separate a marker from anything which follows (and a space after a USFM endmarker is never necessary). Do not try to type carriage returns using the ENTER key.

Export Interlinear Text…
Choose the Export Interlinear Text… command in order to cause Adapt It to construct an output file of ".rtf" type (Rich Text Format,) containing styled tables with invisible boundaries which display the document in interlinear format similar to what you see in the main Adapt It window. The resulting file can be read by any good word processor, such as MS Word, OpenOffice, or LibreOffice, and the styles can be used to set up different fonts, colours, or other properties as desired. The tables are formatted to fit within the printing area – using the current default paper size and margin sizes. Adapt It measures the text when it constructs the file for export, so the cells are sized to fit the data. This relieves the user of the responsibility to manual edit the tables in the word processor. Documents exported in this way would be very suitable for giving to a translation checker (if it was a back translation project), or for adding comments, printing and binding to make an interlinear translation resource book for a national translator (if the source text was the Greek NT, or Hebrew OT.)

When the command is given Adapt It will put up the following dialog:
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The top four checkboxes allow you to choose which lines of the strips seen in the Adapt It main window to be sent out as part of the exported data. The Gloss Text checkbox will be disabled if the Allow Glossing command is not turned on in the Advanced menu. The order of the rows in the exported tables is the same as shown in the Adapt It main window: so navigation text will be the first row, source text the second, and if glossing mode is on then the glossing row will be next and adaptation row last, otherwise it will be the adaptation row next and the glossing row last.

The Portrait versus Landscape radio buttons allow you to tell Adapt It how long the tables can be, so the application will not produce any table which will not fit within the printable area. If necessary, before you use the export command, you could change your paper setting and left and right margin sizes to different values, and then use the Export Interlinear Text… command – Adapt It will then use the new values for paper and margin sizes when it constructs the tables. Adapt It measures the text in order to work out the cell sizes for the tables. For formatting font sizes in the interlinear tables, Adapt It uses the style information contained in the AI_USFM.xml control file. It does not use the font sizes currently defined within the application for your fonts

The Output Range section of the dialog allows you to specify a chapter/verse range for export, if you want; or you can use the radio buttons at the bottom to export everything preceding chapter 1 verse 1, or everything after the last verse of the last chapter. Default is to format and export the whole document, which for a large document can tie Adapt It up for several minutes, and the resulting RTF file could be enormous if you are adapting a large book such as a gospel. You might find it better to print out the document in parts, using this range functionality to do so.

The name of the export file and its saved location depend on whether your administrator has configured Adapt It to assign Interlinear text exports to a special default folder for exports of interlinear texts. The assigned folder for interlinear RTF exports is _INTERLINEAR_RTF_OUTPUTS. If your administrator has configured Adapt It to do so, Adapt It automatically assigns the export file a name and date-time stamp and saves the export file to the appropriate special folder. If your administrator has not configured Adapt It to use a special default folder, Adapt It opens up a standard output file dialog which you can use to change the name of the file if you wish, and/or store the exported file in some other folder or drive. The default name within the file dialog will be the same as for the document, but by ticking one of the check boxes at the bottom you can have Adapt It prefix a project name, or “interlinear_” to the name or add a date-time stamp suffixed to the name. Adapt It provides an .rtf extension.

Export Glosses As Text... 

This command is similar to the other export commands described above. All the glosses that exist in the document will be exported along with format markers that control chapter and verse marking. Other normally "filtered" information (including notes and free translations) is not included in the export of glosses.

The name of the export file and its saved location depend on whether your administrator has configured Adapt It to assign glosses text exports to special default folders for exports of the glosses texts. The assigned folder for glosses text SFM exports is _GLOSS_OUTPUTS. The assigned folder for glosses text RTF exports is _GLOSS_RTF_OUTPUTS. The assigned folder for Xhtml exports is _XHTML_OUTPUTS, and the assigned folder for Pathway exports is _PATHWAY_OUTPUTS. If your administrator has configured Adapt It to protect glosses text exports from navigation, Adapt It automatically assigns the export file a name and date-time stamp and saves the export file to the appropriate special folder. If your administrator has not configured Adapt It to protect such exports from navigation, Adapt It opens up a standard output file dialog which you can use to change the name of the file if you wish, and/or store the exported file in some other folder or drive. The default name within the file dialog will be the same as for the document unless you tick one of the check boxes at the bottom of the dialog to have Adapt It prefix “glosses_text_” to the name or add a date-time stamp suffixed to the name. Adapt It provides an appropriate extension for the type of export format (.txt, .rtf, xhtml, etc).

Export Free Translation... 

This command is similar to the other export commands described above. All the free translations that exist in the document will be exported along with format markers that control chapter and verse marking. Other normally "filtered" information (including notes and glosses) is not included in the export of free translations.

The name of the export file and its saved location depend on whether your administrator has configured Adapt It to assign free translation text exports to special default folders for exports of the free translation texts. The assigned folder for free translation text SFM exports is _FREETRANS_OUTPUTS. The assigned folder for free translation text RTF exports is _FREETRANS_RTF_OUTPUTS. If your administrator has configured Adapt It to protect free translation text exports from navigation, Adapt It automatically assigns the export file a name and date-time stamp and saves the export file to the appropriate special folder. If your administrator has not configured Adapt It to protect such exports from navigation, Adapt It opens up a standard output file dialog which you can use to change the name of the file if you wish, and/or store the exported file in some other folder or drive. The default name within the file dialog will be the same as for the document unless you tick one of the check boxes at the bottom of the dialog to have Adapt It prefix “freetrans_text_” to the name or add a date-time stamp suffixed to the name. Adapt It provides a .txt extension (or an .rtf extension).

Export Knowledge Base…
This command will export the knowledge base to a separate file on your hard drive or a removable disk. There are two types of knowledge base exports: (1) Standard Format, and (2) LIFT Format.  The standard format of knowledge base records is a plain text export in which each record looks like this:

\lx aso
\ge we
\del 0
\wc Bill Martin:BILLDESKTOP
\cdt 2010-11-30T03:05:01Z
\mdt 2011-08-12T07:13:03Z
whereas the same record in xml formatted LIFT export looks like this:

  <entry guid="EE236B90-5E63-43C1-A1FB-70603BB22CC3"
    id="aso-EE236B90-5E63-43C1-A1FB-70603BB22CC3">
    <lexical-unit>
      <form lang="lid">
        <text>aso</text>
      </form>
    </lexical-unit>
    <sense>
      <definition>
        <form lang="eng">
          <text>we</text>
        </form>
      </definition>
    </sense>
  </entry>
The LIFT format may be used to exchange lexical data with programs like WeSay or FLEX, but it does not retain the date-time information and deletion status of KB entries that the SFM format retains, so it is not as desirable to use as a backup format for your KB records.

Adapt It displays this dialog for you to choose the type of knowledge base export you want to produce:
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Select the type of export and click OK. 

The name of the export file and its saved location depend on whether your administrator has configured Adapt It to assign knowledge base exports to special default folders for KB exports. The assigned folder for KB SFM exports is _KB_INPUTS_OUTPUTS, and the assigned folder for KB exports in LIFT format is _LIFT_INPUTS_OUTPUTS. If your administrator has configured Adapt It to do so, Adapt It automatically assigns the export file a name and date-time stamp and saves the export file to the appropriate special folder. If your administrator has not configured Adapt It to use a special default folder, Adapt It opens up a standard output file dialog which you can use to change the name of the file if you wish, and/or store the exported file in some other folder or drive. The default name within the file dialog will be the same as current project name unless you tick the check box to “Use date-time suffix on export filename, in which case it will add “dictionary records” suffixed to the name and a .txt extension for SFM exports or a .lift extension for LIFT exports.

Import to Knowledge Base…
This command allows you to add entries to an existing knowledge base, by importing dictionary records of the same kind (SFM or LIFT) which are exported by the Export Knowledge Base command discussed above. The Import to the Knowledge Base dialog looks like this:
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SFM Imports
Select the “Standard Format (\lx and \ge)” option. For SFM imports to the knowledge base, the dictionary entries need to have a minimum of two field markers: the first must be \lx followed by one or more spaces, and following that is a source text word or phrase; then must follow one or more lines which contain some, or all, of the possible translations or the preceding source text word or phrase. The translation line(s) must begin with the marker \ge  followed by one or more spaces, then one of the particular translations.  For example: the following entry would cause the Takia word "naok" to be entered into the knowledge base with two possible translations (in English), "face" and "kind".

\lx naok
\ge face
\ge kind
The SFM records may also contain the \del, \wc, \cdt, and \mdt fields that Adapt It KB SFM exports include, but they are optional for KB imports. The records may be separated by one or more blank lines. You can omit the blank lines if you wish.

LIFT Imports
Select the “LIFT (XML) Format” option. When the records are input, the new knowledge base entries which they generate are appended to whatever is the contents of the knowledge base of the currently open project. If an entry is already in the knowledge base, then the new one is not added and is ignored. You can import as few as a single record; or as many as you like – there is no upper limit, except for what can fit on your hard disk.

After selecting the type of import (SFM or LIFT), Adapt It will show a file selection dialog. If KB inputs and outputs are protected, the file dialog will look similar to this (showing the files available for import – depending on the type of import whether SFM or LIFT):
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Using the Import and Export commands
These commands give you some versatility as follows:

· Use Export Knowledge Base (in SFM format) to provide a second way to back up the knowledge base, for example, you could export the knowledge base at the end of your work session, overwriting the earlier one of the same name exported at the end of your previous session; it takes only a few seconds.

· Use Export Knowledge Base (in SFM format) to send the knowledge base to another computer in a convenient form for the user at the other computer to add to his/her knowledge base, or fill an empty knowledge base with what was in yours.

· Use the Export Knowledge Base (in SFM format) to get a .txt file which can be opened in any word processor, where you can then search the records to see if certain words or phrases are present, either in the source text, or the target text.

· Use the Export Knowledge Base command (in SFM format) to edit the knowledge base 'off line'.

· Use the Import Knowledge Base (in SFM format) to restore a damaged knowledge base by an alternative means to the built in "Restore Knowledge Base" command.

· Use the Import Knowledge Base (in LIFT format) to quickly set up a knowledge base for a new adaptation project based on dictionary entries generated by other means (eg. a WeSay, FLEX, or Shoebox database of a linguistic study of a dialect related to the one you may be working in).

· Use the Import and Export Knowledge Base commands with two computers, each of which is working independently on different books within the same project. Each user can then generate a knowledge base which contains all the knowledge which is in the other person's knowledge base, by each exporting their knowledge base and giving it to the other to import the records. Each import that is done will import only those entries which are not already in that person's knowledge base.

· Maybe you can think of other ways these commands could be used. The above is probably not the end of the matter!

Import Edited Source Text…
You can now export a source text from Adapt It (USFM format), edit it in another editor, and bring it back into Adapt It using this command on the Export-Import menu. This command is new in Adapt It since version 6.0.0. Material that is unchanged retains all the adaptation information, but material that is new or altered appears as un-adapted "holes" ready for adapting. The document may then be saved manually if the result is satisfactory. The technology behind this feature is also used automatically by Adapt It when it is working in collaboration with Paratext or Bibledit.
Advanced Menu

See Glosses
This command allows you to see a glossing line and any glosses which have been entered previously in the currently visible part of the document. Clicking this command does not make the application switch to glossing mode however, it just makes glosses visible. When you choose this command, the application will put a glossing checkbox at the right end of the toolbar. The checkbox will initially be off (un-ticked) because the application is still in adaptation mode. To enter glossing mode you need to click the glossing checkbox on (ticked.) When on, the active knowledge base will be the glossing one, and the phrase box's line will display glosses and the phrase box itself is where you would type your glosses for each source text word. Any adaptations will still be seen, in the line below the glossing line, but will not be editable while the application is in glossing mode. Similarly, when in adaptation mode after choosing the Allow Glossing command, the glosses will be visible in the bottom line but will not be editable.

You can turn glossing on or off with the glossing checkbox as often as you like. If you want to merge some source words into a phrase, you have to be in adaptation mode – so you would need to turn glossing off, then you could switch back to glossing mode and gloss the phrase you just made if you wish.

Remember that the knowledge base commands in the File menu act on whatever knowledge base is currently active, and so those commands look at glossing checkbox to determine which knowledge base the command is to  be applied to.

When in glossing mode, the glosses you type can be single words, or phrases, or linguistic glosses – such as 2sg:SUBJ.run.PAST:PERF or similar complex expressions involving punctuation as well as text. The default behaviour when glossing is that any punctuation which you type will be entered into the glossing knowledge base along with the text. This makes it easy to type and store linguistic style glossing. 

By default, glossing uses the same encoding and font as the target text's encoding and font; however, glossing always uses the same colour as the navigation text in order to make it easily distinguishable from the target text. In some circumstances you may with to use a different encoding and font for the glossing language. The navigation text's language can be pressed into service to meet this need. Just choose the Advanced menu command: 

Glossing Uses Navigation Text's Font.  

The size and style settings for the navigation text will then be applied to the glossing text; and if you use the Export Interlinear Text… command on the File menu, and choose to export the glossing text, then the navigation text's font and encoding properties will be used in the export process for the glossing text too. The Fonts tab of the Preferences… dialog also allows you, in the Adapt It Unicode application, to set the directionality of the navigation text – it is left-to-right reading by fault, but a checkbox allows you to set it to right-to-left reading for languages which require it.

A good scenario for using the glossing feature is a cluster project. If a translation exists in one language of the cluster, the translation can be loaded into Adapt It as the source text, and this can then be glossed in a regional or national language which all the adapters in the cluster can speak. The resulting glossed documents can then be used as the starting documents for adaptations based on that source text into the other languages of the cluster. Whenever one of the adapters is not sure what the meaning of a source text word or phrase is, he or she can look at the gloss and then know how to translate the source text into his or her own target language.

Transform Adaptations Into Glosses
This command is very powerful. It enables an adaptations knowledge base, and documents in a project which have been adapted to some other language, to be transformed into a glossing knowledge base plus transformed documents (with the same source text) in which the adaptations have been changed into glosses.

Because this process will irreversibly change an adaptation knowledge base into a glossing knowledge base, the command cannot be used to transform the currently open project into a glossing form of itself. Instead, you have to be in some other project (it should be an empty one which you have just created and not yet created any documents within it) and then you choose the Transform Adaptations Into Glosses command and the application will then enable you in a dialog to access an adaptation project which is to have its contents transformed to glosses and copied to the currently open project. This process leaves the contents of the adaptations project unaffected; the transformed documents and knowledge base will appear in your newly created and currently active project, and the currently open project will have its adaptations current knowledge base contents added to by all the former adaptations  which have become glosses. The new project has no adaptations yet, so if See Glosses is turned on, someone can start adapting the source text in the new project, and be able to check what translations were used in the previous project as he or she works, because they will be visible as a third line in each strip. 

The application has to put up a few messages and dialogs in order to get the information it needs for processing the command, and also to make sure you are aware of the effects that will occur. The first message is the following:
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If you click the Yes button, you will proceed to the next dialog. If you have not just created a new empty project for the results to be stored in, you should click the No button. Note the message at the bottom of the dialog which tells you what to do if that is the case. After you click Yes you will see the following dialog which allows you to tell the application which project you want to be transformed:
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Proceeding with the operation will cause the English adaptations in the Swahili project to be turned into glosses in whatever is the current project – and that is the project which has empty glossing and adaptations knowledge bases because we have just created it and as yet have no documents in it.

If you see that there number of entries in either knowledge base is not zero, then your active project already has some data in it. Clicking Yes would mean that the contents of the knowledge bases would be lost, which is probably not what you want. If that is the case, click the No button and then go create a new (empty) project and try again. When you click the Yes button, you will see the dialog which allows you to specify which documents will get transformed. In our present case there is only one, and the dialog looks like this:
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Any documents which you don't want to be copied and transformed, click to select them and use the X button to move them to the right hand list. When you click the OK button, the documents remaining in the left hand list will be copied and transformed and will from then on belong to the currently active project. The original project from where they were taken is not in any way affected by this operation: its knowledge bases and documents remain unchanged.

In case you are not sure why this command would be useful, consider this scenario. A translator in a country where Russian is the trade language, has produced plain text standard format marked scripture files for a New Testament adaptation in the language X (this could have been done in Adapt It, or in a word processor or some other application.) When it is time for a consultant to check the translation, this translator creates a back translation project in Adapt It and he then does the back translating into the language of the translation checker, which in this scenario might be Russian. However, language X is related to language Y, also in the same country. There are bilingual speakers of Y who understand X reasonably well but not perfectly. One of these speakers wants to adapt X into Y. He too, of course, knows Russian. So, instead of throwing away the back translation project, somebody creates a new project for adapting X into Y, and then when the X to Y adaptations project is currently active, he or she uses the Transform Adaptations Into Glosses command, and in the dialogs which come up he or she accesses the X to Russian back translation project. The transformations which result from this makes the X to Y adaptations project have a fully populated glossing knowledge base in Russian, which gives glosses for the words and phrases of the source language X; and also all the documents for the whole New Testament copied to the X to Y adaptations project and are transformed so that the Russian back translations have been turned into Russian glosses, leaving the adaptation fields empty ready for the new translator to do the adapting from X into language Y. Anytime that the new translator does not fully understand the X source text's words or phrases, he or she can look at the Russian glosses to see what the intended meaning is, and hence know how to translate into the Y language at that location in the document.

Delay...
(See discussion of the Delay feature earlier in this document – in the discussion about Adapt It Modes)

Storing Documents in Book Folders...
(See discussion of “Book Folders Mode” earlier in this document – in the discussion of the Change Folder... command on the File Menu.)

Free Translation Mode
Free Translation Support
Adapt It gives great support for the consultant checking process. The two new features which are probably the most useful for this are Notes (discussed in a section below) and Free Translations. Adapt It permits you not just to type free translations (which, incidentally, are automatically stored as filtered information and therefore can be propagated to another project by means of an export of the target text), but it intelligently lays them out in a line below the strips in the main window - keeping the free translation close to the text it applies to and automatically sectioning it as necessary when the free translation spans two or more strips. To see the free translations laid out in the main window, free translation mode has to be turned on. The Free Translation Mode command on the Advanced menu does that (see the picture). You also must turn on this command in order to produce the free translations. The picture below shows some free translations, some license has been taken with the meaning in order to make them obviously different from the adaptation line's content. This section has been updated to reflect the free translation feature additions first released in version 6.5.2, December 2013.
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Before discussing this, note that if literalistic back translations had been typed into the glossing line, then we could have glossing mode on as well and have them also shown along with the lines shown above.
There are several things to note:
    * Free translations are done in a mode, and the mode severely constrains the location of the phrase box. If you click to reposition the phrase box it will do one of two things: if you click within an existing free translation section, the box will automatically locate itself at the start of that section; but if you click at a location where there is no free translation section defined yet, then a new section is commenced at that clicked source word's location.
* When you turn on free translation mode, the Compose Bar is automatically opened and it will contain a set of buttons which will help you to control the free translating behaviours. There are buttons to move back and forth in the existing free translation sections, find a new empty place to start a new free translation (the button for that is the Advance button), Shorten or Lengthen a section, and to indicate whether sections are to be defined using the location of punctuation as a guide, or on a verse by verse basis (although it only happens over a whole verse provided there are no significant standard format markers within the verse - if there are, then such a marker causes the existing section to be closed off and the next section will start at the next word). There is also a button to Remove a free translation. You may have to move the phrasebox to a different section and back again to make the Remove button become enabled. Once enabled, clicking it removes the current free translation.
* As of version 6.5.3, there are two new buttons. Adjust... and Join To Next. These were added because of difficulties users reported when the needed free translation did not fit within the available space in the current section. The older behaviour truncated the free translation, and put … at the end of the truncation. This was unhelpful to consultants using the mode for scripture checking purposes. So several new options were introduced – these are available from the dialog shown by the Adjust... button, and one of the options is repeated outside the Adjust button's dialog – the Join To Next button. More on these below.
    * Free translation mode makes use of backgrounding colour. Pink is used to indicate the words which you are providing a free translation for. Green is used to show you which words have existing free translations defined on them. White is used to show you which words are not yet free translated.
    * Free translations don't care about any retranslations that may be in the adaptation. You can halt and start a new free translation within a retranslation. You can place the phrase box within a retranslation in order to indicate where a new section is to commence, but only while free translation mode is on.
    * When Adapt It  is working out where it will end the next free translation section, it will start looking to see if there is any punctuation to help define where the section ends. Defining a section is done one at a time, and you then type your free translation; so if you don't like where the end has been put, you can use the Shorten or Lengthen buttons to change it. You can shorten to as short as a single word. You can lengthen as long as you like, or until you encounter a significant standard format marker, whichever comes first.
    * Some of the buttons may be grayed (disabled) if Adapt It figures out that using the button would be inappropriate. For free translations it is important that no adaptation text is missed out. If you had existing free translations either side of the current location, it would not be appropriate to shorten the section because you might forget to free translate the words missed by the shortening operation; likewise it would be inappropriate to lengthen the section because it would then encroach on the section which follows.
    * There is no button which moves a section's beginning to be at an earlier location. If the earlier location has no free translation defined on it, you can move the section to be there by clicking to place the phrase box there as you do when you want to edit a word in adaptation mode. But once a free translation section is defined, it's start is anchored to the location where the phrase box is while you type the free translation text. The only way you can move a section when it has been anchored is to use the Remove button. You lose the free translation text when you do that, unless you've saved it to the clipboard beforehand. To actually move the section to an earlier or later location will probably involve using the Remove button once each for the free translations which are located in the area where you want things to be different; and if so you are going to have to retype the free translations there for each such changed section. However for most people there should be little or no need to move sections around.
    * You type a free translation in the Compose Bar's edit box. It can be as long as you like, but if it is so long that it cannot be fitted within the document's layout of the words to which it applies, then Adapt It will lay out as much of it as it can fit, and put an ellipsis (...) at the end to indicate there is more to be seen, and at the same time it will open the Adjust... popup dialog to give you options that will avoid having the truncation.
    * If you click in an existing free translation, in the green backgrounded text, that section becomes the current one, its text is shown in the Compose Bar's box, and the backgrounding changes to pink for that section.
    * When you turn free translation mode off, the current contents of the Compose Bar's box are saved as the current section's free translation.
* Operations which don't depend on the phrase box being able to move to an arbitrary location can be done while in free translation mode. For example, you can click on any green wedge to open the View Filtered Material dialog, select any marker in it, cut or copy its content from the edit box, paste it in the Compose Bar's edit box, or cut and paste from the Compose Bar's box to the View Filtered Material dialog's edit box. You can even edit already defined free translations at other locations by using a green wedge click and editing the free translation in the dialog, and saving it. The main window will then automatically update to show your edited free translation text. Some people may prefer to edit at other locations this way rather than use the <Prev or Next> buttons. You can be in collaboration mode, you can save the document to the history, or even restore an earlier version from the history, free translation mode will work seamlessly with those options. You can also use the Clipboard Adapt feature while free translation mode is turned on – the free translation state will be restored after you close the Clipboard Adapt mode.
* Free translations, because they are stored as filtered information, are always available for viewing when free translation mode is turned off. Just click on the green wedge where you want to see the free translation. You can edit it there too, even though free translation mode is off.
    * By default, free translations are included in any standard format export. This makes them easy to propagate. The advantages of propagation of free translations are the same as for propagation of back translations.
    * The current free translation section, if there are no adaptations defined yet, highlights the text in the source line instead.
    * On the Advanced menu are two commands called 
Use Target Text As Default Free Translation and 
Use Gloss Text As Default Free Translation. 

These are toggles. (That is, each time you click it, it gives the opposite value. Click once to turn it on, click it again to turn it off.) If your free translation is often going to be pretty similar in meaning to the sum of the glosses in the gloss line, or the adaptations (or back translations) in the target text line, then you might consider turning on the relevant one of these two commands. What then happens is that when, in free translation mode, the phrase box moves to a new section, the Compose Bar's edit box will show you the collected text from whichever line you specify. (You don't have to have the glossing line visible for the collection to get its text into the Compose Bar's box for you.)
* The colour of laid out free translation text is set to purple. This color scheme currently cannot be changed. If users want to be able to change it, provision for that could be done in a later version on request. (The font and encoding used are as used for the navigation text.) In Adapt It Unicode it is possible to have the free translation text laid out right-to-left when necessary - just turn on the navigation text's checkbox for RTL directionality in the Fonts pane of the Preferences dialog.
Ideally, free translating should be done as late as possible. Editing of free translations is quite possible and fairly easy to do, but you would want to avoid having to do so if you can do so. The best time to do free translating is when the adaptation, and any back translating, has been made as accurate within Adapt It as it is possible to do so.
If you export the adaptation into Paratext and do significant editing of the adaptation there, then the translation within Adapt It will no longer agree with that within Paratext. Currently there is no way to re-import the edited translation back into the Adapt It document. So, if at that point you still want to do free translating with Adapt It you should probably do it as follows. Export the polished translation from Paratext as an USFM plain text file, create an Adapt It back translation project, and in that use the exported Paratext file as source text to create an Adapt It document. You can then use the free translation feature to add appropriate free translations. (You could also use the adaptations line for doing literalistic back translations too, if you want both back translations and free translations together. Collection and propagation options are the same as discussed earlier.) 
Free Translation Features Added In Version 6.5.3
The Adjust... button shows the following dialog:
[image: image168.png]R Git nstalston s on this computer, but you sill ave options.

You have the following Gitinstall options:

O Do not try toinstall Git at this time
ry
Do NOT install G, 1l use Adapt It without Gt or | willinstall Gt later.

® Download and install Git from the Interet.

“This option instals Git version 2.32.0. This option requires access to the Intemet and will ~
‘download about 47MB of data. A copy of the Git installer is saved to the Adapt It nstallation

(O Browse this computer to find s Gitnstller

“This option instals Git using a previously downloaded Git installer. Gt can be installed this

way without accessing the Internet.

Please select the option you want above then click OK.





If you click Cancel, the dialog goes away and no changes are made to the current section. To make a choice, click the radio button for your choice, then click OK.
When the user's free translation is appropriate for the current section, but the section lacks enough space to display it all without truncating its end, two options are provided. To join – either ahead or backwards. (In version 6.5.2, “wideners” were offered as an option. This option has been removed permanently in 6.5.3 – they were not very useful and cluttered the document.)
What are wideners really? They are just a Placeholder with two new characteristics. First, they have 5 dots instead of three. Second, they will not accept typing if you put the phrasebox at one and try to enter some text.
If you have a document with wideners you've inserted in it, here is how to remove them. The normal way to remove one (it has to be done one at a time), is to do the following steps:
Step 1. Exit from Free Translation Mode
Step 2. Place the phrasebox at the widener.
Step 3. Hit the command bar button, “Remove Placeholder”.
Step 4. Repeat steps 2 and 3 for any other wideners you want to get rid of. 
(It is always safe to remove wideners, nothing will break.
Step 5 (Optional). Go back to free translation mode if you want to do more work there.
Join to next. This option joins the current section to the section which follows. If no section follows, then one is created automatically, and then the join takes place. However take note: joining across a verse boundary is prohibited, so if a verse follows the current section, try joining instead with the section which precedes  - that will work so long as the current section is not itself the start of the verse. When the join is done, the location of the cursor is automatically restored to where it was before the join. The free translations are joined too.
Join to previous. This options joins the current section to the section which precedes. If no section precedes, then one is created automatically and then the join takes place. As noted just above, joining across a verse boundary is prohibited – so if necessary, try Join to next instead. When the join is done, the location of the cursor is automatically restored to the start of the previous section. The free translations are joined too.
Split the typed text. In the past, users could type into a free translation section far more than is appropriate for that section, because they failed to notice that their eye is still moving forward and reading text which does not have pink background colouring (and so lies beyond the end of the current section). There was nothing to stop them typing dozens of words too many. Now, overtyping is limited to how much display space is available in the current section. Once that limit is reached, the Adjust Section or Typing dialog will automatically open – and normally the user will then use the Split the typed text option to split off the first words of what he typed so they stay in the current section, and the rest of his typing will be moved into the next section – where another Split can subsequently be done if needed, as often as necessary.
When you choose Split the typed text, it is not yet known just where in the free translation the split into two parts should occur. Adapt It cannot guess, so it puts up a further dialog as follows.
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When it appears, the top two boxes display the adaptation text, and the current free translation that the user has typed up to this point. The cursor will be shown in the middle of the Free Translation box, which might be between two words, or within a word. However, it is up to you, not the program, to decide where to make the split. You do so by clicking between two words, or, by clicking on whichever word is to be the first in the remainder text which is to be sent to the next free translation section.
Suppose you decide that it should be split between the words “ago” and “and”. This is what you would see if you clicked on “and” and then click the Split button:
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The dialog is not finished when you have clicked Split. You might have made a mistake and want to split at some other place. If so,  just click at the other place in the Free Translation box, and click Split again. Repeat as often as you like until you get the two free translation parts exactly as you want them, then click Done to end the dialog, and the program will then distribute the two parts into the sections to which they belong. Note, none of the text in this dialog is editable; all you can do is decide where to split it. Or you can Cancel and no changes will be made.
Collect Back Translations…
This menu item simply collects words on a verse by verse basis, and stores them as filtered information, adding a \bt marker. The collection can be done from either the contents of the adaptation line, or from glosses that have been entered in glossing mode. The usefulness of this feature is simply that it is a handy way to export the collected information into a USFM marked up text that is going to be the source text in a new project. The collected information will then be available within that new project by clicking the View Filtered Information dialog, and selecting the \bt marker – then what was done in the previous project, at that location in the document, can be inspected. See the section below which discusses Propagating Information, for more details.
Remove Back Translations
This menu command just removes any collected back translations currently stored as filtered information in the document.
Back Translation Support and Propagating Information
In version 3, as was also the case in earlier legacy versions, there were two possible ways for creating back translations in an Adapt It document. The first way was to use glossing mode, and in the glossing line type in literal back translations. The disadvantage of this way is that in glossing mode it is not possible to merge words into phrases, do retranslations, or insert placeholders in which extra back translation can be typed as needed. As a result, if the back translation did not communicate the meaning of a passage well (which typically would be the case for a back translation language unrelated to the target text's language), then tough, you couldn't do much about it.
To get around this difficulty there was, and is, a second way to do back translating. The user exports the target text (the adaptation) as a standard format plain text file. He then, if he has not done so earlier, creates a new adaptation project dedicated to doing the work of back translating. For each document he creates in that back translation project, he uses the exported target text from the first step as the source text. The adaptation line each document is then available for doing the back translation. This way has the advantage that when the meaning of the back translation does not turn out too well by doing it word by word, he has some extra power to take advantage of. He can insert placeholders to add helpful text (perhaps in [brackets] to indicate it is not part of the meaning of the translation), he can merge words to form phrases so as to reduce the syntactic mismatch between the translation language and the back translating language. and if necessary he can use the retranslation feature to handle stuff which the former two techniques don't adequately handle.
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Since version 3 Adapt It does not introduce a special custom back translation line in the display dedicated just to that particular task, but it does have some extra functionality to make the techniques described in the above two paragraphs more useful - particularly in a multi-language cluster project. All that the legacy versions could do with the typed back translations was to permit them to be exported within the information included in an interlinear export. While that was, and will continue to be, a useful way to make use of the back translation, it lacked one important feature - it was not possible to propagate a back translation from one adaptation project to another. For example, if you adapted from language A to language B, and produced a back translation of the B translation in language C (perhaps English), and then you took the B translation and in a separate adaptation project you adapted that particular translation to language D (another one in the same language cluster), there was no way that you could associate the earlier back translation with the translation in language D. You had to type it all over again. The problem with that was that the two back translations, while not being identical, would nevertheless be very similar and identical for many short stretches. That state of affairs was not satisfactory, so versions since version 3 have a Collect Back Translations... command on the Advanced menu to help you out some more. It puts up the dialog shown below.
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The collecting operation can be done over the whole document, or just within the scope of a selection. The collecting of text is done either from the text in the glossing line, or from the text in the adaptation line, and the dialog permits you to choose which is the case.
What is involved in the collection operation? Adapt It scans through the document, or through the selection if there is one, and groups sections of the text into a long phrase, puts a \bt marker at the start of each such phrase, and then squirrels the resulting marker plus content away as filtered information at the location where each section of collected text starts. What guides Adapt It in defining how much to put into each section? Well, it does it over each verse - but it does it over shorter sections if it encounters a standard format marker of sufficient importance that it deems that the collection should stop there and recommence at that standard format marker's content. This process is fully automatic, and it generates intelligent collection groupings which you should not ever need to alter. The knowledge of which markers are sufficiently important that they should halt collection and cause a new section to begin is built into Adapt It and some of it is provided by the AI_USFM.xml control file; so you don't have to worry about it yourself.
You are probably wondering why this is of any use? After all, it is only collecting information that is already there and visible to the user. The secret is the fact that the information gets stored away as filtered information. Filtered information has the useful property that by default it is exported along with a source text, or target text, standard format export of the document. Did I hear you say 'So what?' Well, anything that is exported as a standard format plain text file is immediately, and without any additional change, able to have ALL its contained information imported into any other project to form a document in that project. So, if the file contains formerly filtered back translations, then the new document in the other project will contain those back translations automatically, filtered, ready for whatever use you wish to make of them.
For example, after the person doing the adaptation in that project has produced his first draft, he might like to click on the green wedges to open the View Filtered Material dialog at each location, to examine how close in meaning is the imported back translation to the new adaptation. If there are any differences, he then has the option of editing either the adaptation (if he thinks the earlier back translation states the meaning better) or the old back translation (to make it agree precisely with the new adaptation.) The important point is that the whole back translation does not have to be retyped from scratch in the new project. It has been propagated from the old project to the new project. Propagation can save heaps of typing time, if used with care. (The danger of propagating information from one project to another is that unless it is checked, and edited if necessary within the new project, it is probably going to be misleading if relied upon without warranted editing changes being done. User beware!)
A second use he might make of this propagated information is as follows. He may not be fully bilingual in the source language. So any time he is not sure what the source language is saying, he could examine the propagated back translation at that point in the text to see what meaning it had in the earlier project's document at the same location. This can help him to get the right meaning and stop him from getting bogged down by his lack of fluency in the source language as he does his adapting work.
If, for consultant checking purposes the consultant considers that a propagated back translation should not be relied on, a command on the Advanced menu, Remove Back Translations, permits the user, or consultant, to delete all the filtered back translations stored in the document by a single click. The user can then redo the back translating from scratch by one of the two methods described above in the first two paragraphs of this section.
Individual back translations can be deleted by the button for that purpose in the View Filtered Material dialog. To replace or update a back translation at just a certain part of the text, or to replace or update a number of back translations over a short section of the document, a selection can be used to define where the replacements or updating is to take place. The rules for doing this which guide Adapt It in the process are as follows:
·     The start of the selection is important. If a back translation starts there already then its content is updated, if one does not start there, then a new back translation marker is created and stored there (and a new green wedge would appear).
·     The collection operation goes only up to the end of the selection, or as far as the next \bt marker (or any marker beginning with the three characters \bt), whichever comes first.
·     Because important standard format markers halt collection and initiate collection of the next section, it is quite possible that the second of the above two rules may produce more than one instance of a filtered \bt marker and its content within the one selection. This is normal and it is what you would want to happen. The thing to be careful to do is to make sure that the selection is long enough to include all the words you want included in the collection, or updating of an existing collection. A good place to end the selection is therefore on the word immediately preceding a green wedge. Don't include the green wedge as the last word of the selection - that would make the last collection contain only the word or phrase which occurs at that last green wedge.
What happens if you have an existing set of filtered \bt markers, with their associated content (whether produced by a collection operation in the document earlier, or propagated into the document from a different project's document), and you then invoke the Collect Back Translation... command without having any selection defined? Adapt It will re-collect over the whole document, wiping out the earlier collection information and replacing it with the sectioned text contents from the gloss or adaptation line (depending on which you choose) as they currently are at that time. You can do this anytime, as often as you like. The content within the old collections is gone for good, so don't do it unless you mean it.
Can you shift material from one back translation to another? Yes, but it is tricky. Cutting and pasting between the content of \bt markers as displayed in neighbouring View Filtered Material dialogs is easy enough, but doing that does not move the green wedge to a new location, that has to be done as a separate step. You would click on the wedge that needs to be moved, cut or copy its back translation to the clipboard, then use the Remove Back Translation button to clear out the back translation from the filtered information at that part of the document. Then close the dialog. Make a selection of appropriate length, starting at the location where the edited back translation should commence, then invoke the Collect Back Translations... command, specifying one or the other line as the source of the text (doesn't matter which because you are going to overwrite it later anyway). After that is done then click on the newly placed green wedge, click the \bt marker, select any text in the edit box and paste the clipboard contents over it. Close the dialog - you've done it. That ought to convince you that you don't want to mess with moving back translation material around if you can help it. But it can be done.
Use Transliteration Mode
This is functionality new to version 3.1.0.
This feature was designed by Bob Eaton, and it is meant to work in conjunction with a configured SILConverter (such as a transliteration converter) to do complex transliteration within Adapt It. This mode permits the user to set up a transliteration project to convert source text words in some script (for example, Devanagari) into another script (such as Arabic). This is primarily for use when a character or algorithm-based transliterator alone cannot transliterate accurately between scripts due to inherent ambiguities between the writing systems. Such a complex transliteration process can be improved upon by using Adapt It to maintain the database (knowledge base) of lexical exceptions to the algorithm-based transliteration process.
The thing to note here is the difference in behaviour between Transliteration Mode and the normal Adapt mode that you may be used to. In the normal adaptation and glossing modes, all words are entered into the Knowledge Base whether they are accepted as is or whether they are re-typed and then accepted. By contrast, in Transliteration mode, you use a special key sequence to step through the text, which determines whether the word is added to the Knowledge Base or not. The key sequences that are active in Transliteration mode are:
·       ENTER -- As with a normal adaptation project, hitting the ENTER key will cause the current word—whether retyped or not—to be added to the Knowledge Base (as an exception).
·       CTRL+ENTER (i.e. hold down the CTRL key and press the ENTER key) -- this key sequence will cause the Adapt It project to remember the source word—so that subsequent occurrences of it will be automatically skipped over—but it will also indicate that it isn't an exception. Instead of a normal record in the Knowledge Base, Adapt It will store a null record (that is, <Not In KB>) to indicate that the source language word has been dealt with fully adequately by the transliterator algorithms, but Adapt It won't save a corresponding target language word for the given source language word.
This mode can be used in conjunction with an algorithm-based transliterator in the following manner: The algorithm-based transliterator (configured as the SIL Converter as discussed above) is used to process the source language (script) words producing an attempted transliteration. If the transliteration is correct, then you type CTRL+ENTER to indicate, "I've dealt with this word, but the algorithm-based transliterator works just fine." If the transliteration is not correct (e.g. this word contains a non-systematic ambiguity between the two scripts), then you retype the correct transliteration and hit the Enter key to save this exception in the Knowledge Base. Either way, you only deal with each word-form once: either the configured SILConverter transliterator will do the correct job (CTRL+ENTER = null KB record) or you will type in the correct transliteration and save the exception record (ENTER = regular KB record).
There is visual feedback given to show you the result: when you type CTRL + ENTER, an asterisk (*) is shown in the navigation text area, above the source wordform (and all subsequent occurrences). The asterisk says, in effect, "The algorithm-based transliterator got this particular word correct." But when the user edits the phrase box contents to produce the correct transliteration and presses ENTER (to cause the normal KB storage of that wordform), then no asterisk will be shown above the source wordform. The lack of the asterisk says, in effect, "This word is an exception to the algorithm-based transliterator and requires an exception record to be stored in the KB."
Once the knowledge base is populated with exception records, it can be used to transliterate between the two scripts in other SILConverter client applications, such as FieldWorks, Word, etc. See the SILConverters help for the AdaptIt Knowledge Base Lookup converter and the Primary-Fallback compound converter for more details.
There is an alternative shortcut which can be used instead of CTRL + ENTER, it is ALT + BACKSPACE. There is no difference at all in what they do, just choose whichever appeals to you as the easiest to use.
Now, all that might seem a little obscure, but really it is quite simple. It reduces to the following simple rules... follow them and let Adapt It do the rest for you. Rules 5 and 6 are the two which you would use over and over again to get the job done.
1. Make a project expressly for doing transliteration (as opposed to adaptation). But instead of source and target language names, you use source and target script names instead.
2. Configure your algorithm-based transliterator (e.g. ICU transliterator, CC table, TECkit map) as the converter to be used to preprocess source language (script) words by using the Tools, SIL Converters... and Use SIL Converter commands.
3. Put the phrase box at the start of the Adapt It, or Adapt It Unicode, document. Make sure the Automatic checkbox is ticked (it's on the Mode bar).
4. Click the Use Transliteration Mode command on the Advanced menu.
5. Inspect the phrase box contents. If it is incorrect, then edit its contents to give the correct transliteration form and then press the ENTER key.
6. If the content of the phrase box are already correct, then press the CTRL + ENTER key.
7. Repeat 5 and 6, working through the document, until it is done. You can save at any time, or let 
auto-saving do it for you.
8. When you exit from the application, if you are asked to save your changes, do so.
Setup Or Remove Knowledge Base Sharing...
(To be implemented in a future version)
Controls For Knowledge Base Sharing
(To be implemented in a future version)
Discover KBservers
(To be implemented in a future version)

Layout Menu

The Layout Menu is only visible in the Unicode version of Adapt It. It has a single menu item which is a toggle item that reads either “Layout Window Right To Left”, or “Layout Window Left To Right”. These commands are available in the event that the application does not correctly align text in the window that should be rendered Right-to-Left, or Left-to-Right. 

Help Menu

Adapt It Quick Start Help
This Help menu item loads the HTML document “Adapt_It_Quick_Start.htm” into your web browser. It contains information on getting started quickly with Adapt It. 
Help Topics
Help Topics is an extensive HTML Help system that is organized by topics. These helps are in the process of being revised. They are very informative, but some of the information and screen shots reflect version 4 of Adapt It. If you need help with setting up collaboration with Paratext or Bibledit, please refer to the Help_for_Administrators.htm document (which is available from the Administrator menu via password).
Report a Problem…
Adapt It version 6 introduced an email reporting system that allow the user who has Internet access to directly send a problem report to the Adapt It developers – with or without the users email program. The Report a Problem dialog looks like this:
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When this email report is used it can greatly help the developers because it automatically collects and makes available the user’s “System Information”. The “Usage Log” if included, tells what features of Adapt It were being used when a problem occurred. The user can also click on the “Attach the document (packed)” button if a document is currently open and the document might illustrate the problem that the user encountered. Note: Sending an email report directly from Adapt It via secure SSL connection may not be enabled depending on the state of the server at adap-it.org. If that is the case, you can still send a report to your own default email program, if you have access to an email account and a default email program set up on the computer.
Give Feedback…
The Give Feedback is similar to the “Report a Problem” dialog and looks like this:
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Use the edit box and its sample feedback text as a guide for providing feedback. Adapt It is provided free to all users anywhere. The developers appreciate all feedback from its users. Feedback can encourage the developers to improve Adapt It and make it a better tool for your translation work. Like the Report a Problem dialog, this dialog collects system information and makes it available, copying it to the user’s email program for sending along with the user’s feedback.
Use Tooltips 
Tool tips are used throughout Adapt It. They popup as temporary help messages when a user hovers the mouse button momentarily over a menu, toolbar button or an element in a dialog. If these become too distracting, you can turn off the tooltips by clicking this menu item. It works like a toggle to either turn the tooltips on or off.
About Adapt It…
The About Adapt It menu item displays a dialog containing information about the Adapt It program and the computer it is being used on. It displays information about the version of Adapt It, its release date, the developer’s email addresses, the version of the wxWidgets library used, and the “Language and Locale Information” in effect for the running program. If you communicate with the developers about Adapt It, please include the version and date information in your communications. See the “Report a Problem” and “Give Feedback” menu items above for the most convenient ways to communicate with the developers of Adapt It.
Administrator Menu

The Administrator menu is normally hidden from sight. Access to the Administrator menu is password protected to give program administrators exclusive control over certain features of Adapt It and its interface that are not intended to be easily accessible to normal Adapt It users. The menu can be made visible on the menu bar by going to the Edit menu, selecting Preferences…, clicking on the View tab of the Preferences dialog, and then clicking the check box labeled [ ] Show Administrator Menu (Password protected). The Administrator menu looks like this:
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The Administrator menu now supports extra capabilities of interest to the administrator of a language program. The following features have now been implemented on the Administrator menu: 
   (1) Help for Administrators (HTML)
   (2) Setup or Remove Collaboration…
   (3) Manage Data Transfer Protections to Paratext or Bibledit…
   (4) Force Free Translation Sectioning By Verse
   (5) User Workflow Profiles… & Turn OFF the current user profile temporarily
   (6) Assign Locations For Inputs and Outputs…
   (7) Move Or Copy Folders Or Files…
   (8) Set Password…
   (9) Custom Work Folder Location…
   (10) Lock Custom Location
   (11) Unlock Custom Location
   (12) Restore Default Work Folder Location
   (13) Show DVCS version...
   (14) Knowledge Base Server Manager... (to be implemented in a future version)
Help for Administrators (HTML)
As an administrator, if you select this menu item Adapt It will load an HTML Help file called “Help_for_Administrators.htm” from the Adapt It installation on your computer into your browser (or a special HTML viewer if your browser is not set to automatically open files of type .htm). You should read that file which goes into much more detail than this document does on how to use the items on the Administrator menu. Here we only give a short summary of each item on the Administrator menu. The Help_for_Administrators.htm HTML help is also available to view online at: https://adapt-it.org/Help_for_Administrators.htm. 
Setup Collaboration…
This menu item allows an administrator to set up Adapt It to collaborate directly with Paratext (versions 7.x, 8.x, or 9.x) or Bibledit. Paratext or Bibledit must be installed and its projects set up first BEFORE Adapt It is configured to collaborate with those projects. When collaboration is set up and turned ON, Adapt It automatically obtains its source texts from a Paratext or Bibledit project, and automatically transfers adapted translation (target) texts back to Paratext or Bibledit.  No more exporting and copying of files manually back and forth between Adapt It and Paratext or Bibledit! See the “Help for Administrators (HTML) document from the Administrator menu or directly online at: https://adapt-it.org/Help_for_Administrators.htm for more details.
Manage Data Transfer Protections to Paratext or Bibledit…
After drafting books within Adapt It, a team will eventually do their revisions and polishing of the translation in Paratext/Bibledit. It can be helpful, however, to bring the revisions that are done to those polished books back into the Adapt It documents in order to keep its knowledge base up to date (for more accurately adapting other books/chapters). This menu item allows an administrator to prevent the saving any changes made within Adapt It after a certain point from being transferred over to the already polished documents in Paratext/Bibledit. By setting up data transfer protections for certain books/chapters allows the team to keep Adapt It’s knowledge base up to date for more accurate adaptation of future books, without the user having to worry that the update process would disturb or overwrite those books/chapters within Paratext/Bibledit. See the “Help for Administrators (HTML) document from the Administrator menu or directly online at: https://adapt-it.org/Help_for_Administrators.htm for more details.
Force Free Translation Sectioning By Verse
The default sectioning in Free Translation mode is by “Punctuation”. However, this menu item allows an administrator to force all free translation sectioning to be done by verses – or by major USFM marker, and keep sectioning free translation by verse each time the free translation mode is turned on. See the “Help for Administrators (HTML) document from the Administrator menu or directly online at: https://adapt-it.org/Help_for_Administrators.htm for more details.
User Workflow Profiles… 
Turn OFF the current user profile temporarily 
Adapt It has many menu items and features to choose from. Such choices may be bewildering to a new user or inexperienced user. Adapt It now allows an administrator to control which choices appear in the program's interface, and which others remain hidden until such time as they may be needed. Adapt It provides some pre-defined user profiles which include “Novice”, “Experienced” and “Skilled”. There is also a “Custom” profile which can use the settings from one of the other profiles as a starting point. All profiles can be further customized so that individual interface elements can be hidden or shown according to the administrator’s preference for a given user. Another menu item in this group is “Turn OFF the current user profile temporarily”. This item is provided so that administrators who are examining a user’s computer can temporarily access all of the interface items (as though the None user profile is in effect). See the “Help for Administrators (HTML) document from the Administrator menu or directly online at: https://adapt-it.org/Help_for_Administrators.htm for more details.
Assign Locations For Inputs and Outputs…
Adapt It now allows the administrator to pre-assign locations for Adapt It's inputs and outputs, and therefore protect the user from having to compose file names and from having to navigate the file system to find or save files. Protection is provided automatically for source text inputs and adapted text exports when collaboration with Paratext or Bibledit is ON. The other types of inputs and outputs can also be protected according to the wishes of the administrator. See the “Help for Administrators (HTML) document from the Administrator menu or directly online at: https://adapt-it.org/Help_for_Administrators.htm for more details.
Move Or Copy Folders Or Files…
This menu item brings up the following dialog which can be used by the administrator to move or copy files and folders from one folder location to another folder location:
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Read the warning and instructions in the text box at the top of the dialog. When the dialog appears it automatically displays the default work folder’s contents in the list on the left. The administrator must use the Locate the destination folder button (above the right hand list) and navigate to select a destination folder where the move or copy operation is to be done. The source folder can also be changed by use of the Locate the source folder button above the left hand list. Double clicking on a folder in a list opens that folder and displays its contents. The buttons with the yellow folders and green up arrows can be used to reopen a parent folder. Copying and moving is always done from the left list to the right list. Moving or copying a folder moves or copies all its contents. Selections in the right hand list allow you to delete or rename what you select.
Set Password…
The Set Password command brings up the set password dialog:
[image: image106.png]Type Adminisrator Password

Accss to Admnsratorprivieges equres hat you type a pasonord
T

(o) Comai ]





where an administrator can set a password used to access the Administrator menu and its features. The password you enter here is stored in the basic configuration file. There is a failsafe password that will always work. See the Adapt It changes.txt file for more information.
Custom Work Folder Location…
This menu item can be used to either (1) set a temporary custom work folder location on the local machine, a peripheral device, or a remote machine - including a remote machine running a different operating system. Without locking the custom location (see below) this menu item simply allows you to browse to a folder where Adapt It projects are located and look around or do some work there on a temporary basis – the switch to a custom work folder only lasts until the end of the session; (2) set a permanent custom work folder location on the local machine or on a peripheral device attached to the local machine. 
With (1), it is quite possible that more than one instance of Adapt It may attempt to access the same project at the same time on a given computer. In such cases Adapt It now has a read-only projection mechanism in place to protect the data on the machine (see Automatic Read Only Protection below).
Lock Custom Location
This menu item is enabled provided the path to the custom folder is not a path accessible as a network share. When activated the work folder at the custom location becomes permanent, until explicitly changed at some future time (see Unlock Custom Location feature below).
Unlock Custom Location
This menu item is enabled provided the path to the custom folder is not a path accessible as a network share, so that the persistent work folder custom location becomes temporary - i.e. the path will be forgotten when the current session ends.
Restore Default Work Folder Location
This menu item restores the default work folder location (including returning to the use of a work folder location set up earlier by the -wf command line switch). If this command is used when a custom work folder location has previously been made persistent, then Adapt It does an implicit call of the Unlock Custom Location feature as part of the process of returning to the use of the default work folder at the default location. Note: there may not be any projects at the default location, so returning there may also require moving project folders back there from the former custom work folder; that task can be done by means of the Move Or Copy Folders Or Files menu item of the Administrator menu (see below), or by using a file browser application outside of Adapt It.
Show DVCS version...
Shows the version of git that is installed, if any, in the system.
Automatic Read-Only Protection
If an administrator navigates, using the Custom Work Folder Location command, to a remote machine's Adapt It project folder which is currently in use by the remote user, the data in the remote user’s project folder which is currently in use by the remote user will be protected from being changed by the administrator, and the administrator will only obtain read-only access - any kb or document saving attempts by the administrator user will not do anything. Read-only protection works like this: Whichever of two users who first accesses a given project will get ownership write privileges within the project folder, the user who arrives at the project folder second, will only get read-only access (actually, he will be able to do things normally on the local copy in memory from the remote machine's drive, but any attempt to save work to the remote machine will only simulate a successful save, in actual fact, no save is done). 
This protects the remote user from unknowingly losing work because of actions done by a snooping administrator from a different machine somewhere on the local network. Whoever gets ownership of the project folder for writing, Adapt It will save a "lock" file with name that looks like this in the project folder being accessed:
"~AIROP-machinename-username-processID-SYS.lock"
This lock file is held open it for writing – to signal that the project folder is locked by the one described in the components of the lock filename. Adapt It will fill in machinename, username, processID and SYS with the appropriate names automatically retrieved from the machine which is running the Adapt It instance that succeeded in obtaining ownership for writing. When no such file is present in a folder, the next person entering that folder will get ownership of it. The management of this functionality is totally automatic, no user or administrator need do anything in normal operation. Ownership is lost when you leave the project folder. It is gained when entering the project folder, provided no one else already has ownership.
Whenever you open a new document in the project, an attempt is made to give you ownership rights - but you won't get them unless the previous owner has relinquished the project folder. This protection functionality is "always turned on". It can't be turned off. It works whether or not you are trying to access a folder on a remote machine, or just doing your normal work on your own machine. If you run two instances of Adapt It on the same computer, and both attempt to gain access to the same project, the first to gain access will have write access, the other will have read-only access.
A special case ensues if the administrator gains full access to a project on a remote machine and a user on the remote machine then tries to open that project which exists on his own local machine. He will be allowed to have either read-only access (the usual case), or if his computer has a Linux or Mac operating system, he can gain full write access. If he opts for full write access the administrator's access will immediately switch to read-only access in order to protect data integrity. When a user has read-only access (whether local user or administrator a project remotely), he will not be able to write KB or documents to disk until the other user having write access has relinquished ownership of the project. Gaining write access after having read-only access (and after the other user relinquishes ownership of the project) requires that the current user close the document or project first, then reenter the project. That is, whoever opens the project first, gets ownership; whoever arrives second, only gets read-only access and must close and reenter to gain write access once the first user has left the project. This protocol prevents inadvertent loss of data.
Note: Adapt It’s automatic read-only protection mechanism also is used when an advisor or consultant opens the user’s project and selects the option “Read-only mode (All texts accessible but not editable – I’m an advisor or consultant)”. The mode helps ensure that the advisor or consultant does not make any unintentional changes while examining the user’s text files.
See also Saving Versions in a Document History (and Roll-back) section (discussed with File Menu commands).
Resolving Font Mismatches
If an administrator navigates, using the Custom Work Folder Location command, over a network to a remote machine's Adapt It project folder, Adapt It tries to substitute a suitable font on the administrator’s machine to match what was used on the other computer. If no font with the same face name exists on the user's own computer, Adapt It will attempt to find fonts with a similar encoding. If that fails, the administrator will be notified which fonts could not be found, and Adapt It will automatically select and use system fonts instead. If the system font does not render the text correctly, it may be necessary for the administrator to select a suitable font from his own Preferences (on the Edit menu), or if no compatible font is available on his computer, he may need to first install fonts that are compatible with the fonts used on the other machine on the network. This may happen especially if the other machine being accessed uses a different operating system - such as when a Windows computer accesses an Adapt It project on a Linux or a Mac computer, or a Linux or Mac user accesses an Adapt It project on a Windows computer, etc.
Notes Support
Since version 3 Adapt It includes support for Adapt It Notes. These notes are not the same as Paratext notes. USFM has support for notes in scripture using \n or \nc markers. Adapt It notes are not meant to ever be included in Scripture, they are intended for comments placed within the adaptation document for some purpose. Typical uses will be to explain adaptation decisions, explain keywords used the adaptation, to guide adapters regarding exegetical decisions or other translation issues, to ask questions of a consultant about how to translate something or for a consultant to ask questions about the adaptation, back translation or free translation. We expect that many people will use them to help in the translation checking process. A consultant could review the document on screen, and add comments and questions at any point where checking is needed.
Adapt It notes are marked with a \note marker, and end with a \note* end marker. Adapt It creates the markers for you. These notes are always filtered (hidden), and so they can be viewed at any time in the View Filtered Material dialog by clicking the green wedge where they are stored in the text, or in the note dialog itself by clicking the notepad icon next to the green wedge. 
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The above picture shows the command bar for version 3: it has four new buttons - all for notes support. They are buttons 8 to 11from the left. The first creates an empty Note dialog; or if there is already a note at that location, the Note dialog opens and the note is displayed in it. The next button with a green arrow to the left, opens the previous note, the following button with the green arrow to the right opens the next note, and the button with the red cross deletes all notes from the document (this deletion is not reversible, so only do it when you mean it).
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The picture above shows the Note dialog with some text typed into it. Read the text to find out a little more about notes. The <Prev and Next> buttons work the same as the buttons on the command bar; use the <<First or Last>> buttons to jump to either the first note in the document, or the last one. The text size in notes is set to be 12 point only.
The place where notes are stored is indicated by a peach coloured small square icon next to a green icon. Click on the note icon and the note stored there will be shown in the note window, and the word or phrase where you clicked will be shown with light yellow highlighting so that you can keep track of which note you are viewing. You can click in the main window while the dialog is open, because the Note dialog is not modal. You can also click another note icon while the Note dialog is showing you a different note - doing so closes the currently open note, automatically resaves the note contents (as if you had instead clicked the OK button), removes its dialog, and then immediately opens the other note at the clicked location. This behaviour allows you to click around on various visible note icons safely, until you find the particular note you are looking for.
Because notes are filtered automatically, they can be exported - either in a standard format export, or in an RTF export - including an Interlinear export. When exported as RTF they can be viewed in a printed document either as margin comments in bubbles (like comments in MS Word or OpenOffice documents), or as footnotes - the export dialog allows you to choose how they are to be displayed - the default is to show them in margin text bubbles. Also, again because notes are filtered, they can also be read and edited in the View Filtered Material dialog - by clicking a green wedge and then clicking the \note SF marker if it is not already selected. You cannot have both the View Filtered Material dialog and the Note dialog open at the same time. Finally, notes exported in a standard format export can be propagated into a new project's document simply by creating a document in the new project using the standard format exported data which includes the notes.
Propagating Notes, Back Translations and Free Translations 
to Other Projects
Adapt It always automatically filters any notes you create, any back translations created with the Collect Back Translations command on the Advanced menu, and any free translations produced by clicking the Free Translation Mode command on the same menu.
As explained in several places above, anything filtered automatically gets exported by default in a standard format export - whether a source text export or a target text export. The Adapt It parser knows how to handle such information when it occurs in a file used for creating an Adapt It document - which means that it goes seamlessly into the newly created document, is automatically filtered, and is available where you expect it to be on demand - by clicking either the note icon, or the green wedge icon, or by turning on free translation mode to have free translations laid out for viewing in the main window.
The picture below shows the dialog you get when you click the Export Translation Text... command on the Export-Import menu. Note the “Options” button next to the “Filter out selected markers and text” selection.
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You get the above propagation behaviour for filtered information without having to do a single thing. It's the default behaviour. However, if you want to exclude certain filtered information from appearing in the export - an Export Filter/Options dialog permits you to exclude certain standard format markers (and hence, the content associated with them) from being included in the exported data.
The Options… button opens that dialog, pictured below.
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The default is to output all filtered information - the dialog opens with the top radio button selected. The picture above shows the dialog after the lower radio button has been clicked. That makes the information in the list of markers become enabled. Markers which cannot ever be excluded from the export are not listed. The check box next to any marker in the list can be clicked on to select that particular line, or you can click the Filter Out button to cause it to be removed from data being exported, and the text information associated with that marker will not be exported either.
The checkboxes at the bottom give you options for how Adapt It will format notes, back translations and free translations, if any of these occur in the document. They are grayed out in the picture because they would be meaningless options for a standard format plain text export; they only have meaning for an RTF export - and that is when they would be shown enabled.
One final thing needs to be mentioned. When free translations are included in a target text standard format export, some special number information is included in the file immediately after each \free marker and the space which follows it. The number is a count of how many words belong to that particular section of free translation. The next paragraph shows a little bit of the Adapt It exported translation data.
\c 2
\v 12 My children, in the name of Christ God
\note This is my next note. \note* has removed your sins.
\free |@8@| Therefore I am writing this letter to you \free* Therefore I am writing this letter to you.
\bt You PLUR father you PLUR know good about this man exist before INTENS and live still Like and I write this word to you PLUR
\free |@15@| Fathers, you know a lot about this man who lived long ago and is still alive \free*
\p
\v 13 Fathers, you know well about this man who lived long ago and is still alive.
Note the |@8@|  at the start of the first section of free translation, and the |@15@| in the second. The numbers are not the count of the words within the \free and \free* markers, but rather the words which follow each \free* marker. These numbers are needed so that Adapt It can set up the appropriate free translations in any document which uses that plain text file as its source text data. The |@ and @| are useful for enabling Adapt It to find this information and extract the numbers quickly when parsing in the file's data to create a document. (Strictly speaking this could be done without these numbers being in the file, but counting the words would slow down document creation unacceptably.) So when you see this number information in a file, please understand it needs to be there and don't remove it. The numbers are removed automatically when the file is used to create a document.
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An optional affix Guesser (built by Alan Buseman) is built in to recent versions of Adapt It. It's functionality was greatly enhanced at version 6.5.5. It works by building up a statistical record of 'recurring partial strings' – which loosely can be considered to be potential matchups between the source and target language prefixes or suffixes on words. But in reality, the Guesser knows nothing at all about morphemes. It just matches up recurring substrings of the source text with recurring substring of the target text, and if the frequencies for the matchups get large enough in relation to the frequencies of similar matchups for the same source text substring, then the high-frequency target substring is shown as a guess in the phrasebox - embedded in the potentially correct place in the copied source text. When a guess is shown, the phrasebox is given a background colour – the default colour is light orange, but you can set some other colour if you wish – see below.
So the guesser does not replace the use of the knowledge base – if the latter has the needed form, it is used and the Guesser is bypassed. The Guesser is only given a chance when lookup within the phrasebox fails to find anything suitable to put into the phrasebox. The Guesser has two dialogs. The topmost one is called “Guesser Settings Dialog”. This is where the basic controls for governing how the Guesser works, or for turning it On or Off, are located. Here is a screenshot…
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Note: In recent versions of Adapt It, the Guesser is OFF by default. The reason: For users that have very large Knowledge Bases (such as those who have used Adapt It to adapt a whole Bible into a related dialect), the Guesser can show down the performance of Adapt It considerably.

· Tick Use Adaptations Guesser if you want to turn it ON. Sliding the Guessing level to 0 will have the same effect as turning the Guesser off. The Guesser is Off by default every time you  launch Adapt It, unless you explicitly turn it on in the dialog shown above.

· The Guessing level's slider control value of 50 is a good choice. Set it smaller to inhibit all but very highly frequent guesses, but the likelihood that those guesses that get shown are accurate will increase. Set it greater than 50 if you want to see more guesses – both good ones and inaccurate ones.

· Any guess shown in the phrasebox can be rejected by pressing the keyboard's Esc key. What then gets shown is the copied source text without any changes having been made by the Guesser.

· If you don't like a light orange background colour for a guess, the button Choose Guess Highlight Color... allows you to set any colour you like. You colour choice will be stored in the project configuration file, and restored to use each time you subsequently launch Adapt It.

· If you have Load Consistent Changes turned on as well, which feature wins? Consistent Changes wins. If it tries to make a change to the copied source text word, the Guesser is skipped. However, you can specify that the Guesser should be tried, provided a consistent change was not made to the copied source text. To do that, tick the checkbox: Allow Guesser to operate on unchanged Consistent Changes output.

· Number of Correspondences in Adaptations Guesser is information only. It's how many matchups have been made using the knowledge base data as it currently stands, including any affix matches that you manually supply in the subdialog (see further below). Matchups use the target text form when it is unique, but if more than one adaptation of a source text form exists, then the correspondence that is used in the Guesser's list of correspondences is the most frequently occurring of the adaptations for that source text form. The Guesser automatically works out which one that is.

· Ignore the Glosses Guesser. We currently do not support it, and it is likely we never will - because glosses are not likely to be done in a related language and so guesses done in glossing mode would be meaningless. 

· The Cancel button rejects any setting changes you may have done. The OK button accepts any changes.

· Version 6.5.5 includes the new child dialog, Construct Suffixes and Prefixes Lists, and clicking the button Suffix and Prefix Lists... causes it to be displayed. It looks like this (the picture is showing some already entered suffix matchups between the source language and the target language).
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· The picture shows that Suffixes list has been chosen (the default when the dialog opens). Clicking Prefixes list would display what is currently in the list of prefix matchups. Only one list can be visible at any one time. Every row of either list shows a source text affix or substring (which can be longer than an affix, or even be an affix combination) in the first column, and its equivalent target text affix(which can be longer than an affix, or even be an affix combination) in the second column. The columns can be widened by dragging their divider bar in the title area at the top of the list.
To be useful, each line's two forms should never be empty. The target column form can legally be empty, but it would be useless to the Guesser so there is no point entering such a matchup. The source text form cannot be legally empty – you will get a warning message if you try enter such a line.

· You can enter, in either list, as many matchups as you like. (The responsiveness of the adapting interface might drop a little if the lists are really huge.)

· There is no 'right time' to add or remove entries in the affix lists. You can do it anytime. It's going to help you more if you create affix lists early in your project's adapting work, preferably at the start.

· The affix lists are stored in human-readable xml files in your project's folder.

· The forms in the Source list must differ from each other. If not, a warning message will be shown.

· There is no way to tell the Guesser to be selective about what types of words it works with. You cannot, for example, tell it to only make guesses for verbs and ignore nouns and other word types.

· Each list belongs only to the project in which you create it. If you change to a different project, it will have a different knowledge base, and that project's Guesser will start off with no affixes.

· Short forms will give you more editing work – because it's likely that words without any affixes will start or end with such forms, and so those words will be shown to you with a guess  wrongly inserted into the phrasebox contents. Use the Esc key to cancel the guess. Guessing short affixes might be worth the bother if the frequency of correct guesses greatly outnumbers the frequency of wrong guesses. You may need to remove some lines in the list in order to get the most helpful outcomes when the frequency of bad guesses gets so high that it annoys you.

· The large black hyphens before the text boxes will be shown after the text boxes if you are working with the Prefixes list. They are a visual reminder of what affix type you are setting up the list for – whether prefixes, or suffixes.

· Add enters an affix pair at the bottom of the list. You control where you want each pair to be shown. If you don't want to Add at the list's end, use the Insert button instead.

· Insert requires you first to select which line you want the current affix pair to be inserted before. This lets you group affixes together which you feel belong together as far as the grammar of the languages is concerned. Rearranging the order of the list's lines does not affect the Guesser's operation.

· If you want to correct either or both affixes in any line, first click on the line to select it, make your correction, then click Update.

· To remove any line, click it to select it, then click Delete.

· The Guesser can be fine-tuned to the typology of the source and target languages. Some languages have only suffixes, some have prefixes, some have both, but generally languages tend to have few prefixes, and a richer set of suffixes, and there may be two or more orders of suffixes on some classes of words. The Guesser can be set to limit how many affixes it tries to match. The two choice controls near the dialog's top allow you to specify such a limit. For example, if you know there will never be more than one suffix, you would limit the guessed suffixes to have the value 1. The allowed value for each choice are:
Prefixes:  0, 1, 2, or no limit.
Suffixes: 0, 1, 2, 3, or no limit.
The values you choose are preserved in your project configuration file.
Avoid setting both choices to 0 because that would give the Guesser no chance of helping you.
If you set the values higher than actually is useful for the languages you are working with, the Guesser will generate more bad guesses than otherwise would be the case – and probably cause frustration. You may need to experiment a bit to get the most helpful behaviours. What the Guesser is trying to do is to save you some typing; it is not trying to do morphology. It will not remove the need for editing work. It's helpful only if it saves you some of your typing load. If it annoys you, then just turn if off.

· Finally, the button at the top: Click here for an explanation of how to use this dialog...  will open a more detailed html document in your machine's web browser (it can be left open and will not interfere with your use of Adapt It, in fact, it will stay open even after Adapt It is shut down). It contains more guidelines and tips for getting the most out of the Guesser. The main point is this: don't try for too much; try to get the most common stuff guessed, and don't worry about the more rare affix occurrences.  Here's the contents of that document:


Making Suffix and Prefix Lists For The Guesser

Affixes are of two main types: prefixes or suffixes. Affixes are usually short, and they have meaning. 
Prefixes occur at or near the start of a word; suffixes at or near the end of a word. 
Use the dialog to Add, Update (edit), Insert, or Delete (remove), affix pairs - either within the prefixes list, or within the suffixes list.

Choose which list to work with by clicking Prefixes List, or Suffixes List. 
(If the source and target languages do not use prefixes, just leave the Prefixes List empty.)

Each list that has contents will display two columns of affixes. Each line contains an affix pair. 
For each affix pair: the first affix is from the source language, and the second is the affix which has the same meaning in the target language. 
If the source language has a certain affix, but the target language lacks it, enter the source language's affix, but leave the target language's text box empty. 
If the target language has a certain affix, but the source language lacks it, do not bother trying to enter the target language affix into the list, because that line of the table would be ignored. 

Type the affixes (that is, suffixes or prefixes depending on which list you are working in) into the two text boxes at the right of the dialog. (Do not type hyphens.) The left hand box is for a source language affix. The right hand box is where you type the equivalent affix from the target language. 
If you select a line in the list, that line's contents will appear in the text boxes and you can then edit either affix, or both.

Buttons below the text boxes allow you to control what is done. You can: 
Add a new affix pair at the end of the list. 
Insert the affix pair which is in the text boxes into the list; it will be put immediately preceding the currently selected line. 
Delete an affix pair. Or, 
Update a pair, meaning that your editing changes done in the two text boxes will get moved into the selected line in the list.

The lists are not ordered, so you can keep similar kinds of affixes grouped together in your chosen part of the table. 
The more valid affix pairings you supply, the more accurate the Guesser will be when it suggests a translation for you.
Helpful Hints
1. The Guesser does not really understand what affixes are. It just matches recurring groups of letters. So the groups of letters you include in the lists can contain more letters than what actually occur in affixes. It might help if some of the affixes you type include the adjacent letter from the word's root or stem. Also, affixes which are only a single character are 'risky', use them with care. See the Important Guidelines section below. 
2. When the Guesser is matching source text to target text affix guesses, if there are longer and shorter matchups possible, it will prefer the longer one over the shorter one. Combing this fact with 1. above, it is possible to enter pairs that handle spelling changes at affix boundaries (linguists call this language behavior "morphophonemic changes") 
3. Enter into the list only affix spellings that actually occur. 
4. If the spelling of an affix changes depending on what follows it, enter some or all of the possible combinations as a series of pairs. 
5. Sometimes, when two (or more) affixes occur together, as a combination they have a spelling which is unexpected, or "irregular". In this circumstance, type into the Guesser list each such pair of irregular spellings - the irregular affix combination from the source language followed by the matching affix combination from the target language (whether irregular or not). 
6. Do not expect the Guesser to do miracles. Even though you supply lots of unique pairs, there will always be circumstances which do not result in an accurate guess. These you will need to correct manually in the phrasebox when you do your adapting work, or press the Esc key to make the copied source text be placed in the phrasebox instead of the unwanted guess.

Important Guidelines
1. The advice in this section will help you get good help from the guesser. And remember: if the Guesser is not doing enough of what you want, or it gives you anxiety, you can go to the Change Guesser Settings dialog and click the checkbox within that dialog to cause the Guesser to be turned off; or you can drag the slider to 0 percent - which has the same effect. Remember: In each Adapt It session the Guesser starts in the OFF state.

2. Avoid, at all costs, typing the same form in both the prefix list, and the suffix list. (Put it in just one list, and handle the other by manually typing in the phrasebox while you do the adapting work.)

3. Trying to make the Guesser handle lots of affixes may not work well. Too much potential for wrong guesses. Be selective - handle the most common affixes. If, for example, verbs have rich affixation, and nouns just a little bit of affixation, you may get better results by entering morphemes just for the verbs. But affixes for both word classes would be acceptable if unique, and if they are not short ones.

4. The Guesser cannot reliably determine the difference between stem and affix, so typing in lots of affixes will also give you lots of wrong guesses, with parts of the stem being changed too. Reject a bad guess by pressing the Esc key.

5. Avoid typing in single-letter affixes as much as possible. They tend to produce unexpected changes in the wrong places. Typing in some may be acceptable however - but only one or two for each list, and make sure you obey rule 2 above. Be aware that single-letter affixes in the lists will increase the frequency of bad guesses more than any other single factor.

6. Affixes which are longer produce fewer bad guesses. Two or more letters in an affix make it a much better candidate for successful guessing. The longer the affixes, the better will be the guesses.

7. Do not give up too early. When starting you will use the Esc key often, to reject a bad guess. But over time as the commonly occurring grammatical words get successfully adapted, the incidence of bad guesses will slowly decrease, and the proportion of accurate or helpful guesses will slowly increase.

Editing The Source Text

To edit the source text, first select the section which is to be edited and then choose the Edit Source Text… command on the Edit menu, or press the CTRL+Q key combination. If you want to select across a location where there is a standard format marker, you will need to use one of the means for extending your selection across a boundary (for example, if selecting by clicking and dragging, you would need to hold down the CTRL key while you drag.) 
Also, recalling that Adapt It treats a retranslation section as a unit, if your selection includes one or more source text words which are within a retranslation, then Adapt It will include the whole of that translation as source text shown to you for editing. (Adapt It makes the required adjustments automatically, it is not something you need to think about when you are making your selection.)
Adapt It permits you not only to edit the source text, but to make any desired changes to the document's standard format marker structure as well (for example, you could impose chapters and verses structure on a document which up to that point lacks it.) When you choose the above command, the dialog below will open:
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The dialog shows you the preceding and following source text context in the top and bottom edit boxes; and the source text you selected is in the second edit box. You make your editing changes in the third edit box, including any punctuation which needs to be in the edited source text. (You can also use this dialog to restore punctuation to the source text which you formerly removed with the Remove Source Text Punctuation button.) 
Clicking the Cancel button will restore the document to the state it was in before you made the original source text selection. 
Beginning with version 4, Adapt It allows you more freedom in editing the source text. In fact Adapt It guides you through the editing process, especially if there is filtered information (hidden) within the source text that you want to edit. At the start of the source text editing process, Adapt It temporarily removes any previous adaptations and significant filtered information that may exist (such as free translations, back translations and notes) that were are a part of that source text, storing that information in lists. Removing this information temporarily gives you the ability to focus on the editing process without having to worry about how editing the source text will impact the other bits of information in the document such as filtered information, the changes that will be required in any target text adaptations due to changes in the resulting source text, etc. Once you have edited the source text and click OK, Adapt It will immediately display the newly edited source text. Adapt It then will guide you through the process of modifying or adding back any adaptations, free translations, etc, that it temporarily removed during the source text editing process. The modifications to other bits of information that are required due to editing the source text we are calling the “vertical editing”  process.
What happens to Notes?
When you select source text words, there may be Adapt It Notes stored within the span of the selection. These will be temporarily removed from that section of the document, and temporarily stored until your source text editing changes are completed. Adapt It will then, without your help, restore them to the document at locations as close as possible to where they originally were; this also happens even if you completely remove all the source text words you selected. Adapt It will automatically move adjacent Notes leftwards or rightwards if necessary in order to keep the order of the original set of Notes unchanged. There is no interface for the Note restoration process, it happens automatically.
(In one very unlikely scenario this process could lose one or more of the Notes. If your selection was at the end of the document, and the context has few or no words without Notes at the end of the document, and there are not enough source text words after editing for restoring all the removed notes in the correct order, then in that case only any Notes not able to be placed back into the document will be thrown away. This scenario is so unlikely to ever happen that no warning is given to the user if a Note is abandoned in this way.)
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When you have edited the source text, Adapt It will help you in a step-by-step process to restore information that it may have removed to facilitate source text editing. If information exists that Adapt It cannot restore on its own, Adapt It displays its vertical editing interface which appears immediately above Adapt It's main window (highlighted above by the red rectangle in the image above). This interface changes depending on what step you are at in the vertical editing process.
The “steps” in the vertical edit process are the following, for the default order in which the steps are done:
1. Adaptations step.
2. Glosses step.
3. Free translations step.
4. Re-collecting any collected back translations removed at the start of the source text editing process.
Note: a pair of radio buttons in the Backups and Misc page of the Preferences allows you to switch the processing order for steps 2 and 3 to be the following:
1. Glosses step.
2. Adaptations step.
3. Free translations step.
4. Re-collecting any collected back translations removed at the start of the source text editing process.
In either case, step 4 has no interface; it is done for you silently at the end of the vertical edit process whenever it is appropriate.
The vertical edit interface includes a tool bar with four buttons: Previous Step, Next Step, End Now, and Cancel All Steps. In normal use of the vertical editing feature, you are unlikely to need to use any of these buttons. They are there merely to give you a little extra control over what happens, for special situations. Briefly, here is what they do.

Previous Step
Click this to abandon any work done in the current step and restore the vertical edit process to the beginning of whatever was the previous step. (You cannot use this button to restore the Edit Source Text dialog, it will be disabled. Instead, use Cancel All Steps and then re-attempt your Edit Source Text operation.)

Next Step
Click this to end the current step, retaining any work already done in the current step, and proceed immediately to the start of the next step.

End Now
Click this to immediately end the current step, retaining any work already done in the current and earlier steps, but skip any steps which may follow – ending the vertical edit process prematurely and restoring the main window’s normal working view.


Cancel All Steps
Click this if, for any reason, you do not want to retain any of your editing changes in any and all of the steps, including the original source text edit if that was where you started from.

The Undo Last Copy button can be used to undo whatever was the effect of copying an item from the combo box list during this or any other vertical edit step. The phrase box has to be at the appropriate location though, otherwise the button is disabled.
Vertical Editing – adaptations step:

The first step is to add or edit any adaptations that were removed in the vertical editing process, and Adapt It has collected any adaptations that existed in the span of source phrases that you just edited and placed those adaptations into a list. This list of adaptations is in the drop-down list to the right of the “Removals” label in the above illustration in which the first item in the list is “little”. 
If you have previously done much in the way of adaptation work, usually just pressing the enter key will fill in most of the adaptations for the newly edited source text. That is normally what you would do. However, since in adaptations step Adapt It is in adapting mode, all the adapting mode functionalities are available – so you can insert placeholders, make retranslations, or merge source text words. Doing such things would usually alter the number of piles within the editable span – you don’t need to worry about such matters because Adapt It automatically keeps track of what you do and makes all the necessary alterations without you needing to do anything extra.
If you click on the down arrow of the combo list located to the right of the “Removals” label you can select from any of the adaptations that Adapt It stored during source text editing – when you click to select the item you want, it is immediately entered into the phrase box, replacing whatever was in the phrase box. The old phrase box contents are temporarily stored, in case you subsequently want to use the Undo Last Copy button to restore the phrase box contents to the earlier state.
Note: adaptations step is not entered if, at the location where you edited the source text, there were no adaptations already defined. Instead, it will attempt the next step of the vertical edit process. (Of course, there might be no glosses or free translations or collected back translations at that part of the document either, in which case the vertical edit process would not even commence.)
Ending the adaptations step:

There is no need to press a button to end the adaptations step. The normal way to end it is to merely do the required adaptations, and press the Enter key to cause the phrase box to move to the next location. When the next location is somewhere within the gray text following the editable span of the document (that is, the text which is not gray), Adapt It will detect that the phrase box is about to move to the gray area and automatically transition the interface to the beginning of the next step, repositioning the phrase box to whatever location is appropriate at the next step’s beginning. (If the phrase box is at the last pile of the editable span, and you have entered the correct adaptation, then clicking the End Now button would have the same effect as pressing the Enter key.)
Vertical Editing – glosses step:

No picture is shown; the interface for the glosses step is almost identical to that for the adaptations step; only the text of the message changes, and Adapt It is switched to glossing mode so that the phrase box is ready to accept any glosses that you type. For more details, read the comments for adaptations step above, but note that in glossing mode it is not possible to do placeholder insertions, retranslations, nor mergers.
Note: glosses step is not entered if, at the location where you edited the source text, there were no glosses already defined. Instead, it will attempt the next step of the vertical edit process.
Ending the glosses step:

There is no need to press a button to end the glosses step. The normal way to end it is to simply do the required glossing in the phrase box with an Enter key press to cause the gloss to be stored and the phrase box to move to the next location. When the phrase box is about to move forward into the gray text area, Adapt It will transition the interface to the beginning of the next step.
Vertical Editing – free translations step:
If there were any free translations anchored in the span of edited source text, Adapt It automatically switches the application into free translation mode and loads those free translations into the drop down list. If there were no free translations within that span, then Adapt It will skip this step.
The following illustration shows what the vertical editing process looks like in the free translations step:
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When this dialog is active, you can update the free translation (if the original source text selection included many words, you may need to update more than one free translation). You can do the updating by either typing the free translation you want, or, use the combo box at the right of the Removed: label to display a list of removed free translations – and click in the drop down list to select the one you want. When you click on it, it will immediately be copied into the free translation box, replacing anything already in the free translation box. (You can use the Undo Last Copy button if you change your mind.) Copying an old free translation is appropriate if (1) it is still valid, or (2) it only needs a few editing changes to make it become valid.

If your original source text selection was quite short, when you get to the free translations step of the vertical edit you may find that the phrase box is positioned earlier than at the place where you started your original selection, and that the pink backgrounded text is longer than your original selection. This is not an error. It just means that your original section was within the span of one or more free translations, and so the free translations interface has to permit you to update all the free translations affected by your source text edit – no matter how short that may have been.
Vertical Editing – back translations step:

The final step is an invisible step. It happens only when the original source text selection lay within a section of the document in which back translations had been “collected”. (Recall that such collection is done from either the adaptations information, or the glosses information – whichever you specified at some earlier time.) If there are no collected back translations at that part of the document, this step is skipped.
When Adapt It analyses your original source text selection, it determines what your original choice was for the back translation collection operation, and stores that information. Then, when restoring the collection, it uses that stored value, and the back translation span (which usually will be longer than your original source text selection) to re-collect the appropriate words, so as to re-establish an updated back translation, storing it as filtered information in the document in the normal way. This updating process “works” without your intervention because you will have already updated both adaptations and glosses at earlier steps in the vertical edit process.
What happens at the end of the vertical edit process? 

Adapt It throws away the information it stored while the vertical edit process was happening. It then restores the main window to whatever mode was in operation before you edited the source text, or before the vertical edit process was entered. The removed information – adaptations, glosses, and free translations, however, are retained for as long as the current document remains open. Each subsequent vertical edit potentially can add words to the lists for those kinds of information. The lists, however, retain only the most recent 100 entries, per list.
Standard Format Markers Commonly Used
A standard format marker begins with a backslash and then follow one or more characters which constitute the 'name' of the marker, and then follows a space. Markers which take numbers (such as chapter or verse markers) have the number following the space, and then another space following the number. The 'name' of some markers may include a digit, though only a few do that.

United Bible Societies and SIL International these days use a richer set of markers than those below, called "Unified Standard Format Markers" (USFM). Commonly used markers in the USFM set are identical to the commonly used ones in the now old PNG marker set shown below. Documentation for the USFM markers is available at  https://paratext.org/usfm/ and PDF documentation, or documentation in other formats, is available from links on that page. The PNG marker set is now quite obsolete, so don't do markup using it. However, markers like \p, \v, \c, \s, \id, \m, \q are common to both marker sets.

Here are the markers commonly used in the PNG branch's text mark-up. The function of each is described to its right. A marker precedes any text with which it is associated.

\p
begin a new paragraph

\c
chapter (a number follows)

\v
verse ( a number follows)

\s
section heading

\id
identification information

\@
cross-reference at

\bn
Psalms book number

\cap
picture caption

\cat
picture catalogue number

\des
picture description

\di
Psalms musical direction

\div
division heading

\dvrf
division reference

\f
footnote

\fe
footnote end

\gd
glossary definition

\gm
glossary main entry

\gp
glossary paragraph

\gs
glossary subentry

\h
header

\hl
Hebrew letter

\hr
horizontal rule

\im
introduction continue at margin

\io1
introduction outline level 1

\io2
introduction outline level 2

\io3
introduction outline level 3

\ip
introduction paragraph

\iq
introduction poetry level 1

\iq2
introduction poetry level 2

\is
introduction section heading

\loc
picture location

\m
continue at margin

\mi
indented continue at margin

\mt
main title

\nc
centred note

\pc
paragraph spanning a chapter

\pi
indented paragraph

\pm
preface continue at margin

\pp
preface paragraph

\pq
preface poetry

\ps
preface section heading

\pt
preface title

\px
extra paragraph 1

\pz
extra paragraph 2

\q
poetry level 1

\q2
poetry level 2

\q3
poetry level 3

\qc
centred poetry

\qh
list/genealogy

\qm
left margin poetry

\qr
 right margin poetry

\qx
extra poetry 1

\qz
extra poetry 2

\r
reference

\rr
right margin reference

\siz
picture size

\sp
speaker

\st
secondary title

\sx
extra heading 1

\sz
extra heading 2

\tir
topical index reference

\tis
topical index heading level 1

\tpi
topical index heading level 2

\tps
topical index heading level 3

\xr
cross reference

From version 1.3.6 onwards, and in the Unicode version, the following markers are also supported:

\vn
"verse number" (should be followed by a space, then the verse number, then space or newline)

\vt
"verse text" (should be followed by a space or newline, and then comes the text of the verse)

\nt
"note" (should be followed by space or newline, then whatever text follows, up to the next


standard format marker, is interpreted as note text (which is adaptable if the user wishes.)

Unknown markers:
These are hidden and restored on export; but the navigation text shows





??text type (meaning "unknown text type"), the text type is internally set to





noType, and they are written in the colour used for "special text." The text





of these markers may be adapted if the user wishes.

Printing

Adapt It supports printing. The printing commands are on the File menu and they are:

Print…
Print Preview
Page Setup…
Although printing can be done from the Print... item on the File menu, this type of printing shows the interlinear text generally as it displays on the computer screen with a fair amount of wasted space and little or no formatting. Version 6.1.0 and later support the direct printing of glosses and/or free translations (see the Special Print Options dialog below under the Print command). Before you print with the File menu's Print... command, you should consider exporting your document first as an RTF document (either the Source text, Target text, Glosses text, Free Translation Text, or Interlinear Text export), which allows for more print format options, and saves your document as a separate disk file. Then you can load the exported RTF document into an external word processor such as MS Word or OpenOffice/LibreOffice and print it from there. This will result as a more nicely formatted printout.

Notice: In the newest Linux versions of Adapt It, the File → Print and File → Print Preview function may be disabled due to aberrations in version 3 of the wxWidgets library which use a different PostScript standard for printing in Linux. This problem will hopefully be corrected in the future. But, even so, a better and more flexible printout of an adapted document will always be obtained by first exporting the document using the “Export Interlinear Text...” option on the “Export-Import” menu, loading the resulting RTF file into Word or LibreOffice Writer, and printing it from one of those external programs.

There is also a command on the View menu called Units of Measurement… When you click it, you get the following dialog:


You can then select whether you want to work in inches, or metric units. Default is inches. Which setting you use only affects the numbers appearing in the edit boxes for the page margins of the Page Setup dialog. Whatever setting you choose will be preserved in the configuration file, and will therefore remain in force until you next change it. [Note: On Windows systems only the “Centimeters” option is the only option that actually makes sense here because of the way the cross-platform Page Setup dialog appears (see below) – this is a known limitation and will be changed in a future version]

Page Setup…

This command puts up the following dialog:
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You can use this dialog to change the orientation, the paper size and source. Margin setting is only possible here in the Page Setup dialog. Your margin settings, whatever they happen to be when the application is closed, are preserved in the configuration file – hence the same margins will be restored when next you launch the application. [Note: On Windows systems only the “Margins (millimeters)” option is shown in the Page Setup dialog (see comment in the Units Dialog section above) – this is a known limitation and will be changed in a future version]

You can check the appearance of the document by choosing the Print Preview… command from the File menu before you give the Print… command. (You cannot suppress the previewing of the footer, footer suppression is only possible during the actual printing operation.). Note: The previewing of very long documents may take a significant amount of time while Adapt It lays out the printed form of the document in memory before displaying it on screen.

Print…

The Print dialog allows you to print your document in almost WYSIWIG format. It is "almost" what-you-see-is-what-you-get because the document width on the printed page will probably be a little different to the document width you see on the screen, therefore line wrap will occur at different places. Adapt It uses the width of the paper, together with your left and right margin sizes, to work out how wide to make the document for printing – and this could be quite different from the screen layout if you have a very narrow, or very wide main window.  Because of the fact that standard dialogs are somewhat different on different platforms, Adapt It WX displays a “Special Print Options” dialog before displaying the standard print dialog for the operating system you are using. The “Special Print Options” dialog looks like this:
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This dialog allows you to include or exclude certain types of text in printouts. The first two check boxes allow you to include or exclude free translation text, and glosses text in printouts.

The dialog also allows you to specify a printing range in Pages, or as a “Chapter/Verse” range for printing. It also allows you to specify how Adapt It is to handle any existing section headings and footers during printing. 

Adapt It will always print a footer unless you use the checkbox to suppress it. The footer is always visible in the Print Preview… view, it is only able to be suppressed during the actual printing operation. The footer will contain, on the left, source and target language names separated by a slash, then the filename followed by the chapter and verse range if you have that option chosen, a page number (centred, if possible), and the last modification date of the file. If the file has not yet been saved to disk, the date printed will be the current (local) time – using a 24 hour clock.

The print range option permits printing of the whole file (default), or printing of the selection, or choosing a page range, or choosing a range of verses. For example, if you wish to print from chapter 3 verse 5 through chapter 7 verse 6 inclusive, you would set the top two edit boxes to 3 (for the chapter) and 5 (for the verse), and the bottom two edit boxes to 7 (for the chapter) and 6 (for the verse). If there is a section heading before or after the verse range to be printed, default behaviour is to include a preceding section heading, and to omit a following section heading. If you wish to vary these defaults, there are two checkboxes at the bottom left of the dialog for that purpose. The are "Suppress of preceding section heading"  and  "Include a following section heading."

It is not possible to do a Print Preview… of a chapter/verse range.  If you have a selection in force when you give the Print command, the dialog will come up with the Selection radio button turned on. If you click one of the other radio buttons, the selection option cannot be rechosen – you would have to Cancel the dialog and invoke it again with your selection active to do that.

Printing, if you have a colour printer installed and provided you have not specified the greyscale option in its Options dialog, will be in colour - which is slower and more expensive than black and white printing. If you want to print in greys and black, choose the Options button and set your printer's greyscale option to "on". If you do not want to do it that way, you can always instead go to the Preferences… dialog (see the Edit menu), and choose black for the text colour for the source, target, and navigation text fonts.

If your document does not have chapter numbers, but only verse numbers, then use 0 (zero) as the chapter number in the dialog. If your document has neither chapter numbers nor verse numbers, the chapter/verse range option will generate a warning message and the print operation will be aborted.

The normal view can be printed, or the "Show Target Only" view. (In the latter view, verse and chapter numbers cannot be seen in the document window and will therefore not be printed, but the print dialog will nevertheless use verse and chapter numbers correctly if you specify them in the edit boxes in order to specify a range.)

You might find it helpful to use the Preferences… command on the Edit menu to change the document so that it has small font sizes, no colour, a small vertical gap between strips, and a smaller gap between piles, so that printing does not waste paper.

NOTE: if you do not specify a range, the print operation will print the WHOLE document - and that could be very many hundreds of pages for a large book such as a gospel! So beware. (Remember, if you do want to print the whole document, before you print you should change to black fonts, small point sizes, close up the interpile gap significantly, reduce the distance between strips, and so forth, so that you do not waste paper.)
Remember, if you want a printout containing chapter and verse numbering, and just the target text, you will do far better to use the Export… command on the File menu, and then open the exported text in a word processor application such as MS Word or OpenOffice, and do the printing from there. Likewise, if you want an interlinear formatted output you will do better to use the Export Interlinear Text… command and open the exported document in MS Word or OpenOffice.
After you specify any special options, you can click on the “Print >>” button which will then cause the standard print dialog to appear for your computer system. On Windows systems, the standard print dialogs looks something like this:

[image: image117.png]



The dialog allows you to change the default printer, access and adjust the printer properties, specify the number of printed copies to be printed and whether to collate or not (if your printer driver permits those options). You can specify a print range in pages from this dialog, but it is better to use the “Special Print Options” dialog for specifying ranges (see above).

Print Preview

Print preview allows you to see what you will get if you were to print to an external printer. The Print Preview dialog looks like this:
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The Print Preview dialog allows you to navigate to individual pages and see what they will look like before printing. You can also scale the preview image using the drop down box.

Using Adapt It with Command-Line Options

Some features of Adapt It's operation can be changed with command-line options. These command-line options are now mostly outdated, or confined to very specific use cases asked for by a small number of users. These are the main command-line operations:

1. Use of the -xo switch (Better fit on the OLPC XO computer) [Outdated]

The -xo switch can be used to change Adapt It's interface for better fit on certain display screens such as that used on the OLPC XO low power computer, where the high resolution (200dpi) screen shrinks the size of bitmaps, but the operating system also inflates the size of fonts. When Adapt It is run with the -xo switch, it causes Adapt It to use a toolbar with larger (but fewer) buttons; a mode bar that spans two lines instead of a single line under the toolbar; and a few dialogs adjusted for better layout. The -xo option is not restricted to use on the OLPC XO; it can be added to the command-line on most systems by right-clicking on a menu item, shortcut, or launcher icon that is normally used to start Adapt It, and choosing "Properties" from the popup menu. Then in the Command or Target field that invokes Adapt It,  add a space after the executable name, followed by the -xo option. 

For example, on an OLPC XO running under Balsa, right-click on the Adapt It desktop icon and choose, "Edit Launcher". Then in the Command field add a space and -xo after the command so that the Command field looks like this:

/usr/bin/adaptit -xo
To change the xfce menu item to also use the -xo switch, you will need to do a little more work. Most of the general menu items are controlled by <application>.desktop files located in the following directory:

/usr/share/applications/
where you will find the Adapt It file that the debian packager installs, which is at:
/usr/share/applications/adaptit.desktop
If you edit this adaptit.desktop file you can add the -xo option to the line that currently looks like this:
Exec=adaptit
and change that line to read like this:
Exec=adaptit -xo
Once you make this change, the Adapt It menu item located in the Office folder will use the -xo adjustments when you select Adapt It from the general menu.
2. Use of the -wf <path> option (Changing Adapt It's Work Folder name/location)

Adapt It now can process an -wf <path> command-line option, where <path> is the path to a folder to be used as Adapt It's work folder. When this command-line option is used the folder location designated by <path> will be used instead of Adapt It's default work folder, which has traditionally been called "Adapt It (Unicode) Work". The <path> following the -wf option can be on a different drive/volume or even a network path. This option can be added to the command-line on most systems by right-clicking on a menu item, shortcut, or launcher icon that is normally used to start Adapt It, and choosing "Properties" from the popup menu. Then in the Command or Target field that invokes Adapt It, add a space after the executable name, followed by  -wf  followed by another space and the desired path. For example, the Command/Target field might look like this (on a Windows Start Menu item for Adapt It WX):

"C:\Program Files\Adapt It WX\Adapt_It.exe" -wf "e:\My Data"
in which case the project file(s) created by Adapt It would be located in the "My Data" folder on the e: drive. Note: paths containing spaces must be enclosed in quote marks. If this command-line option is later removed from the menu's properties so that no -wf <path> command-line argument is supplied, Adapt It reverts completely back to its classic behaviour of creating an "Adapt It (Unicode) Work" folder in the user's "(My) Documents" folder (or whatever path and folder name the OS reports is currently being used for documents by the user), and using that folder as its work folder.

Note: If an administrator sets Adapt It up to use a custom work folder (using -wf <path>) AFTER data is already created at the default "Adapt It (Unicode) Work" folder location, Adapt It currently won't find the previously existing classic work folder, and will instead create/use what is specified in the -wf <path> command-line option. In such a situation, the administrator who sets up the custom work folder will probably want to also copy or move all of the projects from a previously existing "Adapt It (Unicode) Work" folder to the new custom work folder. Once that is done Adapt It will just "see" them there at the custom specified <path> and continue to expect it work folder to be in the specified location as long as the -wf <path> command-line option continues to be specified in the menu's properties.

3. Use of the -frm switch (force reviewing mode) 

In some unusual circumstances it may be desirable to force Adapt It to run with Reviewing mode turned on at program launch. This can be activated by use of the -frm command line switch. Do not use this switch unless you know what you are doing. It puts Adapt It into 'Reviewing mode' on launch, and hides both the Drafting and Reviewing radio buttons, so that in that session the user becomes locked in to reviewing mode. This is useful when a "dumb mode" for back translating is wanted. No lookup of the KB is done in this mode. The phrase box does not copy source text nor make an initial suggestion of any kind, and no auto insertions are done, but the KB still gets populated in the normal way as the user types back translations into the phrase box. This feature can be used with a shell script launch of Adapt It, to force this mode on, on a per-session basis. That's one way this feature could be used. Another way is to setup a desktop shortcut and in the shortcut properties' Target box, add the -frm switch to the end of the path. Whatever you do, be sure that the normal way to launch Adapt It does not have the -frm switch used, otherwise you'll lock the user (or yourself) out of essential adaptation functionalities at every launch. You've been warned!

4. Use of the export command-line option for Automated Exports of target text in conjunction with the SendIt utility

This is a specialized use of the command line and cannot be used with any of the other command-line options discussed above. In this use there must be four and only four command line parameters, and all four must be present and in the following order: export  projectfoldername  documentname  pathtooutputfolder. The first parameter is the option switch, and the other three represent document and path names. Put double quotes around any of these paths or the name parameter, if there are spaces within them. This automated export feature is used by the SendIt utility which John Hatton has developed. SendIt allows the user to select a document from a list of documents currently in the project and it will then automatically generate the required export of the adaptation line's data to a file and attach the file to an email to be sent by HF radio using UUplus.

5. Use of the -srcRespell switch (source text Respelled) 

This is a command line switch that might be useful in the following circumstance. The user has an existing source text as an external text file (possibly in Paratext), with USFM markup, and collaboration mode is currently turned on, and that source text is to be selected for adaptation  in Adapt It. Then PROVIDED THERE ARE NO MERGERS IN THE ADAPT IT document, and the user has edited the source text in Paratext to have a different spelling system (but no meaning changes, no extra words, no words deleted either, just respellings scattered throughout the source text), the respellings can be transferred into the Adapt It document by a smart merge which does NOT remove any of the existing adaptations, by using this switch. 

If this switch is turned on then when the smart merge happens (it happens, in collaboration mode, at the time the document is first opened for adapting work) Adapt It will check automatically (without asking you) for the presence of any mergers in the document. Provided there are none, it will retain the adaptations of the respelled words during the smart merge of the newly spelled material received from Paratext. (Or from Bibledit if that is your external editor with which Adapt It is collaborating.) 

But if one of more mergers are present, the smart merge still happens, but the legacy way of doing it is done – that is, the adaptation at any source text word which differs from what it was before, is thrown away; and after the merge, the user then has to re-adapt all the “holes” created by those thrown away adaptations.

Here's what you'd do for steps...

1) Prepare a shortcut (Windows) or launcher icon (Linux) with the -srcRespell switch added to the end of the path to where Adapt It is. The path should be in opening and closing vertical doublequotes, but the -srcRespell itself doesn't need to be wrapped in single or doublequotes.

2) Open Paratext (or Bibledit if you use that) and respell the chapter, or book, with your new spellings. Or do whatever you need to do so that the words needing to be respelled are respelled correctly. (Steps 1 and 2 can be done in any order, but both must be completed before you do step 3.)

3) Use the launcher or shortcut to launch Adapt It, choose your collaborating project, make sure collaboration is turned on, select the book and chapter to be updated, click OK. (If the check for a merger finds one, Adapt It will put up a message to tell you that the special smart merge is not possible, and the legacy one will be used instead. If you don't see such a message, then the adaptations will have been retained and no manual re-adapting will be necessary.)

End of Documentation
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